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Preface

Anyone who has been developing on the Microsoft platform for the last several years knows the drill:
every few years, there’s a new database access technology. There was ODBC; then DAO and RDO;
OLEDB, ADO, and ADO.NET; LINQ to SQL; and now Entity Framework! In many ways, this progression
of technologies has been confusing, but in other ways it’s wonderfully refreshing to see this field evolve
from simple open connectivity to componentized connectivity, to disconnected access in a managed
environment, to friction-less access syntax, and finally to conceptual modeling.

It’s the conceptual modeling that is the defining feature of Entity Framework and is at the heart of
this book. Entity Framework builds upon the previous data access paradigms providing an environment
that supports rich, real-world domain level modeling. We can now think of and program against real-
world things such as orders and customers, and leverage concepts such as inheritance to reason about
things in our domain and not just rows and columns.

There is no question that Entity Framework is the future of data access for the Microsoft platform.
The first release in August of 2008 was widely considered a good first step. Now, more than year later,
this new release of Entity Framework (often called EF 4.0) as part of the newly released Visual Studio
2010 and .NET 4.0 has matured into a full function data access technology ready for production use in
both green field and legacy applications.

The concepts and patterns you will learn as you use the recipes in this book will serve you well
into the future as Microsoft continues to evolve Entity Framework in the years to come.

Who This Book Is For

This book is for anyone who develops applications for the Microsoft platform. All of us who work in this
field need access to data in our applications. We are all interested in more powerful and intuitive ways to
reason about and program against the real-world objects in our applications. It makes much more sense
for us to architect, design, and build applications in terms of customers, orders, and products rather
than rows and columns scattered among tables locked away in a database. Because we can reason about
problem space in terms of real-world objects, we have a lot more confidence in our design and in the
code that we build. We are also better able to document and explain our applications to others. This
makes our code much more maintainable.

Entity Framework is not just for developers. Microsoft is aggressively positioning the modeling
concepts in Entity Framework to serve as the conceptual domain for Reporting Services and Integration
Services as well as other technologies that process, report on, and transform data. Entity Framework is
quickly becoming a core data access foundation for many other Microsoft technologies.

This book contains well over 150 recipes that you can put to work right away. Entity Framework is
alarge and complex topic. Perhaps it’s too big for a monolithic reference book. In this book, you will find
direct and self-contained answers to just about any problem you’re facing in building your Entity
Framework-powered applications. Along the way, you'll learn an enormous amount about Entity
Framework.

xxxiii



PREFACE

What’s in This Book

We’ve organized the recipes in this book by topic. Sometimes we’ve found that a recipe fits into more
than one chapter, and sometimes we find that a recipe doesn’t fit perfectly in any chapter. We think it’s
better to include all the important recipes rather than just the ones that fit, so you might find yourself
wondering why a particular recipe is in a certain chapter. Don’t worry. If you find the recipe useful, we
hope that you can forgive its (mis)placement. At least we got it into the book.

XXXiV

The following is a list of the chapters and a brief synopsis of the recipes you'll find in them:

Chapter 1: Getting Started with Entity Framework. We explain the motivation behind Entity
Framework. We also explain what the framework is and what it does for you.

Chapter 2: Entity Data Modeling Fundamentals. This chapter covers the basics in modeling. Here
you'll find out how to get started with modeling and with Entity Framework in general. If you're just
getting started, this chapter probably has the recipes you're looking for.

Chapter 3: Querying an Entity Data Model. We’ll show you how to query your model using both
LINQ to Entities and Entity SQL.

Chapter 4: Using Entity Framework in ASP.NET. Web applications are an important part of the
development landscape, and Entity Framework is ideally suited for ASP.NET. In this chapter we
focus on using the EntityDataSource to interact with your model for selects, inserts, updates, and
deletes.

Chapter 5: Loading Entities and Navigation Properties. The recipes in this chapter cover just about
every possibility for loading entities from the database.

Chapter 6: Beyond the Basics with Modeling and Inheritance. Modeling is a key part of Entity
Framework. This is the second of three chapters with recipes specifically about modeling. In this
chapter, we included recipes that cover many of the more complicated, yet all-too-common
modeling problems you’ll find in real-world applications.

Chapter 7: Working With Object Services. In this chapter, we included recipes that provide practical
solutions for the deployment of your models. We also provide recipes for using the Pluralization
Service, using the edmgen.exe utility, and working with so-called identifying relationships.

Chapter 8: Plain Old CLR Objects. Using code-generated entities is fine in many scenarios, but there
comes a time when you need to use your own classes as EntityTypes. The recipes in this chapter
cover plain old CLR objects (POCO) in depth. They show you how to use your own classes and
reduce code dependence on Entity Framework.

Chapter 9: Using Entity Framework in n-Tier Applications. The recipes in this chapter cover a wide
range of topics using Entity Framework across the wire. We cover POCO, self-tracking entities,
serialization, and concurrency.

Chapter 10: Stored Procedures. If you are developing or maintaining a real-world, data-centric
application, you most likely work with stored procedures. The recipes in this chapter show you how
to consume the data exposed by those stored procedures.

Chapter 11: Functions. The recipes in this chapter show you how to create and use model-defined
functions. We also show how to use functions provided by Entity Framework, as well as functions
exposed by the storage layer.
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Chapter 12: Customizing Entity Framework Objects. The recipes in this chapter show you how to
respond to key events, such as when objects are persisted. We also show how to customize the way
those events are handled.

Chapter 13: Improving Performance. For many applications, getting the best performance possible
is an important goal. This chapter shows you several ways to improve the performance of your
Entity Framework applications.

Chapter 14: Concurrency. Lots of instances of your application are changing the database. How do
you control who wins? The recipes in this chapter show you how to manage concurrency.

Chapter 15: Advanced Modeling. This is the last of three chapters that focuses on modeling. The
recipes in this chapter show you how to solve some of the most vexing modeling problems you are
ever likely to encounter.

About the Recipes

At present there are four perspectives on model development in Entity Framework. Each of these
perspectives is at a different level of maturity in the product and at a different level of use in the
community.

The initial perspective supported by Entity Framework is called Database First. Using Database
First, a developer starts with an existing database that is used to create an initial conceptual model. This
initial model serves as the starting point for further development. As changes occur in the database, the
model can be updated from these database changes. Database First was the initial perspective
supported in Entity Framework, is the best-supported approach, and is widely used to migrate existing
applications to Entity Framework.

The current release of Entity Framework introduced the Model First perspective. With Model
First, the developer starts with a blank design surface and creates a conceptual model. Once the
conceptual model is complete, Entity Framework can automatically generate a script to create a
complete database for the conceptual model. In this release there is limited support for many of the
modeling scenarios. As you might expect, realizing an arbitrarily complex conceptual model in a
traditional relational database is an enormous challenge. The support for this perspective will mature
over time and will likely become the dominant approach, particularly for new projects.

Persistence ignorance, which is supported in many ORM products, is now supported in the
current version of Entity Framework. With persistence ignorance, you can use plain old CLR objects,
usually referred to as POCO, as entity types. There is no need for them to inherit from EntityObject. We
have devoted a number of recipes to POCO.

Finally, an emerging perspective is Code First. In this approach, there is no .edmx file (which
encapsulates model and mapping information). Your objects create and use a model dynamically at
runtime. This perspective is still in the experimental stage and is available as a Community Technology
Preview.

In this book, we focus on the Database First perspective. This perspective is the most widely used
and most mature approach. Many, if not most, developers in the Entity Framework community find
themselves working with existing applications or developing models that are not readily supported by
the other perspectives. We also have to share a dirty little secret: many existing applications don’t exactly
use the best database designs. Way too often we find ourselves working with databases (of course,
created by other less talented developers) that are poorly designed. As developers, sometimes in larger
organizations with lots of process control, or with lots of fragile legacy code, we can’t change the
database enough to really fix the design. In these cases, we simply have to work with the database design
we have.
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Many of the recipes we selected for this book take on the task of modeling some of these more
challenged database designs. We’ve found hundreds of examples of these databases in the wild and
we’ve worked with many developers in the Entity Framework community who have struggled to model
these databases. We've taken these experiences and selected a number of recipes that will help you solve
these problems.

Stuff You Need to Get Started

Okay, what do you need? First off, you will need Microsoft’s latest software development environment.
Microsoft’s Visual Studio 2010 comes complete with full support for Entity Framework. Visual Studio
2010 Express Edition is freely available. The other versions of Visual Studio fully support Entity
Framework.

You’'ll need a database. Microsoft SQL Server 2008 with Service Pack 1 is the simplest choice, but
there are Entity Framework providers for databases from other vendors. Microsoft SQL Server 2008
Express is freely available. Make sure you apply the latest service packs and updates. These recipes were
built and tested using Microsoft SQL Server 2008. Previous versions of SQL Server or other databases
may not play well with a few of the recipes.

Code Examples

This book is all about recipes that solve very specific problems in a way that allows you to directly apply
the solution to your code. Feel free to use and adapt any of the code you find here to help build or
maintain your applications. Of course, it’s not okay to copy large parts of this material and distribute it
for fun or profit. If you need to copy large parts of this material, contact our publisher, Apress, to get
permission.

If you use our code publicly (in blogs, forums, and so on), we would appreciate, but don’t require,
some modest attribution such as author, title, and ISBN.

We’ve taken a decidedly low-tech approach in the code in each recipe. We’ve tried not to clutter
the code with unnecessary constructs and clever tricks. In the text, we show just the code of interest, but
we also show enough to give the proper context. In the download for the code, we have complete
solutions for each recipe. The solutions build simple applications that you can modify and run over and
over to play with various changes that suit your needs.

The Database

Of course, there is more to each recipe than just the code. We created a single database for all the
recipes. This makes it much easier to work through the recipes because there is just one database to
create in your development environment.

To keep some sanity in the table names and provide at least a little organization, we created a
schema for each chapter. The recipes in the chapter use the tables in the corresponding schema. In the
text, we often show database diagrams similar to the one in Figure 0-1. This helps make clear the table
structure we’re working with. Each table in a diagram is annotated (courtesy of SQL Server Management
Studio) with the name of the table and the schema for the table. Because we reuse table names
throughout the book (we’re just not creative enough not to), this helps keep straight exactly which tables
we're referring to in the database.
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Figure 0-1. Each database diagram in the text has the schema name next to the table name.

We've also provided the complete set of database diagrams for each recipe as part of the
database. If something isn’t clear from just the tables, especially when several tables are involved, it
often helps to look at the diagram to sort things out.

Apress Website

Visit the Apress website (http://apress.com/book/view/1430227036) for the complete code download as
well as the database with all the tables and database diagrams used in this book. Please look for the
“Source Code” link underneath the cover image.
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CHAPTER 1

Getting Started With
Entity Framework

In relational databases, we think of things in terms of tables with rows and columns. Tables are very
structured and amenable to all sorts of interesting set theory. Before the dawn of object-oriented
programming, back in the day when we focused on “structured” programming and wrote function after
function, it seemed a good idea to break down a big problem into lots of little problems. Working with
tables, rows, and columns seemed a good match with our code. Our code was structured and
procedural. Our data was structured and backed up by database side procedures. Things lined up well.
Many database vendors even supplied preprocessors that allowed developers to intermix SQL
statements and C (or Fortran) code. Life was good for a time.

Much has evolved on the code side. Now we think in terms of objects in a domain model. We
architect, design, and program against real-world things like customers and orders. We draw the nouns
in our problem space on whiteboards. We draw lines between them, denoting relationships and
interactions between customers and orders. We build specifications and assign work to development
teams in terms of these drawings. In short, we architect, design, and program at a conceptual level that is
very distant from the logical organization of the database.

While the software development process has matured, and the way in which we reason about and
solve problems during the process has evolved, the data in our databases has been locked in the same
tables, rows, and columns structure. The synergy between structured data and our code evaporated as
quickly as structured programming in the heat of modern object-oriented development. To cope with
this growing mismatch, many projects introduced a “database layer” to isolate the object-oriented code
from the data store. This layer translated objects to the rows and columns saved in tables. Many
commercial solutions were introduced, including an entire field of Object Relational Mapping (ORM).
These tools provided many out-of-the-box yet configurable ways to bridge the ever-widening gap
between the evolving development process and structured data.

The fundamental problem is this: the gap is widening and it is increasingly impractical to fill the gap
with yet more glue code. No one wants to develop and maintain more in house glue code and
commercial solutions are struggling to keep up. Microsoft is fond of calling this gap the impedance
mismatch between code and data.

Microsoft’s Entity Framework, together with Language-Integrated Query (LINQ) and a new query
language called Entity SQL, are technologies specifically designed to address the impedance mismatch
problem. With Entity Framework, we model the nouns (entity types) on a design surface. On the design
surface, we can model the relationships (associations) between entities. In our code, we program against
these entities and associations. LINQ allows us to express the set theoretical concepts of relational
databases directly in our code while working in terms of entity types and associations. All this elevates
the interactions with the data store to the conceptual level we design and reason about with our code.
When we work at the conceptual level for both code and data, we can worry less about the logical
schema of the data store and free ourselves from the noise of the glue code and third-party ORM tools.



M vt v M iTivd vl i et b iimiivii vy i

A Brief Tour of the Entity Framework World

Entity Framework is a collection of technologies for developing applications that use data. Unlike
previous Microsoft data-access technologies, Entity Framework, together with Visual Studio, is a
comprehensive, model-based ecosystem that you can use to develop a wide range of data-oriented
applications. You can develop desktop applications, server-side applications, Internet applications using
ASP.NET and Silverlight, and Windows Communication Foundation (WCF)-based multimachine
applications. In this book, we have recipes that will help you develop all these types of applications.

Let’s take a very brief look at some of the parts of the Entity Framework ecosystem. What follows is
not by any means a comprehensive description of Entity Framework; that would take hundreds of pages.
We'll look at just a few key things to help get you oriented for the recipes that are at the heart of this
book.

Models

Entity Framework is a technology that’s all about modeling. The modeling in Entity Framework
represents more of an evolutionary point than a revolutionary idea. As you work with models in Entity
Framework, you will see many familiar genetic markers from previous technologies and patterns. You
will, no doubt, see a family resemblance to entity-relationship diagrams and the long-used conceptual,
logical, and physical design layers approach.

Entity Framework uses models characterized by the Entity Data Model (EDM). The EDM is a formal
structure for defining data used in the applications you create with Entity Framework. The EDM defines
the data types, the specific definitions of what types of relationships are allowed, the schemas that
support the model, and the mapping between these schemas. The models you build and program
against are defined in terms of the EDM, but are not themselves Entity Data Models. It’s sort of like the
difference between a class and an instance of the class (an object). If you understand the definition of a
class, you know a great deal about the behavior of an instance of the class, but the two are quite
different. Although models in applications are often confused with the EDM (sometimes even in
Microsoft’s documentation), it’s important to emphasize the difference.

So what does the EDM say about the structure of models? Well, quite a lot as it turns out. First off, a
model is composed of three layers: a conceptual layer, a storage layer, and a mapping layer. The syntax
for each layer, that is, how it’s represented in a file, is XML-based. The schema for each of these layers is
defined, of course, by the EDM. XML is amenable to designer applications, can be consumed and
produced by developer tools, and is sort of human-readable. For convenience, all three of these layers
are usually bundled in single file in your project. The file has the .edmx extension.

The conceptual layer, or conceptual model, is perhaps the only part many developers see when they
work with a model. Visual Studio provides a full-featured designer that enables you to whiteboard the
high-level nouns (entity types) and relationships (associations) in our domain. On the conceptual layer,
there is no taint of a physical storage organization. With the designer you create entities, perhaps
establish inheritance hierarchies, and link entities together through associations. The syntax for the
conceptual model is defined by the Conceptual Schema Definition Language (CSDL).

Every useful application needs to persist objects to some data store. The store layer, or store model,
defines the data store. This includes the tables, columns, and data types that the EntityClient layer will
ultimately map to the underlying database. The syntax for the store model is defined in by the Store
Schema Definition Language (SSDL).

The mapping between the conceptual model and the store model is defined by the mapping layer.
Among other things, this layer defines how properties on entities map to columns on tables. Although it
is tucked away in the Mapping Details window, this mapping layer is also exposed to the developer
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through the designer. The syntax for the mapping layer is defined by the Mapping Specification
Language (MSL).

Terminology

There is a huge amount of terminology around Entity Framework. If you have used any of the popular
ORM tools or are familiar with database modeling, you've probably encountered some of the
terminology before. Much of the terminology is unique to Entity Framework. Here we’ll provide just a
few of the basic terms to get us started.

An EntityTypeis the “noun” in your model. An EntityType, like a class, defines a new type. An
instance of an EntityType is referred to as an entity. An EntityType is represented on the design surface
as a box with various properties. Figure 1-1 shows two EntityTypes: Employee and Task.

“: Employee & o Task x
= Properties = Properties
# EmployeeMumber 4 Taskld
ﬁ:‘Name 1 """""" . ﬁ:‘;—\ssignedld
57 Salary 57 Description
= Navigation Properties = Navigation Properties
B Tacks B Employee

Figure 1-1. A model with Employee and Task and a one-to-many association between them

Most of the time, in this book and throughout much of the documentation, blogs, forum posts, and
so on, you'll find people referring to a particular EntityType as just an entity. Following this somewhat
lazy approach, people will say that Figure 1-1 has two entities: Employee and Task, when really it has two
EntityTypes. For this section, we’ll stick with EntityType to be clear.

An EntityType usually has one or more properties. Just like with a class, a property is a named value
with a specific data type. Properties can have simple types like integer, string, and so on; or have
ComplexTypes; or be collections. Navigation properties refer to other entities in an association. The
non-navigation properties on an EntityType are usually just called scalar properties.

An Association between two EntityTypes is shown on the design surface as a line connecting the
EntityTypes. The line is annotated to show the multiplicity on each end of the association. The
association in Figure 1-1 is a one-to-many association between Employee and Task. An Employee can
have zero or more tasks. Each Task is associated to exactly one Employee.

Every EntityType has some set of properties which denote its EntityKey. An EntityKey for an entity
uniquely indentifies the entity to Entity Framework and is most often obtained from the entity’s
representation in the underlying database.

An EntitySet holds instances of an EntityType (or one of its derived types) at runtime. In most cases,
instances of a given EntityType are held in just one EntitySet, but we’ll cover examples of Multiple
EntitySets per Type (MEST).

A ComplexTypeis a set of related properties. A ComplexType does not have a key like an EntityType
does. A ComplexType is typically used to group related properties together to be reused in a model or to
simplify a model. For example, an Address ComplexType might group together address line 1, address
line 2, suite number, city, state, and ZIPCode. In a Customer EntityType, you might have a
BillingAddress and a ShipToAddress, each of type Address. This makes Customer a little simpler because
it doesn’t need individual properties for each part of the customer’s address (see Figure 1-2).
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= Navigation Properties

Figure 1-2. Address ComplexType that is the data type for both the BillingAddress and the ShipToAddress

for the customer

Code

The story of Entity Framework is not quite complete without code. After all, Entity Framework is just a
tool you use to create your applications. The models, EntityTypes, associations, mappings, and so on are
ultimately expressed in concrete code that becomes part of your application. This code is either
generated by Visual Studio and Entity Framework during the build process or else it is created by you,
the developer. You get to choose quite a bit about the code-generation process or the lack of it by
changing various properties on your project and modifying or creating code-generation templates.

Visual Studio uses a relatively new code-generation technology called Text Template
Transformation Toolkit, which is such mouthful everyone refers to it simply as T4 Templates. T4
Template support comes from the Domain Specific Language tools work that Microsoft has been doing
for some time. It is a way to provide a human-readable template that used to guide the tooling in Visual
Studio when it automatically generates code. The great thing about T4 Template support in Visual
Studio is that you can edit the templates to tailor the code-generation process to your needs. This is an
advanced technique, but it is necessary in some cases. We’ll show you how to do this in a few recipes.

Creating your own classes that implement your EntityTypes is often referred to as using Plain Old
CLR Objects or simply POCO. Your POCO classes typically don’t have any dependence on Entity
Framework plumbing. The recipes in Chapter 8 show you the basics of creating and using POCO. There
are also many recipes throughout the book that show you how to use POCO in specific contexts such as
in n-tier applications.

The workflow for code generation is managed during the build process by Windows Workflow
Foundation (WF). Although WF has been around for a while, the .NET 4.0 release contains a completely
re-engineered implementation and now an integration into Visual Studio 2010.

Visual Studio 2010

Of course, the main tool we use when developing applications for the Windows environment is Visual
Studio. This Integrated Development Environment has evolved over many years from a simple C++
compiler and editor to a highly integrated, multilanguage environment that supports the entire software
development lifecycle. Visual Studio and its related tools and services provide for design, development,
unit testing, debugging, software configuration management, build management and continuous
integration, and much more. Don’t be worried if you haven’t used all these in your work; few developers
have. The point is that Visual Studio 2010 is a full-featured toolset. Visual Studio plays a vital role in the
development of Entity Framework applications.
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Visual Studio provides an integrated design surface for Entity Framework models. Using this design
surface and other tools in Visual Studio, you can create models from scratch or create them from an
existing database.

If you have an existing database, which is the case for many of us with existing applications, Visual
Studio provides tools for importing your tables and relationships into a model. This approach, known as
Database First, is the best-supported modeling approach and the one we use in most of the recipes in
this book. This fits nicely with the real world because few of us have the luxury of developing brand-new
applications. Most of us have to extend, maintain, or evolve our existing code and databases.

When you create a model from scratch, also known as Model First, you start with an empty design
surface and add new EntityTypes to the surface and create both the associations and inheritance
hierarchies for your model. When you are done creating the model, right-click the design surface and
select Generate Database from Model. Not all modeling scenarios are currently supported with Model
First. In time, Model First will likely become the dominant modeling approach. For now, Model First is
great for many modeling scenarios for new applications.

Once you have created your model, changes often happen. That’s the nature of software
development. Visual Studio provides tools for updating the model from the database. This will keep the
model synchronized with changes in the database. Beware: updating the model will update the
conceptual model (.csdl), but may also change the underlying store model (.ssdl). This is fine if you
haven’t manually edited the store model (which we do in some recipes). If you have edited the store
model, you may find that you have to reapply your changes. We’ll warn you in the recipes in this book
when updating the model will make changes to your store model.

Using Entity Framework

Entity Framework is an integral part of Visual Studio 2010. One simple way to start using Entity
Framework is to include a new ADO.NET Entity Data Model in your project. Right-click your project and
select Add »New Item. In the dialog box (see Figure 1-3), choose the ADO.NET Entity Data Model
template. This template is located under the Data templates. Click Add to launch the Entity Data Model
Wizard.
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Figure 1-3. Adding a new model to your project

There are two options on the first page of the Entity Data Model Wizard: start with an existing
database or start with an empty model. This first page is shown in Figure 1-4.
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Entity Data Model Wizard (2] = |

J— 1 Choose Model Contents
—— =

‘What should the model contain?

B

Generate  Empty model
from d...

Generates the model from a database. Classes are generated from the model when the project is compiled.
This wizard also lets you specify the database connection and database objects to include in the model.

e

Figure 1-4. The Entity Data Model Wizard gives you a choice between creating a model from an existing
database or starting with an empty model

Generating a model from an existing database is the Database First approach. The wizard will create a
model based on one or more tables, views, and stored procedures from an existing database. With just a
few exceptions, the tables you include will be modeled as EntityTypes. If the tables you include are
related in the database, these relationships will be modeled as associations. This is a great way to create
your model if you already have a database for your application. If you're working on a brand-new
application, you may want to start with an empty model. This approach is called Model First.

With Model First, you are presented with an empty design surface. Right-click the design surface to
create new EntityTypes, associations, or inheritances. You can also drag them from the Toolbox onto the
design surface. Once your model is complete, just right-click the design surface and select Generate
Database from Model. This will generate a script you can use to create the database tables and
relationships for the model.

With either Model First or Database First, you use the designer to develop your model. The key parts
of amodel in the designer are shown in Figure 1-5. In this model, a Customer is in a one-to-many
association with an Order. Each customer may have many orders, but each order is associated with just
one customer. The Mapping Details window shows that the Customer EntityType maps to the Customer
table in the database. The Mapping Detail window also shows the mapping between the columns in the
Customer table and the scalar properties in the Customer EntityType.
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Figure 1-5. Key parts of a model in the designer

Of course, there is alot more to the designer and the model than just the few key parts illustrated in
Figure 1-5. In the recipes in this book, we’ll cover just about every aspect of using the designer to create
models. In some cases, we go beyond what can be done with the designer and show you how to create
models that require directly editing the underlying .edmx file. The .edmx file contains the complete
model definition, including the conceptual layer, store layer, and mapping layer.

Okay, now that you have a model, how do you program against it? Well, that’s where Entity
Framework really shines: you program against objects in the model (EntityTypes) as you do with other
objects in your application. For the model in Figure 1-5, your code uses Customer and Order in much
the same way as you use other objects.

If you want to insert a new customer and order into the database, you can use the new operator to
create instances of the Customer and Order types, set the properties, add them to the in-memory
context that represents the model, and call SaveChanges (). All the necessary SQL code is generated and
sent to the database to insert the rows. To retrieve customers and orders from the database, you use
either LINQ or Entity SQL to create a query in terms of the EntityTypes and associations in the model.

The recipes throughout this book will show you step by step how to model just about every
conceivable database scenario; how to query, insert, update, and delete using these models; and how to
use Entity Framework in many kinds of applications.



CHAPTER 2

Entity Data Modeling Fundamentals

Entity Framework is a new technology from Microsoft. More likely than not, you are just beginning to
explore Entity Framework and you are probably asking the question, “Okay, how do I get started?” If this
describes you, this chapter is a great place to start. If, on the other hand, you have built some working
models and feel comfortable with a few key modeling concepts such as entity splitting and inheritance,
you can skip this chapter.

In this chapter, we will walk you through the basic examples of modeling with Entity Framework.
Modeling is the core feature of Entity Framework and what distinguishes Entity Framework from
previous Microsoft data access platforms. Once you have built your model, you can write code against
the model rather than against the rows and columns in the relational database.

We start off this chapter with an example of how to create a simple conceptual model and let Entity
Framework create the underlying database. In the remaining examples, we will show you how to create
models from existing tables and relationships in your databases.

2-1. Creating a Simple Model

Problem

You have a brand new project and want to create a model with just one entity.

Solution

Let’s imagine you want to create an application to hold names and phone numbers of people you know.
To keep things simple, let’s assume you need just one entity type: Person.
To create the new model, do the following:

1. Right-click your project and select Add » New Item.

2. From the templates, select ADO.NET Entity Data Model and click Add. This
template is located in Data under Visual C# Items. See Figure 2-1.

3. In the first step of the wizard, choose Empty Model and click Finish. The
wizard will create a new conceptual model with an empty design surface.

4. Right-click the design surface and select Add » Entity.
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5. Type Person in the Entity name field and select the box to Create a key
property. Use Id as the Key Property. Make sure its Property Type is Int32.
Click OK, and a new Person entity will appear on the design surface. See Figure

2-2.

6. Right-click near the top of the Person entity and select Add » Scalar Property.
A new scalar property will be added to the Person entity.

7. Rename the scalar property FirstName. Add scalar properties for LastName,

MiddleName, and PhoneNumber.

8. Right-click the Id property and select Properties. In the properties view,
change the StoreGeneratedPattern property to Identity. This flags the Id
property as a value that will be computed by the store layer (database). The
database script we get at the end will flag the Id column as an identity column,
and the storage model will know that the database will automatically manage

the values in this column.

The completed conceptual model should look like the model in Figure 2-3.

-
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General Qﬁ ADO.NET Entity Data Model
Web =
Windows Forms ﬁ DataSet
WPF ==
Reporting <02 LINQ to SQL Classes
Workflow .

Online Templates _J Local Database
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Visual C# Itemns
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Visual C# Items
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Visual C# Iterns

Visual C# Itermns

| Search Installed Templates
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Entity Data Model,
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Figure 2-1. Adding a new .emdx file that contains XML describing the conceptual model, storage model,

and mapping layer
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Figure 2-2. Adding a new entity type representing a Person in our conceptual model
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Figure 2-3. Our completed model with an entity type representing a Person

You now have a simple conceptual model. To generate a database for our model, there are a few things
we still have to do:

9. We need to change a couple of properties of our model to help with the
housekeeping. Right-click the design surface and select properties. Change the
Database Schema Name to Chapter2 and change the Entity Container Name
to EFRecipesEntities. Figure 2-4 illustrates these changes.

11



~MEiraw Tt &

12

10. Right-click the design surface and select Generate Database Script from
Model. Select an existing database connection or create a new one. In Figure 2-
5, we've opted to create a new connection to our local machine and to the
database EFRecipes.

11. Click OK to complete the connection properties and click Next to preview the
database script (see Figure 2-6). Once you click Finish, the generated script is
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added to your project.

12. Run the database script in a query window to create the People table.

Properties
Recipel ConceptualEntityModel

g2l =l
Code Generation Strategy
Connection String
Database Generation Workflow
Database Scherna Name
DDL Generation Template
Entity Container Access
Entity Container Name
Lazy Loading Enabled
Metadata Artifact Processing
MNamespace
Pluralize Mew Objects

Validate On Build

Code Generation Strategy

Transform Related Text Templates On Save

Default

TablePerTypeStrategy.xaml (V5]
Chapter2

SSDLToSQL10.H (VS)

Public

EFRecipesEntities

True

Embed in Output Assembly
Recipel

True

True

True

Used to set the code generation strategy of this model. The 'Custom Tool' associated
with this model, accessible from the properties on this item in the solution explorer, ...

Figure 2-4. Changing the properties of our model
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Figure 2-5. Creating a new database connection that will be used by Entity Framework to create a
database script that we can use to create a database from our conceptual model

13
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Generate Database Wizard | ? B

J— 1 Summary and Settings
—— =

Save DDL As:  Recipel.edmx.sgl

DDL

-- Entity Designer DDL Script for SQL Server 2005, 2008, and Azure

m

-- Date Created: 02/25/2010 18:53:20
-- Generated from EDMX file: \Recipel\Recipel\Recipel.edmx

SET QUOTED_IDENTIFIER OFF;

GO

USE [EFRecipes]:

GO

IF SCHEMA_ID(N'Chapter2') IS NULL EXECUTE(N'CREATE SCHEMA [Chapter2]);
GO

-- Dropping existing FOREIGN KEY constraints

’ Finish ] [ Cancel l

Figure 2-6. Generating the storage model in the .edmx file and creating the database script

How It Works

The Entity Framework Designer is a powerful tool for creating and updating a conceptual model, storage
model, and mapping layer. This tool provides support for bidirectional model development. You can
either start with a clean design surface and create a model; or start with a database you already have and
import it to create a conceptual model, storage model, and mapping layer. The current version of the
Designer supports somewhat limited roundtrip modeling, allowing you to re-create your database from
amodel and update the model from changes in your database.

The model has a number of properties that affect what goes in the generated storage model and
database script. We changed two of these properties. The first was the name of the container. This is the
class derived from ObjectContext. We called this EFRecipesEntities to be consistent with the contexts we
use throughout this book.

Additionally, we changed the schema to “Chapter 2.” This represents the schema used to generate
the storage model as well as the database script.

The code in Listing 2-1 demonstrates one simple way to create and insert instances of our Person
entity type. The code also demonstrates iterating through all the Person entities in our database.
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Listing 2-1. Inserting into and retrieving from our model

using (var context = new EFRecipesEntities())

}

var person = new Person() { FirstName = "Robert", MiddleName="Allen",
LastName = "Doe", PhoneNumber = "867-5309" };

context.People.AddObject(person);

person = new Person() { FirstName = "John", MiddleName="K.",
LastName = "Smith", PhoneNumber = "824-3031" };

context.People.AddObject(person);

person = new Person() { FirstName = "Billy", MiddleName="Albert",
LastName = "Minor", PhoneNumber = "907-2212" };

context.People.AddObject(person);

person = new Person() { FirstName = "Kathy", MiddleName="Anne",
LastName = "Ryan", PhoneNumber = "722-0038" };

context.People.AddObject(person);

context.SaveChanges();

using (var context = new EFRecipesEntities())

foreach (var person in context.People)

System.Console.WriteLine("{0} {1} {2}, Phone: {3}"
person.FirstName, person.MiddleName,
person.LastName, person.PhoneNumber);

-

The output of the code in Listing 2-1 should look something like the following:

John K. Smith, Phone: 824-3031

Robert Allen Doe, Phone: 867-5309

Kathy Anne Ryan, Phone: 722-0038

Billy Albert Minor, Phone: 907-2212

15
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Best Practice

When we created a new instance of the object context, we did it within a using() statement:

using (var context = new EFRecipesEntities())

}

If you are not familiar with this pattern, it’s really pretty simple. Normally, when we get a new instance of
an object, we use the new operator and assign the result to some variable. When the variable goes out of
scope and the object is not longer referenced by anything else, the garbage collector will do its job at some
point and reclaim the memory for the object. That works great for most of the objects we create in our
.NET applications because most objects hold on to resources that can wait around for whenever the
garbage collector has a chance to reclaim them. The garbage collector is rather nondeterministic. It
reclaims resources pretty much on its own schedule, which we can only partially influence.

Instances of ObjectContext hold on to resources such as database connections that we want to release
as soon as we’re done with them. We don’t really want these database connections to stay open waiting
for the garbage collector to eventually reclaim them.

There are a few nice features of using statements. First, when the code execution leaves the using() {}
block, the Dispose() method on the context will be called (because ObjectContext implements the
IDisposable interface). For ObjectContext, the Dispose() method closes any active database connections
and properly cleans up any other resources that need to be released.

Second, no matter how the code leaves the using(){} block, the Dispose() method is called. Most
importantly, this includes return statements and exceptions that may be thrown within the code block. The
using(){} block is kind of a guarantee that critical resources will be reclaimed properly.

The best practice here is to always wrap your code in the using(){} block when creating new instances
of ObjectContext. It's one more step to help bullet-proof your code.

2-2. Creating a Model from an Existing Database

Problem

You have an existing database with a few tables, perhaps a few views, and some foreign key constraints,
and you want to create a model for this database.

Solution

Let’s say you have database describing poets and their poetry. Your relational database might look
something like the diagram in Figure 2-7.
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Poet (Chapter2) Poem (Chapter2) Meter (Chapter2)
@ Poetld ¥ Poemld @ Meterld
Firsthame 2 Poetld > - MeterMName
MiddleName Title
LastMame Meterld

Figure 2-7. A simple database for poets and their poetry

From this database diagram, you can see that a poet can be the author of one or more poems and each
poem can be categorized by its meter, which is the basic pattern of a poem’s verse. It’s not shown in this
diagram, but our database also has a view that joins the tables together so that we can more easily
enumerate each poet, poem, as well as the poem’s meter.

To import the view, tables, and relationships into a model, do the following:

1.
2.
3.

Right-click your project and select Add » New Item.
From the Visual C# Items Data templates, select ADO.NET Entity Data Model.

Select Generate from database to create the model from our existing tables.
Click Next.

Either choose an existing connection to your database or create a new
connection. If you are creating a new connection, you will need to select your
database server, your authentication method (Windows or SQL Server), and
the database. Once you have selected these, it’s a good idea to click Test
Connection to be sure the connection is ready to go. Once you have tested the
connection, click Next.

The next dialog box shows all the tables, views, and stored procedures in the
database. Check the items you want to include in the model. We want to select
all the tables (Meter, Poem, and Poet). We also want to select the view
(vwLibrary). For now, leave the two check boxes for pluralizing and including
foreign key columns selected. We’ll talk more about them in a minute. Figure
2-8 shows the things we’ve selected.

17
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Pluralize or singularize generated object names
Include Foreign Key Columns in the Model
Model Namespace:

EFRecipesModel

lext > [ Finish ] ’ Cancel ]

Figure 2-8. Selecting the tables and view to include in our model. Leave the Pluralize or singularize
generated object names and Include Foreign Key Columns in the Model checked.

When you click Finish, the wizard will create a new model with our three tables and the view. The wizard
will also read the foreign key constraints from the database and infer a one-to-many relationship
between Poet and Poem(s) as well as a one-to-many relationship between Meter and Poem(s).

Figure 2-9 shows the new model created for us by including the Poet, Poem, and Meter tables as well
as the vwLibrary view.
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Figure 2-9. Our completed model

You now have a model you can use in your code. Note that the vwLibrary entity is based on the
vwLibrary view in our database. In most databases, views are read only objects: inserts, deletes, and
updates are typically not supported at the database layer. This is also the case with Entity Framework.
Entity Framework considers views read only. You can get around this by mapping stored procedures for
the create, update, and delete actions for view-based entities. We will show you how to do just that in
Chapter 6.

How It Works

Let’s look at the model created for us by the importing process. First, notice that the entities have scalar
properties and navigation properties. The scalar properties map to the columns in the tables of the
database while the navigation properties are derived from the relationships between the tables.

In our database diagram, a poem has a meter and a poet (the author). These correspond to the
Meter and Poet navigation properties. If we have an instance of a Poem entity, the Poet navigation
property holds an instance of a Poet entity while the Meter navigation property holds an instance of a
Meter entity. A poet can be the author of any number of poems. The Poems navigation property
contains a collection of instances of the Poem entity. This collection can be empty, of course, for those
poets that have yet to write any poetry. For the Meter entity, the Poems navigation property is also a
collection. For this navigation property, the collection holds instances of Poems that have the given
meter. Our database did not contain any relationships with the vwLibrary view and our model reflects
this with an empty set of navigation properties on the vwLibrary entity.

Notice that the Import Wizard was smart enough to pluralize the navigation properties that
contained collections. If you right-click the entities and look at their properties, you will notice that the
entity set names for each of the entities is also property pluralized. For example, the entity set name for
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the Poem entity is Poems. This automatic pluralization happened because we left the Pluralize or
singularize generated object names option checked.

The Include Foreign Key Columns in the model option caused the foreign keys to be included in the
model as well. Although it may seem a little unnecessary to have both foreign keys and navigation
properties, we'll see in many of the following recipes that having direct access to the foreign keys can be
useful.

The code in Listing 2-2 demonstrates how to create instances of Poet, Poem, and Meter entities in
our model and how to save these entities to our database. The code also shows you how to query the
model to retrieve the poets and poems from the database.

In the first block of code in Listing 2-2, we create instances of the Poet, Poem, and Meter entity types
for the poet John Milton, his poem “Paradise Lost,” and the meter for the poem—which in this case is
Iambic Pentameter. Once we have created the instances of the entity types, we set the poem’s Meter
property to the meter instance and the poem’s Poet property to the poet instance. Using the same
approach we build up the other entities relating each poem to its meter and poet. Once we have
everything in place, we call SaveChanges()to generate and execute the appropriate SQL statements to
insert the rows into the underlying database.

Listing 2-2. Inserting into and querying our model

using (var context = new EFRecipesEntities())

var poet = new Poet { FirstName = "John", LastName = "Milton" };
var poem = new Poem { Title = "Paradise Lost" };

var meter = new Meter { MeterName = "Iambic Pentameter" };
poem.Meter = meter;

poem.Poet = poet;

context.Poems .AddObject (poem);

poem = new Poem { Title = "Paradise Regained" };

poem.Meter = meter;

poem.Poet = poet;

context.Poems.AddObject (poem);

poet = new Poet { FirstName = "Lewis", LastName = "Carroll" };
poem = new Poem { Title = "The Hunting of the Shark" };

meter = new Meter { MeterName = "Anapestic Tetrameter" };
poem.Meter = meter;

poem.Poet = poet;

context.Poems.AddObject (poem);

poet = new Poet { FirstName = "Lord", LastName = "Byron" };
poem = new Poem { Title = "Don Juan" };

poem.Meter = meter;

poem.Poet = poet;

context.Poems.AddObject (poem);

context.SaveChanges();

}

using (var context = new EFRecipesEntities())
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var poets = from p in context.Poets select p;
foreach (var poet in poets)

{
Console.WriteLine("{0} {1}", poet.FirstName, poet.LastName);
foreach (var poem in poet.Poems)
{
Console.WriteLine("\t{o} ({1})", poem.Title, poem.Meter.MeterName);
}
}

}

// using our wwlLibrary view
using (var context = new EFRecipesEntities())

var items = from i in context.wwlLibraries select i;
foreach (var item in items)

{
Console.WriteLine("{0} {1}", item.FirstName, item.LastName);
Console.WriteLine("\t{o} ({1})", item.Title, item.MeterName);
}
}
The output from the code in Listing 2-2 is the following:
Lord Byron

Don Juan (Anapestic Tetrameter)
Lewis Carroll

The Hunting of the Shark (Anapestic Tetrameter)
John Milton

Paradise Regained (Iambic Pentameter)

Paradise Lost (Iambic Pentameter)
Lewis Carroll

The Hunting of the Shark (Anapestic Tetrameter)
Lord Byron

Don Juan (Anapestic Tetrameter)

John Milton
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Paradise Regained (Iambic Pentameter)
John Milton

Paradise Lost (Iambic Pentameter)

In the code, we start by creating and initializing instances of the poet, poem, and meter for the first
of John Milton’s poems. Once we have these in place, we set the poem’s Meter navigation property and
the poem’s Poet navigation property to the instances of poem and meter. Now that we have the poem
instance completed, we add it using the AddToPoems () method. Entity Framework does all the remaining
work of adding the poem to the Poems collection on the poet instance and adding the poem to the
Poems collection on the meter instance. The rest of the setup follows the same pattern. To shorten the
code, we reuse variables and instances where we can.

Once we have the all the objects created and all the navigation properties initialized, we have
completed the object graph. Entity Framework keeps track of the changes we’ve made to build the object
graph. These changes are tracked in the object context. Our context variable contains an instance of the
object context (it’s of type ObjectContext) and is what we used to build the object graph. To send these
changes to the database, we call the SaveChanges () method.

To query our model and, of course, verify that we did indeed save everything to the database, we
grab a fresh instance of the object context and query it using LINQ to Entities. We could have reused the
same instance of the object context, but then we know it has the object graph and any subsequent
queries we do against it won'’t flow through to the database because the graph is already in memory.

Using LINQ to Entities, we query for all the poets, and for each poet we print out the poet’s name
and the details for each of their poems. The code is pretty simple, but it does use a couple of nested for
loops.

The last block of code uses the vwLibrary entity. This entity is based on our vwLibrary view. This
view joins the tables together to flatten things out a bit and provide a cleaner perspective. When we
query for each poet against the vwLibraries entity set, we can get by with just one for loop. The output is
a little different because we repeat the poet’s name for each poem.

There is one last thing to note in this example. We didn’t insert the poets, poems, and meters using
the vwLibrary entity because views are always read-only in most database systems. In Entity Framework,
we can’t insert (or update, or delete) entities that are based on views. Of course, we’ll show you exactly
how to overcome this little challenge in many of the recipes in this book!

2-3. Modeling a Many-to-Many Relationship with No Payload

Problem

You have a couple of tables in an existing database that are related to each other via a link or junction
table. The link table contains just the foreign keys used to link the two tables together into a many-to-
many relationship. You want to import these tables model this many-to-many relationship.

Solution

Let’s say your database tables look something like the database diagram in Figure 2-10.
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Album (Chapter2) LinkTable (Chapter2) Artist (Chapter2)
% AlbumId k1 e | ArtistId s O | B Artistld

AlbumMName % AlbumId Firsthame
MiddleName

LastMame

Figure 2-10. Artists and albums in a many-to-many relationship

To create a model and import these tables and relationships, do the following:

1. Add a new model to your project by right-clicking your project and selecting
Add » New Item. Choose ADO.NET Entity Data Model from the Visual C#
Items Data templates.

2. Select Generate from database. Click Next.

3. Use the wizard to select an existing connection to your database or create a
new connection.

4. From the Choose Your Database Object dialog box, select the tables Album,
LinkTable, and Artist. Leave the Pluralize and Foreign Key options checked.
Click Finish.

The wizard will create the model shown in Figure 2-11.

“ Artist 3
2 Album 3
= Properties
= Properties 5 Artistld
r%‘;-\Ibumld 57 FirstName
25 AlbumName * +| [ MiddleName
5 LastMame

=l Navigation Properties

= . =l Navigation Properties
-—t—l Artists g P

-5_—1 Albums

Figure 2-11. Our model with a many-to-many relationship between our tables

The many-to-many relationship between Album and Artist is represented by a line with the *
character on both ends. Because an Album can have many Artists and an Artist can responsible for many
Albums, each of these navigation properties is of type EntityCollection.

How It Works

In Figure 2-11, an artist can be related to many albums, whereas an album can be the work of many
artists. Notice that the link table from Figure 2-10 is not represented as an entity in our model. Because
our link table has no scalar properties (that is, it has no payload), Entity Framework assumes that its sole
purpose is to create the association between Album and Artist. If the link table had scalar properties,
Entity Framework would have created a very different model, as we will see in the next Recipe.
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The code in Listing 2-3 demonstrates how to insert new albums and artists into our model and how
to query our model both for artists and their albums and albums with their artists.

Listing 2-3. Inserting and querying our artists and albums model through the many-to-many association

using (var context = new EFRecipesEntities())

// add an artist with two albums

var artist = new Artist { FirstName = "Alan", LastName = "Jackson" };
var albumi = new Album { AlbumName = "Drive" };

var album2 = new Album { AlbumName = "Live at Texas Stadium" };
artist.Albums.Add(albumi);

artist.Albums.Add(album2);

context.Artists.AddObject(artist);

// add an album for two artists

var artisti = new Artist { FirstName = "Tobby", LastName = "Keith" };
var artist2 = new Artist { FirstName = "Merle", LastName = "Haggard" };
var album = new Album { AlbumName = "Honkytonk University" };
artist1.Albums.Add(album);

artist2.Albums.Add(album);

context.Albums.AddObject(album);

context.SaveChanges();

}

using (var context = new EFRecipesEntities())

Console.WriteLine("Artists and their albums...");
var artists = from a in context.Artists select a;
foreach (var artist in artists)

{
Console.WriteLine("{0} {1}", artist.FirstName, artist.LastName);
foreach (var album in artist.Albums)
{
Console.WriteLine("\t{0}", album.AlbumName);
}
}

Console.WriteLine("\nAlbums and their artists...");
var albums = from a in context.Albums select a;
foreach (var album in albums)

{
Console.WriteLine("{0}", album.AlbumName);
foreach (var artist in album.Artists)
{
Console.WriteLine("\t{0o} {1}", artist.FirstName, artist.LastName);
}
}
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The output from the code in Listing 2-3 looks like the following:

Artists and their albums...
Alan Jackson

Drive

Live at Texas Stadium
Tobby Keith

Honkytonk University
Merle Haggard

Honkytonk University

Albums and their artists...
Drive

Alan Jackson
Live at Texas Stadium

Alan Jackson
Honkytonk University

Tobby Keith

Merle Haggard

After getting an instance of our object context, we create and initialize an instance of an Artist entity
type and a couple of instances of the Album entity type. We add the albums to the artist and then add the
artist to the Object Context.

Next, we create and initialize a couple instances of the Artist entity type and an instance of the
Album entity type. Because the two artists collaborated on the album, we add the album to both artists’
Albums navigation property (which is of type EntityCollection). Adding the album to the Object Context
causes the artists to get added as well.

Now that the completed object graph is part of the object context, the only thing left to do is to use
SaveChanges() to save the whole thing to the database.
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When we query the database in a brand new Object Context, we grab the artists and display their
albums. Then we grab the albums and print the artists that created the albums.

Notice that we never refer to the underlying LinkTable from Figure 2-10. In fact, this table is not
even represented in our model as an entity. The LinkTable is represented in the many-to-many
association which we access via the Artists and Albums navigation properties.

2-4. Modeling a Many-to-Many Relationship with a Payload

Problem

You have a many-to-many relationship in which the link table contains some payload data (any
additional columns beyond the foreign keys) and you want to create a model that represents the many-
to-many relationship as two one-to-many associations.

Solution

Entity Framework does not support associations with properties, so creating a model like the one in the
previous recipe won’t work. As we saw in the previous recipe, if the link table in a many-to-many
relationship contains just the foreign keys for the relationship, Entity Framework will surface the link
table as an association and not as an entity type. If the link table contains additional information, Entity
Framework will create a separate entity type to represent the link table. The resulting model will contain
two one-to-many associations with an entity type representing the underlying link table.

Suppose we have the tables and relationships shown in Figure 2-12.

Order (Chapter2) OrderItem (Chapter2) Item (Chapter2)
% Orderld lxfi——cx3 | % Orderld s o | P OSKU
OrderDate ¥ 5KU Description

Count Price

Figure 2-12. A many-to-many relationship with payload

An Order can have many Items. An Item can be on many orders. Additionally, we have a Count property
connected to each instance of the Order, Item relationship. This Count property is referred to as a
payload.

To create a model and import these tables and relationships into the model, do the following:

1. Add a new model to your project by right-clicking your project and selecting
Add » New Item. Choose ADO.NET Entity Data Model from the Visual C# Data
templates.

2. Select Generate from database. Click Next.

3. Use the wizard to select an existing connection to your database or create a
new connection.
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4. From the Choose Your Database Object dialog box, select the tables Order,
OrderItem, and Item. Leave the Pluralize and Foreign Key options checked.
Click Finish.

The wizard will create the model in Figure 2-13.

¢ Orderltem & S —
2 oder & “e Item x
¢ Order X 5
= Properties
= Properi
= Properties % Orderld t?erE ies
SKU
% Orderld (SEU S g o
= OrderDate 1 * [ Count . 1 o escription
Price
= Mavigation Properties = Mavigation Properties
= ’ g & Item = Navigation Properties
= =4 o
e E Order = Orderltems

Figure 2-13. Two one-to-many associations from a many-to-many relationship with payload

How It Works

As we saw in the previous recipe, for a many-to-many relationship with no payload, the model is clean
and simple to navigate. Because Entity Framework does not support the notion of payloads on
associations, it surfaces the link table as an entity with two one-to-many associations to the related
entities. In this case, the OrderItem table is represented not as an association, but as an entity type with
a one-to-many association to Order and a one-to-many association to Item. In the previous recipe, the
payload-free link table did not translate into an entity type in the model. Instead, it became part of the
many-to-many association.

The addition of a payload requires an additional hop through the entity representing the link table
to retrieve the related items. This is illustrated in code in Listing 2-4.

Listing 2-4. Inserting into and retrieving from the model

using (var context = new EFRecipesEntities())

var order = new Order { OrderId = 1,
OrderDate = new DateTime(2010, 1, 18) };
var item = new Item { SKU = 1729, Description = "Backpack",
Price = 29.97M };

var oi = new OrderItem { Order = order, Item = item, Count = 1 };
item = new Item { SKU = 2929, Description = "Water Filter”,

Price = 13.97M };
oi = new OrderItem { Order = order, Item = item, Count = 3 };
item = new Item { SKU = 1847, Description = "Camp Stove",

Price = 43.99M };
oi = new OrderItem { Order = order, Item = item, Count = 1 };
context.Orders.AddObject(order);
context.SaveChanges();
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using (var context = new EFRecipesEntities())

foreach (var order in context.Orders)

{

Console.WriteLine("Order # {0}, ordered on {1}",
order.OrderId.ToString(),
order.OrderDate. ToShortDateString());

Console. WIlteLlne("SKU\tDescrlptlon\toty\tPrlce"),

Console. WIlteLlne( A \t---\t----- ");

foreach (var oi in order.OrderItems)

Console.WriteLine("{o}\t{1}\t{2}\t{3}", oi.Item.SKU,
oi.Item.Description, oi.Count.ToString(),
oi.Item.Price.ToString("C"));

}

}

The following is the output from the code shown in Listing 2-4.

Order # 1, ordered on 1/18/2010

SKU Description Qty Price

1729  Backpack 1 $29.97
1847  Camp Stove 1 $43.99
2929  Water Filter 3 $13.97

After we create the an instance of our object context, we create and initialize an order entity as well
as the items and order items for the order. We connect the order with the items by initializing the
Orderltem entities with the instances of the Order entity and the Item entity. We use the AddToOrders ()
method to add the order to the context.

With the object graph complete and the order added to the context, we update the database with the
SaveChanges () method.

To retrieve the entities from the database, we create a fresh instance of the context and iterate
through the context.Orders collection. For each order (well, we just have one in this example), we print
the order detail and we iterate through the entity collection on the OrderItems navigation property.
These instances of the Orderltem entity type give us access to the Count scalar property (the payload)
directly and each item on the order via the Item navigation property. Going through the Orderltems
entity to get to the items is the “extra” hop that is the cost of having a payload in the link table
(OrderItems, in our example) in a many-to-many relationship.
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Best Practice

Unfortunately, a project that starts out with several, payload-free, many-to-many relationships often ends
up with several, payload-rich, many-to-many relationships. Refactoring a model, especially late in the
development cycle, to accommodate payloads in the many-to-many relationships can be tedious. Not only
are additional entities introduced, but the queries and navigation patterns through the relationships change
as well. Some developers argue that every many-to-many relationship should start off with some payload,
typically a synthetic key, so the inevitable addition of more payload has significantly less impact on the
project.

So here’s the best practice. If you have a payload-free, many-to-many relationship and you think there is
some chance that it may change over time to include a payload, start with an extra identity column in the
link table. When you import the tables into your model, you will get two one-to-many relationships, which
means the code you write and the model you have will be ready for any number of additional payload
columns that come along as the project matures. The cost of an additional integer identity column is
usually a pretty small price to pay to keep the model more flexible.

2-5. Modeling a Self-Referencing Relationship

Problem

You have a table that references itself and you want to model this as an entity with a self-referencing
association.

Solution

Let’s say you have a self-referencing table that’s like the one in the database diagram in Figure 2-14.

PictureCategory (Chapter2)

¥ Categoryld
Name

i ParentCategoryld

Figure 2-14. A self-referencing table
To create a model and import this table and the self-referencing relationship into the model, do the
following:

1.  Add a new model to your project by right-clicking your project and selecting
Add » New Item. Choose ADO.NET Entity Data Model from the Visual C# Data
templates.

2. Select Generate from database. Click Next.
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3. Use the wizard to select an existing connection to your database or create a
new connection.

4. From the Choose Your Database Object dialog box, select the PictureCategory
table. Leave the Pluralize and Foreign Key options checked. Click Finish.

The wizard will create a model like the one shown in Figure 2-15.
“¢ PictureCategory %

= Properties
#4 Categoryld
ﬁ] Mame
f ParentCategoryld

= Navigation Properties

B PictureCategoryl

Bl PictureCategory2

0.1 *
Figure 2-15. Our initial model of a self-referencing PictureCategory table

The model generated by the wizard contains two navigation properties named PictureCategoryl and
PictureCategory2. Neither of these names is particularly helpful, so let’s change them. One of these
navigation properties refers to the parent category or the 0..1 side of the relationship. The other refers to
the children or the * side of the relationship. To sort out which is which, right-click PictureCategoryl. In
the property window, the multiplicity for PictureCategoryl is * (many), so PictureCategoryl represents
the navigation property for the children or subcategories. Rename PictureCategoryl to Subcategories.
Change PictureCategory?2 to ParentCategory.

The resulting model is shown in Figure 2-16.

“¢ PictureCategory %

= Properties
#4 Categoryld
ﬁ] Mame
f ParentCategoryld

Navigation Properties

= sube ategories

Bl ParentCategory

0.1 | *

Figure 2-16. The model with the correctly named navigation properties

How It Works

Database relationships are characterized by degree, multiplicity, and direction. Degree is the number of
entity types that participate in the relationship. Unary and binary relationships are the most common.
Tertiary and n-place relationships are more theoretical than practical.

Multiplicity is the number of entity types on each end of the relationship. You have seen the
multiplicities 0..1 (zero or 1), 1 (one), and * (many).
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Finally, the direction is either one-way or bi-directional.

The Entity Data Model supports a particular kind of database relationship called an Association
Type. An Association Type relationship has either unary or binary degree, multiplicities 0..1, 1, or * and
the direction is bi-directional.

In this example, the degree is unary (just the entity type PictureCategory is involved), the
multiplicity is 0..1 and *, and the direction is, of course, bi-directional.

As is the case in this example, a self-referencing table often denotes a parent-child relationship with
each parent having many children while each child has just one parent. Because the parent end of the
relationship is 0..1 and not 1, it is possible for a child to have no parent. This is just what you want to
leverage in representing the root node; that is, the one node that has no parent and is the top of the
hierarchy.

Listing 2-5 shows how you can recursively enumerate the picture categories starting with the root
node, which of course, is the only node that has no parent.

Listing 2-5. Inserting into our model and recursively enumerating all the instances of the self-referencing
entity

static void RunExample()

{

using (var context = new EFRecipesEntities())

var louvre = new PictureCategory { Name = "Louvre" };

var child = new PictureCategory { Name = "Egyptian Antiquites" };
louvre.Subcategories.Add(child);
child = new PictureCategory { Name
louvre.Subcategories.Add(child);
child = new PictureCategory { Name
louvre.Subcategories.Add(child);
var paris = new PictureCategory { Name = "Paris" };
paris.Subcategories.Add(louvre);

var vacation = new PictureCategory { Name = "Summer Vacation" };
vacation.Subcategories.Add(paris);
context.PictureCategories.AddObject(paris);
context.SaveChanges();

"Sculptures" };

"Paintings" };

}
using (var context = new EFRecipesEntities())

PictureCategory root = (from c in context.PictureCategories
where c.ParentCategory == null
select c).FirstOrDefault();

Print(root, 0);

}
static void Print(PictureCategory cat, int level)
StringBuilder sb = new StringBuilder();
Console.WriteLine("{0}{1}", sb.Append(' ', level).ToString(), cat.Name);

foreach (PictureCategory child in cat.Subcategories)

{
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Print(child, level + 1);

The output of the code in Listing 2-5 shows our root node: Summer Vacation. The first (and only)
child is Paris. Paris has Louvre as a child. And finally, at the Louvre, we categorized our pictures by the
various collections we visited.

Summexr Vacation

Paris
Louvre
Egyptian Antiquites
Sculptures

Paintings

Okay, the code is a little involved. First, we create and initialize the instances of our entity types. We wire
them together in the object graph by adding the PictureCategories to our louvre category. Then we add
the louvre category to the paris category. Finally, we add the paris category to our summer vacation
category. We build the hierarchy from the bottom up.

Once we do a SaveChanges (), the inserts are all done on the database, and it’s time to query our
tables to see whether we’ve actually inserted all the rows correctly.

For the retrieval part, we start by getting the root entity. This is the one that has no parent. In our
case, we created a summer vacation entity, but we didn’t make it the child of any other entity. This
makes our summer vacation entity the root of the hierarchy.

Now with the root, we call another method we wrote: Print(). The Print() method takes a couple of
parameters. The first parameter is an instance of a PictureCategory. The second parameter is a level, or
depth we are at in the hierarchy. With the root category, summer vacation, we're at the top of the
hierarchy, so we pass in 0. The method call looks like Print(root, 0).

In the Print() method, we write out the name of the category preceded by a space for each level
deep in the hierarchy. One of the Append() methods of the StringBuilder class takes a character and a
integer count. It creates an instance of StringBuilder with the character appended count number of
times. In our call, we send in a space and level and it returns a string with a space for every level deep we
are in the hierarchy. We use the ToString() method to convert the StringBuilder instance to a string.

Now for the recursive part: we iterate through the children and call the Print() method on each
child, making sure to increment the level by one. When we run out of children, we simply return. The
result is the output shown previously.

In Recipe 6-5, we show another approach to this problem using a Common Table Expression in a
stored procedure on the store side to iterate through the graph and return a single flattened result set.
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2-6. Splitting an Entity Across Multiple Tables

Problem

You have two or more tables that share the same primary key and you want to map a single entity to
these two tables.

Solution

Let’s illustrate the problem with the two tables shown in Figure 2-17.

Product (Chapter2) ProductWebInfo (Chapter2)
7 s = | B OSKU
Description ImageURL

Price

Figure 2-17. Two tables, Product and ProductWeblInfo, with common primary keys

To create a model with a single entity representing these two tables, do the following:

1. Add a new model to your project by right-clicking your project and selecting
Add » New Item. Choose ADO.NET Entity Data Model from the Visual C# Data
templates.

2. Select Generate from database. Click Next.

3. Use the wizard to select an existing connection to your database or create a
new connection.

4. From the Choose Your Database Object dialog box, select the Product and
ProductWeblnfo tables. Leave the Pluralize and Foreign Key options checked.
Click Finish.

The resulting model is shown in Figure 2-18.

'3*; Product * -
2 ProductWeblInfo [
= Properties :
@j‘ SKU = Properties
ﬁ:‘Description N o r?gISKU -
7 Price mage
= Mavigation Properties =l Navigation Properties
=l productWeblnfo B2 product

Figure 2-18. The model after importing the Product and ProductWeblInfo tables
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Now that we have our table imported into the model, we need to merge the two entities into a single
entity. To complete the model, do the following:

1.

Copy the ImageURL scalar property from the ProductWeblInfo entity to the
Product entity. You can use copy/paste for this. Do not copy the SKU scalar

property.

Right-click the ProductWeblInfo entity and select Delete. The dialog box in
Figure 2-19 will ask if you want to delete the tables from the store model. Select
No. This will preserve the ProductWebInfo definition in the store model layer.

Click the Product entity to view the Mapping Details window. If the Mapping
Details window is not visible, show it by selecting View » Other Windows »
Entity Data Model Mapping Details.

In the Mapping Details window for the Product entity, click Add a Table or
View and select the ProductWebInfo table. This adds the ProductWeblInfo to
the mappings for the Product entity.

Under the ProductWeblnfo table in the Mapping Details window, map the
ImageURL column to the ImageURL property. Also, make sure that the SKU
property is mapped to the SKU column of the ProductWebInfo table. Your
mappings should look like Figure 2-20.

Delete Unmapped Tables and_ &Iﬂ

The following tables and views in the store model will no longer be mapped. Do you
want them deleted?

ProductWeblnfo

| cance |

Figure 2-19. A dialog box asking if the underlying ProductWebInfo table should be deleted from the store

layer
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Mapping Details - Product *Ax

Column Ope... Value/Property

=& | 4 Tables
4 [ Maps to Product
B8 <Add a Condition>
4 [ Column Mappings
%] SKU:int B sKu:Ints2
=] Description : varchi++ 4 Description : String
=] Price: decimal “— % Price: Decimal
4 [ Maps to ProductWeblnfo
B8 <Add a Condition>
4 [ Column Mappings
%] SKU:int B sKu:Ints2
=] ImageURL : varchar++ 5 ImageURL : String
[ <Add a Table or View>

| NI - e BN &7 Mapping Details

Figure 2-20. Mappings Details window showing the mapping for the ProductWeblInfo table in the Product
entity. Notice that the entity maps to two tables with the SKU column, the key, mapped in both tables.

The resulting model looks just like the one pictured in Figure 2-18, but without the ProductWebInfo
entity type and the ImageURL property moved to the Product entity.

How It Works

It seems all too common in legacy systems to find “extra” information for each row in one table tucked
away in another table. Often this happens over time as a database evolves and no one is willing to break
existing code by adding columns to some critical table. The answer is to graft on a new table to hold the
additional columns.

By merging two or more tables into a single entity, or as it is usually thought of, splitting a single
entity across two or more tables, we can treat all the parts as one logical entity. This process is often
referred to as vertical splitting.

The downside of vertical splitting is that retrieving each instance of our entity now requires an
additional join for each additional table that makes up the entity type. This extra join is shown in Listing
2-6.

Listing 2-6. Additional join required by vertical splitting

SELECT

[Extent1].[SKU] AS [SKU],

[Extent2].[Description] AS [Description],

[Extent2].[Price] AS [Price],

[Extent1].[ImageURL] AS [ImageURL]

FROM [dbo].[ProductWebInfo] AS [Extent1]

INNER JOIN [dbo].[Product] AS [Extent2] ON [Extent1].[SKU] = [Extent2].[SKU]

Nothing special is required to insert into or retrieve from the Product entity. Listing 2-7
demonstrates working with the vertically split Product entity type.
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Listing 2-7. Inserting into and retrieving from our model with the Product entity type

using (var context = new EFRecipesEntities())

var product = new Product { SKU = 147,
Description = "Expandable Hydration Pack",
Price = 19.97M, ImageURL = "/pack147.jpg" };
context.Products.AddObject (product);
product = new Product { SKU = 178,
Description = "Rugged Ranger Duffel Bag",
Price = 39.97M, ImageURL = "/pack178.jpg" };
context.Products.AddObject(product);
product = new Product { SKU = 186,
Description = "Range Field Pack",
Price = 98.97M, ImageURL = "/noimage.jp" };
context.Products.AddObject (product);
product = new Product { SKU = 202,
Description = "Small Deployment Back Pack",
Price = 29.97M, ImageURL = "/pack202.jpg" };
context.Products.AddObject (product);

context.SaveChanges();

}

using (var context = new EFRecipesEntities())
foreach (var p in context.Products)

Console.WriteLine("{0} {1} {2} {3}", p.SKU, p.Description,
p.Price.ToString("C"), p.ImageURL);

The code in Listing 2-7 produces the following results:

147 Expandable Hydration Pack $19.97 /packi47.jpg
178 Rugged Ranger Duffel Bag $39.97 /pack178.jpg
186 Range Field Pack $98.97 /noimage.jpg

202 Small Deployment Back Pack $29.97 /pack202.jpg
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2-7. Splitting a Table Across Multiple Entities

Problem

You have a table with some frequently used fields and a few large but rarely needed fields. For
performance reasons, you want to avoid needlessly loading these expensive fields on every query. You
want to split the table across two or more entities.

Solution

Let’s say you have a table like the one shown in Figure 2-21, which holds information about photographs
as well as the bits for both the thumbnail and the full-resolution image of the photograph.

Photograph (Chapter2)
¥ Photold
Title
ThumbnailBits
HighResolutionBits

Figure 2-21. A Photograph table with a field holding the binary large object (blob) representing the data
for the image

To create an entity type that contains the reasonably low cost and frequently used columns, as well as an
entity type containing the high cost, rarely used HighResolutionBits column, do the following:

1. Add a new model to your project by right-clicking your project and selecting
Add » New Item. Choose ADO.NET Entity Data Model from the Visual C# Data
templates.

2. Select Generate from database. Click Next.

3. Use the wizard to select an existing connection to your database or create a
new connection.

4, From the Choose Your Database Object dialog box, select the Photograph
table. Leave the Pluralize and Foreign Key options checked. Click Finish.

5. Right-click the design surface and select Add » Entity. In the dialog box,
change the Entity name to PhotographFulllmage. Also, change the Key
Property name to Photold. This is the same name as the key column in the
Photograph entity type. See Figure 2-22. Click OK to add the
PhotographFulllmage entity type to the model.

6. Move the HighResolutionBits property from the Photograph entity type to the
PhotographFulllmage entity. You can use select/cut/paste to move the
property.
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7. Click the newly created PhotographFulllmage entity type to view the Mapping
Details window. If the Mapping Details window is not visible, show it by
selecting View » Other Windows » Entity Data Model Mapping Details.

8. In the Mapping Details window for the PhotographFulllmage entity, click Add
a Table or View and select the Photograph table. Map the HighResolutionBits
column to the HighResolutionBits property. Map the Photold column to the
Photold property. See Figure 2-23.

9. Right-click the Photograph entity. Select Add » Association. Add a one-to-one
association between the Photograph entity and the PhotographFulllmage
entity. Make sure you do two things: choose 1 (one) for the multiplicity on both
ends of the association and uncheck the Add foreign key properties to the
Entity check box. See Figure 2-24.

10. Right-click the association link between the entities and select Properties. In
the Referential Constraint under the Constraints section, click the ... button to
add a referential constraint. Set the Principal to Photograph and make sure the
key properties are set to Photold for both the principal and dependent entities.
See Figure 2-25.

Add Entity (2] = |

Properties

Entity name:

PhotographFulllmage

Base type:

(Mone) =
Entity Set:

PhotographFulllmageSet
Key Property

Create key property

Property name:

Photeld

Property type:

Int32 -

[ 0K l ’ Cancel ]

Figure 2-22. Adding the PhotographFulllmage entity to the Entity Data Model
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[ RETAT — Rl & Mapping Details

Column Ope... Value/Property

4 Tables
4 [ Maps to Photograph
% <Add a Condition>
4 [ Column Mappings
%] Photold : int @4 Photold : Int32
=] Title: varchar — ﬁ
=] ThumbnailBits : im++ o

B <Add a Table or View>

=] HighResolutionBits++ % HighResolutionBits : Binary
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Figure 2-23. The mapping details for the PhotographFulllmage entity. We mapped the Photold and
HighResolutionBits columns from the Photograph table to the respective properties on the

PhotographFulllmage entity.

Add Association (2] = ]
Association Name:
PhotographPhotographFulllmage
End End
Entity: Entity:
’Photograph v] ’PhotographFuIIImage v]
Multiplicity: Multiplicity:
[1 (One) | [1ong) -]
MNavigation Property: MNavigation Property:
PhotographFulllmage Photograph
Photograph can havel (One) instance of PhotographFulllmage. Use -
Photograph.PhotographFulllmage to access the PhotographFulllmage
instance.
PhotographFulllmage can have 1l (One) instance of Photograph. Use
PhotographFulllmage.Photograph to access the Photograph instance.
OK l ’ Cancel ]

-

S

Figure 2-24. Adding a one-to-one association between the Photograph entity type and the

PhotographFulllmage entity type

39



~MEiraw Tt & i ivivdvLESnea b v e rnly

40

Referential Constraint | ? 22 |
Principal:
Photograph - oK
Dependent:

Delete
PhotographFulllmage

Cancel

Principal Key Dependent Property
Photold Photold

Figure 2-25. Creating the Referential Constraint between the Photograph (principal) entity type and the
PhotographFulllmage (dependent) entity type

The completed model is shown in Figure 2-26.

“; Photograph E “; PhotographFulllmage &
= Properties = Properties

Bphoteld 5 photold

= Title 1 1| & HighResolutionBits

5 ThumbnailBits =l Navigation Properties
=l Navigation Properties %=l Photograph

B PhotegraphFulllmage

Figure 2-26. The completed model with the HighResolutionBits column represented in a separate entity

How It Works

Entity Framework does not directly support the notion of lazy loading of individual entity properties. To
get the effect of lazy loading expensive properties, we exploit Entity Framework’s support for lazy
loading of associated entities. We created a new entity type to hold the expensive full image property and
created a one-to-one association between our Photograph entity type and the new
PhotographFulllmage entity type. We added a referential constraint on the conceptual layer that, much
like a database referential constraint, tells Entity Framework that a PhotographFulllmage can’t exist
without a Photograph.

Because of the referential constraint, there are a couple of things to note about our model. If we
have a newly created PhotographFulllmage, an instance of Photograph must exist in the object context
or the data source prior to calling SaveChanges(). Also, if we delete a Photograph, the associated
PhotographFulllmage is also deleted. This is just like cascading deletes in database referential
constraints.

The code in Listing 2-8 demonstrates inserting and retrieving from our model.
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Listing 2-8. Inserting into and Lazy Loading Expensive Fields

byte[] thumbBits = new byte[100];
byte[] fullBits = new byte[2000];
using (var context = new EFRecipesEntities())

var photo = new Photograph { Photold = 1, Title = "My Dog",
ThumbnailBits = thumbBits };

var fullImage = new PhotographFullImage { Photold = 1,
HighResolutionBits = fullBits };

photo.PhotographFullImage = fullImage;

context.Photographs.AddObject(photo);

context.SaveChanges();

}
using (var context = new EFRecipesEntities())

foreach (var photo in context.Photographs)
{
Console.WriteLine("Photo: {0}, ThumbnailSize {1} bytes",
photo.Title, photo.ThumbnailBits.Length.ToString());

// explicitly load the "expensive" entity, PhotographFullImage

photo.PhotographFullImageReference.Load();

Console.WriteLine("Full Image Size: {0} bytes",
photo.PhotographFullImage.HighResolutionBits.Length.ToString());

The output from Listing 2-8 is the following:

Photo: My Dog, Thumbnail Size: 100 bytes

Full Image Size: 2000 bytes

The code in Listing 2-8 creates and initializes instances of the Photograph and
PhotographFulllmage entities, adds them to the object context, and calls SaveChanges().

On the query side, we retrieve each of the photographs from the database, print some information
about the photograph, and then explicitly load the associated PhotographFulllmage entity. Notice that
we did not change the default context option that turns off lazy loading. This puts the burden on us to
explicitly load related entities. This is just what we want. We could have chosen not to load the
associated instances of PhotographFulllmage, and if we were iterating through hundreds or thousands
of photographs, this would have saved us an awful lot of cycles and bandwidth.
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2-8. Modeling Table per Type Inheritance

Problem

You have some tables that contain additional information about a common table and you want to model
this using table per type inheritance.

Solution

Suppose you have two tables that are closely related to a common table as in Figure 2-27. The Business
table is on the 1 side of a 1:0..1 relationship with the eCommerce and the Retail tables. The key feature
here is that the eCommerce and Retail tables extend information about a business represented in the
Business table.

Business (Chapter2)
¥ Businessld
Name
LicenseMNumber
& &
7 7
eCommerce (Chapter2) Retail (Chapter2)
7 BusinessId ¥ BusinessId
URL Address
City

State
ZIPCode

Figure 2-27. Closely related tables ripe for inheritance

The tables Retail and eCommerce are related to the Business table which holds a few properties we
would naturally associate with any business. To model table per type inheritance such that entities
Retail and eCommerce inherit from the Business base entity type, perform the following steps:

1. Add a new model to your project by right-clicking your project and selecting
Add » New Item. Choose ADO.NET Entity Data Model from the Visual C# Data
templates.

2. Select Generate from database. Click Next.

3. Use the wizard to select an existing connection to your database or create a
new connection.

4. From the Choose Your Database Object dialog box, select the Business,
eCommerce, and Retail tables. Leave the Pluralize and Foreign Key options
checked. Click Finish.
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5. Delete the associations between the Retail and Business entities and between
the eCommerce and Business entities.

6. Right-click the Business entity and choose Add » Inheritance. In the dialog
box, select Business as the base entity and Retail as the derived entity. Repeat
this step for the eCommerce entity, setting eCommerce as an entity derived
from the Business entity. See Figure 2-28.

7. Delete the BusinessId property from the Retail and eCommerce entities. For
these entities, BusinessId will come from the Business entity.

8. Click the eCommerce entity to view the Mapping Details window. If the
Mapping Details window is not visible, show it by selecting View » Other
Windows » Entity Data Model Mapping Details. Map the BusinessId column to
the Businessld property. Repeat this step for the Retail entity. See Figure 2-29.

Add Inheritance ‘ ? = |

Select the base and derived entities to create a new inheritance relationship.

Select a base entity:

[Business V]

Select a derived entity:
[Retail -

o J[ cme ]

Figure 2-28. Adding Inheritance between the Retail entity type and the Business entity type

Mapping Details - Retail

Column Ope.. Value/ Property

& | 4 Tables
4[] Mapsto Retail
B <Add a Condition>
4 [ Column Mappings
@E Businessld:int 4 @ﬁ Businessld : Int32
=] Address:varchar 4+ 5 Address : String
City : varchar “ 5 City : String
+“r
+“r

o]

=] State:varchar 5 State: String
=| ZIPCode: varchar # ZIPCode: String
M <Add a Table or View=

[ R IETAE — W & Mapping Details

Figure 2-29. Mapping the Businessld column to the Businessld property. This must be done for both the
eCommerce entity type and the Retail entity type.
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The resulting model is shown in Figure 2-30.

>

2 Business

= Properties
#4 Businessld
ﬁ] Mame
ﬁ] LicenseMumber
= Navigation Properties
] 1
¢ eCommerce ES ¢ Retail ES
=* Business =* Business
= Properties = Properties
=5 URL 5 Address
= Navigation Properties ﬁ:‘mt}'
5 State
7 ZIPCode
=l Navigation Properties

Figure 2-30. Table per type inheritance with Retail and eCommerce deriving from the base entity type
Business

How It Works

Both the Retail and the eCommerce tables are on the 0..1 side of a 1:0..1 relationship with the Business
table. This means that we could have a business with no additional information or a business with
additional Retail or eCommerce information. In object-oriented programming terms, we have a base
type, Business, with two derived types, Retail and eCommerce.

Because of the 1:0..1 relationship, we cannot have a row in the Retail or eCommerce tables without a
corresponding row in the Business table. In object-oriented terms, an instance of a derived type has the
properties of the base type. This concept of a derived type extending the properties of a base type is a key
feature of inheritance. In table per type inheritance (often abbreviated TPT), each of the derived types is
represented in separate tables.

Listing 2-9 demonstrates inserting and retrieving from our model.

Listing 2-9. Inserting and retrieving entities in TPT inheritance

using (var context = new EFRecipesEntities())

var business = new Business { Name = "Corner Dry Cleaning",
LicenseNumber = "100x1" };
context.Businesses.AddObject(business);
var retail = new Retail { Name = "Shop and Save", LicenseNumber = "200C",
Address = "101 Main", City = "Anytown",
State = "TX", ZIPCode = "76106" };
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context.Businesses.AddObject(retail);

var web = new eCommerce { Name = "BuyNow.com", LicenseNumber = "300AB",
URL = "www.buynow.com" };

context.Businesses.AddObject(web);

context.SaveChanges();

}

using (var context = new EFRecipesEntities())

Console.WriteLine("\n--- All Businesses ---");
foreach (var b in context.Businesses)

Console.WriteLine("{0} (#{1})", b.Name, b.LicenseNumber);
}

Console. WIlteLlne( \n--- Retail Businesses ---");
foreach (var r in context.Businesses.OfType<Retail>())

{

Console.WriteLine("{o} (#{1})", r.Name, r.LicenseNumber);
Console.WriteLine("{0}", r.Address);
Console.WriteLine("{0}, {1} {2}", r.City, r.State, r.ZIPCode);

Console.WriteLine("\n--- eCommerce Businesses ---");
foreach (var e in context.Businesses.0fType<eCommerces())

Console.WriteLine("{0} (#{1})", e.Name, e.LicenseNumber);
Console.WriteLine("Online address is: {0}", e.URL);

}

The code in Listing 2-9 creates and initializes instances of the Business entity type and the two
derived types. To add these to the Object Context, we use AddObject() method exposed on the Business
entity set in the context.

On the query side, to access all the businesses, we iterate through the Businesses entity set. For the
derived types, we use the 0fType<>() method specifying the derived type to filter the Business entity set.

The output of Listing 2-9 looks like the following:

--- All Businesses ---
Corner Dry Cleaning (#100X1)
Shop and Save (#200C)

BuyNow.com (#300AB)
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--- Retail Businesses ---
Shop and Save (#200C)
101 Main

Anytown, TX 76106

---- eCommerce Businesses ---
BuyNow. com (#300AB)

Online address is: www.buynow.com

Table per type is one of three inheritance models supported by Entity Framework. The other two are
Table per Hierarchy (discussed in this chapter) and Table per Concrete Type (see Chapter 15).

Table per type inheritance provides a lot of database flexibility because we can easily add tables as
new derived types find their way into our model as an application develops. However, each derived type
involves additional joins that can reduce performance. In real-world applications, we have seen
significant performance problems with TPT when many derived types are modeled.

Table per hierarchy, as you will see in Recipe 2-10, stores the entire hierarchy in a single table. This
eliminates the joins of TPT and thereby providing better performance but at the cost of some flexibility.

Table per concrete type is supported by the Entity Framework runtime, but not by the designer.
Table per concrete type has some important applications, as we will see in Chapter 15.

2-9. Using Conditions to Filter an ObjectSet

Problem

You want to create a permanent filter on an entity type so that it maps to a subset of the rows in a table.

Solution

Let’s say you have a table holding account information, as shown in the database diagram in Figure 2-31.
The table has a DeletedOn nullable column that holds the date and time the account was deleted. If the
account is still active, the DeletedOn column is null. We want our Account entity to represent only active
accounts (i.e., account without a DeletedOn value).
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Account (Chapter2)
% Accountld
DeletedOn
AccountHolderId

Figure 2-31. Account table with DeletedOn DateTime column

To model this table so that only active accounts are used to populate the Account entity type, do the

following:

1. Add anew model to your project by right-clicking your project and selecting
Add » New Item. Choose ADO.NET Entity Data Model from the Visual C# Data
templates.

2. Select Generate from database. Click Next.

3. Use the wizard to select an existing connection to your database or create a
new connection.

4. From the Choose Your Database Object dialog box, select the Account table.
Leave the Pluralize and Foreign Key options checked. Click Finish.

5.  Click the Account entity to view the Mapping Details window. If the Mapping
Details window is not visible, show it by selecting View » Other Windows »
Entity Data Model Mapping Details. Click Add a Condition and select the
DeletedOn column. In the Operator column, select Is; in the Value/Property
column, select Null. This creates a mapping condition when the DeletedOn
column is Is Null. See Figure 2-32.

6. Right-click the DeletedOn property and select Delete. Because we’re using the
DeletedOn column in a conditional mapping, we can’t map it to a property. Its
value would always be null anyway in our model.

Mapping Details - Account *0Ox
Column Ope.. Value/ Property
| 4 Tables

4 [ Maps to Account
E5 When DeletedOn Is Mull
E] <Add a Condition>

4

|

[ Column Mappings
@5 Accountd ! int And @ﬁ Accountld : [nt32
=] DeletedOn : datetint+ %' DeletedOn : DateTime
=] AccountHolderdd: +» Zf AccountHolderld : Int32
<Add a Table or View>

‘_‘_; ErorList B Output @ Mapping Details

Figure 2-32. Creating the conditional mapping for the Account entity to the Account table
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How It Works

Conditional mappings are often used when you want to apply a permanent filter on an entity.
Conditional mappings are also key to implementing Table per Hierarchy Inheritance. You can apply
conditions using the following:

<value> Is Null
<value> Is Not Null
<integer> = <value>

<string> = <value>

In this example, we applied an Is Null condition on the Account entity that filters out rows that
contain a DeletedOn date/time. The code in Listing 2-10 demonstrates inserting into and retrieving rows
from the Account table.

Listing 2-10. Inserting into and retrieving from the account

using (var context = new EFRecipesEntities())

context.ExecuteStoreCommand (@"insert into chapter2.account
(DeletedOn,AccountHolderId) values ('2/10/2009',1728)");

var account = new Account { AccountHolderId = 2320 };
context.Accounts.AddObject(account);

account = new Account { AccountHolderId = 2502 };
context.Accounts.AddObject (account);
account = new Account { AccountHolderId = 2603 };

context.Accounts.AddObject(account);
context.SaveChanges();

}
using (var context = new EFRecipesEntities())

foreach (var account in context.Accounts)
{
Console.WriteLine("Account Id = {0}",
account.AccountHolderId.ToString());

In Listing 2-10, we use the ExecuteStoreCommand() method on the Object Context to insert a row into
the database the old-fashioned way. We need to do this because we are inserting a row with a non-null
value for the DeletedOn column. In our model, the Account entity type has no property mapping to this
column; in fact, the Account entity type would never be materialized with a row that had a DeletedOn
value. And that’s exactly what we want to test.

The rest of the first part of the code creates and initializes three additional instances of the Account
entity type. These are saved to the database with the SaveChanges () method.
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When we query the database, we should get only the three instances of the Account entity type that
we added with the SaveChanges () method. The row that we added using the ExecuteStoreCommand()
method should not be visible. The following output confirms it:

Account Id = 2320
Account Id = 2502
Account Id = 2603

2-10. Modeling Table per Hierarchy Inheritance

Problem

You have a table with a type or discrimination column that you use to determine what the data in a row
represents in your application. You want to model this with table per hierarchy inheritance.

Solution

Let’s say your table looks like the one in Figure 2-33. This Employee table contains rows for both hourly
employees and salaried employees. The EmployeeType column is used to discriminate between the two
types of rows. When EmployeeType is 1, the row represents a salaried or full-time employee. When the
EmployeeType is 2, the row represents an hourly employee.

Employee (Chapter2)
% Employeeld
EmployeeType
Firsthame
LastMame
Salary
Wage

Figure 2-33. An Employee table containing both hourly and full-time employees

To create a model using table per hierarchy inheritance based on the Employee table, do the following:

1.  Add anew model to your project by right-clicking your project and selecting
Add » New Item. Choose ADO.NET Entity Data Model from the Visual C# Data
templates.

2. Select Generate from database. Click Next.

3. Use the wizard to select an existing connection to your database or create a
new connection.
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10.

11.

From the Choose Your Database Object dialog box, select the Employee table.
Leave the Pluralize and Foreign Key options checked. Click Finish.

Right-click the design surface and select Add » Entity. Name the new entity
FullTimeEmployee and select Employee as the base type. Repeat this step
creating a new HourlyEmployee entity deriving from Employee. See Figure 2-
34.

Move the Salary property from the Employee entity to the FullTimeEmployee
entity. You can use cut/paste to move the property. Using cut/paste, move the
Wage property to the HourlyEmployee entity.

Click the FullTimeEmployee entity to view the Mapping Details window. If the
Mapping Details window is not visible, show it by selecting View » Other
Windows » Entity Data Model Mapping Details. Select the Employee table in
the Add a Table or View control. Make sure that the Salary property is mapped
to the Salary column.

In the Mapping Details window, add a condition by selecting EmployeeType in
the Add a Condition control. Set the operator to = and the Value/Property to 1.
This maps the Employee table to the FullTimeEmployee entity when the
EmployeeType column is 1. See Figure 2-35.

Repeat steps 7 and 8 for the HourlyEmployee entity. Change the mapping
condition to map the Employee table to the HourlyEmployee entity when the
EmployeeType column has a value of 2.

Right-click the Employee entity and select Properties. Change the Abstract
property to true. This makes the base entity abstract. In our model every
employee must either be an hourly employee or a full-time employee.

Delete the EmployeeType property from the Employee entity.

The completed model is shown in Figure 2-36.
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Add Entity [2] = |)

Properties

Entity name:
FullTimeEmployee

Base type:

Employee -

Entity Set:

Employees

Id

Int32

[ ok ][ canca |

" S

Figure 2-34. Adding the FullTimeEmployee entity type that derives from Employee

Mapping Details - FullTimeEmployee

Column Ope... Value/Property

ER | 4 Tables
4 [ Maps to Employee
E4 When EmployeeType = 1
EY <Add a Condition>
4 [ Column Mappings
=] Salary: decimal  ++ 5 Salary : Decimal
=] Wage: decimal  ++ o
B <Add a Table or View>

| NI - e BN &7 Mapping Details

Figure 2-35. Mapping the Employee table to the FullTimeEmployee entity type when the EmployeeType
column has a value of 1
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“: Employee ES

= Properties
¥ Employeeld
ﬁ] Firsthame
ﬁ] LastMame

= Navigation Properties

@2 HourlyEmployee (% “¢  FulllimeEmployee |%
= Employee = Employee
=l Properties = Properties
5 Wage 5 Salary
= Navigation Properties = Navigation Properties

Figure 2-36. The completed model with the HourlyEmployee and FullTimeEmployee entity types deriving
from the abstract Employee entity type

How It Works

In table per hierarchy inheritance, often abbreviated TPH, a single table is used to represent the entire
inheritance hierarchy. Unlike table per type inheritance, in TPH rows for the derived types as well as the
base type are intermingled in the same table. The rows are distinguished by a discriminator column. In
our example, the discriminator column is EmployeeType.

In TPH, mapping conditions, available through the Mapping Details window, are used to indicate
the values of the discrimination column that cause the table to be mapped to the different derived types.
We marked the base type as abstract. By marking it as abstract, we didn’t have to provide a condition for
the mapping because an abstract entity can’t be created. We will never have an instance of an Employee
entity. We deleted the EmployeeType property from the Employee entity. A column used in a condition
is not, in general, mapped to a property.

The code in Listing 2-11 demonstrates inserting into and retrieving from our model.

Listing 2-11. Inserting into and retrieving from our TPH model

using (var context = new EFRecipesEntities())

var fte = new FullTimeEmployee { FirstName = "Jane", LastName = "Doe",
Salary = 71500M};

context.Employees.AddObject (fte);

fte = new FullTimeEmployee { FirstName = "John", LastName = "Smith",

Salary = 62500M };

context.Employees.AddObject (fte);

var hourly = new HourlyEmployee { FirstName = "Tom", LastName = "Jones",
Wage = 8.75M };
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context.Employees.AddObject (hourly);
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

Console.WriteLine("--- A1l Employees ---");
foreach (var emp in context.Employees)

bool fullTime = emp is HourlyEmployee ? false : true;
Console.WriteLine("{0} {1} ({2})", emp.FirstName, emp.LastName,
fullTime ? "Full Time" : "Hourly");

}

Console.WriteLine("--- Full Time ---");
foreach (var fte in context.Employees.OfType<FullTimeEmployee>())

{
}

Console.WriteLine("--- Hourly ---");
foreach (var hourly in context.Employees.0fType<HourlyEmployee>())

Console.WriteLine("{0} {1}", fte.FirstName, fte.LastName);

Console.WriteLine("{0} {1}", hourly.FirstName, hourly.LastName);

}
The following is the output of the code in Listing 2-11:

--- All Employees ---
Jane Doe (Full Time)
John Smith (Full Time)
Tom Jones (Hourly)

--- Full Time ---

Jane Doe

John Smith

--- Hourly ---

Tom Jones
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The code in Listing 2-11 creates, initializes, and adds two full-time employees and an hourly employee.
On the query side, we retrieve all the employees and use the is operator to determine what type of
employee we have. We indicate the employee type when we print out the employee’s name.

In separate code blocks, we retrieve the full-time employees and the hourly employees using the
0fType<>() method.

Best Practice

There is some debate over when to use abstract base entities in TPH inheritance and when to create a
condition on the base entity. The difficulty with a concrete base entity is that it can be very cumbersome to
query for all the instances in the hierarchy. The best practice is that if your application never needs
instances of the base entity, make it abstract.

If your application needs instances of the base entity, consider introducing a new derived entity to cover
the condition for the concrete base entity. For example, we might create a new derived class such as
UnclassifiedEmployee. Once we have this new derived entity, we can safely make our base entity abstract.
This provides us with a simple way to query for condition formally covered by the base entity with a
condition.

There are some rules to keep in mind when using TPH. First, the conditions used must be mutually
exclusive. That is, you cannot have a row that can conditionally map to two or more types.

Second, the conditions used must account for every row in the table. You cannot have a row in the
table that has a discriminator value that does not map the row to exactly one type. This rule can be
particularly troubling if you are working with a legacy database in which other applications are creating
rows for which you have no appropriate condition mappings. What will happen in these cases? The rows
that do no map to your base or derived types will simply not be accessible in your model.

The discriminator column cannot be mapped to an entity property unless it is used in an is not
null condition. At first, this last rule might seem overly restrictive. You might ask, “How can I insert a
row representing a derived type if I can’t set the discriminator value?” The answer is rather elegant. You
simply create an instance of the derived type and add it to the context in the same way you would any
other entity instance. Object Services takes care of creating the appropriate insert statements to create a
row with the correct discriminator value.

2-11. Modeling Is-a and Has-a Relationships
Between Two Entities

Problem

You have two tables that participate in both Is-a and Has-a relations and you want to model them as two
entities with the corresponding Is-a and Has-a relationships.
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Solution

Let’s say you have two tables that describe scenic parks and their related locations. In your database, you
represent these with a Location table and a Park table. For the purposes of your application, a park is
simply a type of location. Additionally, a park can have a governing office with a mailing address, which
is also represented in the Location table. A park then is both a derived type of Location and can have a
location that corresponds to the park’s governing office. It is entirely possible that the office is not
located on the grounds of the park. Perhaps several parks share an office in a nearby town. Figure 2-37
shows a database diagram with the Park and Location tables.

City

Location (Chapter2) Park (Chapter2)
% LocationId
Address

State
ZIPCode

e O | T Parkld
Name

e e OfficelocationId

Figure 2-37. Location and Park in both a Has-a and Is-a relationship

Follow these steps to model both of these relationships:

1.

Add a new model to your project by right-clicking your project and selecting
Add » New Item. Choose ADO.NET Entity Data Model from the Visual C# Data
templates.

Select Generate from database. Click Next.

Use the wizard to select an existing connection to your database or create a
new connection.

From the Choose Your Database Object dialog box, select the Location and
Park tables. Leave the Pluralize and Foreign Key options checked. Click Finish.

Delete the one-to-zero or one association created by the Entity Data Model
Wizard.

Right-click the Location entity and select Add » Inheritance. Select the Park
entity as the derived entity and the Location entity as the base entity.

Delete the Parkld property from the Park entity type.

Click the Park entity to view the Mapping Details window. If the Mapping
Details window is not visible, show it by selecting View » Other Windows »
Entity Data Model Mapping Details. Map the Parkld column to the LocationId
property.

Change the name of the Locationl navigation property in the Park entity type
to Office. This represents the office location for the park.

The completed model is shown in Figure 2-38.
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“#2  Location 3 -
s Park %
=* Location
= Properties
= p i
@j‘ Locationld rf>pe 183
5 Address ﬁjName
ﬁ] City 2 Officelocationld
el
5 State 1 * | = Navigation Properties
¥ ZIPCode & Office
= Navigation Properties
3_—!, Parks

Figure 2-38. The completed model with Park deriving from Location. A Park is-a location. A park has-a

location for its office.

How It Works

Entities can have more than one association with other entities. In this example, we created an Is-a
relationship using table per type inheritance with Location as the base entity type and Park as the
derived entity type. We also created a Has-a relationship with a one-to-many association between the
Location and Park entity types.

In Listing 2-12, we demonstrate creating a new Park entity which also results in creating a Location

because of the Is-a relationship. We attach an office Location to the Park, which results in a second row
in the Location table.

Listing 2-12. Creating and retrieving Park and Location entities

using (var context = new EFRecipesEntities())

}

var park = new Park { Name = "11th Street Park",
Address = "801 11th Street”, City = "Aledo",
State = "TX", ZIPCode = "76106" };

var loc = new Location { Address = "501 Main", City = "Weatherford",

State = "TX", ZIPCode = "76201" };

park.0ffice = loc;

context.Locations.AddObject(park);

park = new Park { Name = "Overland Park", Address = "101 High Drive",

City = “Springtown", State = "TX", ZIPCode = "76081" };

loc = new Location { Address = "8705 Range Lane", City = "Springtown",
State = "TX", ZIPCode = "76081" };

park.0ffice = loc;

context.Locations.AddObject(park);

context.SaveChanges();

using (var context = new EFRecipesEntities())

context.ContextOptions.LazyloadingEnabled = true;
Console.WriteLine("-- All Locations -- ");
foreach (var 1 in context.Locations)
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Console.WriteLine("{0}, {1}, {2} {3}", l.Address, 1.City,
1.State, 1.ZIPCode);

}

Console. WIlteLlne( --- Parks ---");
foreach (var p in context.Locations.0fType<Park>())

{
Console.WriteLine("{0} is at {1} in {2}", p.Name, p.Address, p.City);
Console.WriteLine("\tOffice: {0}, {1}, {2} {3}", p.Office.Address,
p.0ffice.City, p.Office.State, p.0Office.ZIPCode);

The output from the code in Listing 2-12 is the following:

-- All Locations --

501 Main, Weatherford, TX 76201

801 11th Street, Aledo, TX 76106

8705 Range Lane, Springtown, TX 76081

101 High Drive, Springtown, TX 76081

--- Parks ---

11th Street Park is at 801 11th Street in Aledo
Office: 501 Main, Weatherford, TX 76201

Overland Park is at 101 High Drive in Springtown

Office: 8705 Range Lane, Springtown, TX 76081

2-12. Creating, Modifying, and Mapping Complex Types

Problem

You want to create a complex type, set it as a property on an entity, and map the property to some
columns on a table.
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Solution

Let’s say you have the table shown in Figure 2-39. You want to create a Name complex type for the
FirstName and LastName columns. You also want to create an Address complex type for the
AddressLinel, AddressLine2, City, State, and ZIPCode columns. You want to use these complex types for
properties in your model as shown in Figure 2-40.

Agent (Chapter2)
% Agentld
Firsthame
LastMame
AddressLine1
AddressLine2
City
State
ZIPCode

Figure 2-39. The Agent table with the name and address of the agent

¢ Agent x

= Properties
#4 Agentld
' Mame
E% Address

= Navigation Properties

Figure 2-40. The completed model with the name and address components refactored into complex types

Follow these steps to create the model with the Name and Address complex types:

1. Add a new model to your project by right-clicking your project and selecting
Add » New Item. Choose ADO.NET Entity Data Model from the Visual C# Data
templates.

2. Select Generate from database. Click Next.

3. Use the wizard to select an existing connection to your database or create a
new connection.

4. From the Choose Your Database Object dialog box, select the Agent table.
Leave the Pluralize and Foreign Key options checked. Click Finish.

5. Select the FirstName and LastName properties, right-click and select Refactor
Into Complex Type.

6. Inthe Model Browser, rename the new complex type from ComplexTypel to
Name. This changes the name of the type. On the Agent, rename the
ComplexTypeProperty to Name. This changes the name of the property.
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7. We'll create the next complex type from scratch so you can see an alternate
approach. Right-click on the design surface and select Add » Complex Type.

8. Inthe Model Browser, rename the new complex type from ComplexTypel to
Address.

9. Select the AddressLinel, AddressLine2, City, State, and ZIPCode properties in
the Agent. Right-click and select Cut. Paste these properties onto the Address
complex type in the Model Browser.

10. Right-click the Agent and select Add » Complex Property. Rename the
property Address.

11. Right-click on the new Address property and select Properties. Change its type
to Address. This changes the new property’s type to the new Address complex
type.

12. View the Mapping Details window for the Agent. Map the columns from the
Agent table to the properties on the two complex types we’ve created. The
mappings are shown in Figure 2-41.

Mapping Details - Agent *Bx

Column Oper... Value/ Property

=& | 4 Tables
4 [ Maps to Agent
EY <Add a Condition>
4 [ Column Mappings
@] Agentld: int “ # Agentld : Int32
=] FirstMame : varchar  ++ =% MNameFirstMame : String
=] LastMame:varchar  ++ = MName.LastMame: String
=] Addresslinel : varchar ++ = Address.AddressLinel : String
=] Addressline? : varchar ++ = Address.AddressLine2 : String
=] City: varchar “ =% Address.City: String
=] State:varchar “ = Address.State : String
=] ZPCode: varchar “— = Address.ZIPCode : String
B <Add a Table or View>

ﬂ; Error List B Output B} Find Results 1 [E:al VBRI e

Figure 2-41. Mapping the fields of the complex types to the columns in the Agent table

How It Works

Complex types allow you to group several properties into a single type for a property on an entity. A
complex type can contain scalar properties or other complex types, but they cannot have navigation
properties or entity collections. A complex type cannot be an entity key. Complex types are not tracked
on their own in an object context.

A property whose type is a complex type cannot be null. When you work with entities with complex
type properties, you have to be mindful of this rule. Occasionally, when the value of a complex type
property is unimportant for a particular operation, you may need to create a dummy value for the
property so that it has some non-null value.
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When you modify any field in complex type property, the property is marked as changed by Entity
Framework and an update statement will be generated that will update all of the fields of the complex
type property.

In Listing 2-13, we demonstrate using the model by inserting a few agents and displaying them.

Listing 2-13. Inserting agents and selecting from our model

using (var context = new EFRecipesEntities())

var namel = new Name { FirstName = "Robin", LastName = "Rosen" };
var name2 = new Name { FirstName = "Alex", LastName = "St. James" };
var addressi = new Address { AddressLinel = "510 N. Grant",

AddresslLine2 = "Apt. 8",

City = "Raytown", State = "M0O",

ZIPCode = "64133" };
var address2 = new Address { AddresslLinel = "222 Baker St.",

AddressLine2 = "Apt.22B",

City = "Raytown", State = "M0O",

ZIPCode = "64133" };
context.Agents.AddObject(new Agent { Name = namel, Address = addressi });
context.Agents.AddObject(new Agent {Name = name2, Address = address2});
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

Console.WriteLine("Agents");
foreach (var agent in context.Agents)

{
Console.WriteLine("{0} {1}", agent.Name.FirstName, agent.Name.LastName);
Console.WriteLine("{0}", agent.Address.AddresslLine1);
Console.WriteLine("{0}", agent.Address.AddressLine2);
Console.WriteLine("{o}, {1} {2}", agent.Address.City,
agent.Address.State, agent.Address.ZIPCode);
Console.WriteLine();
}
}
The output of the code in Listing 2-13 is the following:
Agents

Robin Rosen

510 N. Grant

Apt. 8

Raytown, MO 64133

Alex St. James
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222 Baker St.
Apt.22B
Raytown, MO 64133
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CHAPTER 3

Querying an Entity Data Model

In the previous chapter, we showed you lots of different ways to model some fairly common database
scenarios. In this chapter, we dive right into querying your models.

In these recipes we’ll show you how to use LINQ and Entity SQL to query your models. We’ll cover a
wide range of common and some not so common scenarios that will help you understand some of the
basics of querying your models.

3-1. Executing an SQL Statement

Problem

You want to execute an SQL statement.

Solution

Let’s say you have a Payment table like the one shown in Figure 3-1 and you have created a model that
looks like the one in Figure 3-2.

Payment (Chapter3)
¥ Paymentld
Amount

Vendor

Figure 3-1. A Payment table that contains information about a payment made by a vendor
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“¢ Payment ES

= Properties
# paymentld
ﬁ:' Amount
ﬁ:' Vendor

= Navigation Properties

Figure 3-2. A model with a Payment entity type that was created when the model was updated with the
Payment table

You want to execute one or more SQL statements directly against the underlying Payment table. To
do this, use the ExecuteStoreCommand() method available on the object context. Although we have a
Payment entity in our model, it is not required. We simply need some model (after all, we need an object
context) that is connected to the database against which we want to execute the SQL commands.

Follow the pattern in Listing 3-1 to execute one or more SQL statements.

Listing 3-1. Executing an Insert statement

// insert a couple rows
using (var context = new EFRecipesEntities())

string sql = @"insert into Chapter3.Payment(Amount, Vendor)
values (@Amount, @Vendor)";
var args = new DbParameter[] {
new SqlParameter { ParameterName
new SqlParameter { ParameterName

"Amount™, Value = 99.97M},
"Vendor", Value="Ace Plumbing"}

5
int rowCount = context.ExecuteStoreCommand(sql, args);

args = new DbParameter[] {
new SqlParameter { ParameterName = "Amount", Value = 43.83M},
new SqlParameter { ParameterName = "Vendor",
Value = "Joe's Trash Service"}
}
rowCount += context.ExecuteStoreCommand(sql, args);
Console.WriteLine("{0} rows inserted", rowCount.ToString());

}

// materialize some entities
using (var context = new EFRecipesEntities())

Console.WriteLine("Payments");
Console.WriteLine("========");
foreach (var payment in context.Payments)

Console.WriteLine("Paid {0} to {1}", payment.Amount.ToString("C"),
payment.Vendor);
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The following is the output of the code in Listing 3-1:

2 rows inserted

Payments

Paid $99.97 to Ace Plumbing

Paid $43.83 to Joe's Trash Service

How It Works

In Listing 3-1, we start off by creating a string with the SQL insert statement. This statement contains two
parameters: @Amount and @Vendor. These are placeholders that will be replaced by values when the
statement is executed.

Next, we create two parameters that bind the placeholder names to specific values. For the first
insert, we bind the value 99.97 to the Amount placeholder. Next, we create a parameter that binds ‘Ace
Plumbing’ to the Vendor placeholder.

To execute the SQL statement, we pass both the string with the SQL statement and the array of
parameters to the ExecuteStoreCommand() method. ExecuteStoreCommand() returns the count of rows
affected by the statement. In our case, one row is inserted each time we call ExecuteStoreCommand().

If you don’t have any parameters for a SQL statement, there is an overload of the
ExcuteStoreCommand() method that takes just the SQL statement.

The pattern in Listing 3-1 is similar to how we would do the same thing in ADO.NET with SqlClient.
The difference is that we don’t need to construct a connection string and explicitly open a connection.
This is handled by the object context.

The way we express the command text and the parameters are also different. With
ExecuteNonQuery(), the command text and parameters are set on the underlying Command object. Here,
these are passed into the ExecuteStoreCommand() method.

Of course, the observant reader will notice here that we're really not querying the model. In fact, as
we mentioned, you don’t need to have the Payment entity shown in Figure 3-2. The
ExecuteStoreCommand() method simply uses the object context for its connection to the underlying data
store.
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Best Practice

To parameterize or not to parameterize, that is the question....Okay, Shakespeare aside, should | use
parameters for SQL statements or just create the SQL statement strings that contain the parameters? The
best practice is to use parameters whenever possible, and here are some reasons why:

e Parameterized SQL statements help prevent SQL Injection attacks. If you construct
a complete SQL statement as a string by appending together strings that you get
from a user interface such as an ASP.NET TextBox control, you may end up
constructing a SQL statement that does some serious damage to your database or
reveals some sensitive information. When you use parameterized SQL statements,
the parameters are handled in a way that prevents this.

e Parameterized SQL statements, as we have shown in this recipe, allow you to
reuse the non-varying part of the statement. This reuse can make your code more
simple and easy to read.

e Parameterized SQL statements make your code more maintainable and
configurable. For example, the statements could come from a configuration file.
This would allow you to make some changes to the application without changing
the code.

3-2. Returning Objects from a SQL Statement

Problem

You want to execute a SQL statement and get objects from your model.

Solution

Let’s say you have a model with a Student entity type as shown in Figure 3-3.
“¢  Student ES

= Properties
# Studentld
5 Degree
ﬁ] Firsthame
ﬁ] LastMame
=l Navigation Properties

Figure 3-3. A model with a Student entity type
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You want to execute a SQL statement that returns a collection of instances of the Student entity
type. As we saw in the previous recipe, the ExecuteStoreCommand() method is similar to SQLCommand’s
ExecuteNonQuery() method. It executes the SQL statement for its side effects like inserting rows, and
returns the number of rows affected. To materialize objects from our model, we can use the

ExecuteStoreQuery() method on the object context.

To execute a SQL statement and get back a collection of instances of the Student entity type, follow

the pattern in Listing 3-2.
Listing 3-2. Using ExecuteStoreQuery() to execute a SQL statement and get back objects
using (var context = new EFRecipesEntities())

context.Students.AddObject(new Student { FirstName = "Robert",

LastName = "Smith", Degree = "Masters" });
context.Students.AddObject(new Student { FirstName = "Julia",

LastName = "Kerns", Degree = "Masters" });
context.Students.AddObject(new Student { FirstName = "Nancy",

LastName = "Stiles", Degree = "Doctorate" });
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

string sql = “select * from Chapter3.Student where Degree = @Major";
var args = new DbParameter[] {

new SqlParameter {ParameterName = "Major", Value = "Masters"}};
var students = context.ExecuteStoreQuery<Student>(sql, args);
Console.WriteLine("Students...");
foreach (var student in students)

{
Console.WriteLine("{0} {1} is working on a {2} degree",
student.FirstName, student.LastName, student.Degree);
}
}
The following is the output of the code in Listing 3-2:
Students...

Robert Smith is working on a Masters degree

Julia Kerns is working on a Masters degree

How It Works

In Listing 3-2, we add three Students to the object context and save them to the database using

SaveChanges().
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To retrieve the Students who are working on a Masters degree, we use the ExecuteStoreQuery()
method with a parameterized SQL statement and a parameter set to “Masters.” We iterate through the
returned collection of Students and print each of them.

Here we use * in place of explicitly naming each column in the select statement. This works because
the columns in the underlying table match the properties in the Student entity type. Entity Framework
will match up the returned values to the appropriate properties. This works out fine in most cases, but if
you have fewer columns returned from your query, Entity Framework will throw an exception during the
materialization of the object. This can easily be fixed by adding dummy columns and values of the
appropriate types to your query.

If your SQL statement returns more columns than required to materialize the entity, Entity
Framework will happily ignore the additional columns.

There are some restrictions with the ExecuteStoreQuery() method. If you are using Table per
Hierarchy inheritance and your SQL statement returns rows that could map to different derived types,
Entity Framework will not be able to use the discriminator column to map the rows to the correct
derived types. You will likely get a runtime exception because some rows don’t contain the values
required for the type being materialized.

If an entity has a complex type property, then instances of the entity can’t be returned using
ExecuteStoreQuery(). However, ExecuteStoreQuery() can be used to return a collection of instances of a
complex type. Returning instances of a complex type, which is supported, is subtly different from
returning instances of an entity that contains a complex type, which is not supported.

You can use ExecuteStoreQuery() to materialize objects that are not entities at all. For example, we
could create a StudentName class that contains just first and last names of a student. If our SQL statement
returned just these two strings, then we could use ExecuteStoreQuery<StudentName> () along with our
SQL statement to get a collection of instances of StudentName.

We’ve been careful to use the phrase SQL statement rather than select statement because the
ExecuteStoreQuery() method works with any SQL statement that returns a row set. This includes, of
course, select statements, but also includes statements that execute stored procedures.

There is a version of ExecuteStoreQuery() that takes a parameter that determines how the returned
objects are merged into the object context. By default, ExecuteStoreQuery() uses the
MegeOption.NoTracking, which means that the returned objects are not tracked in the object context. If
you happened to retrieve an object that has the same entity key as an object that is already in the object
context, you will get a fresh copy of the object. If you use this version of the ExecuteStoreQuery()
method, the second parameter is the name of the entity set that contains the entity.

3-3. Returning Objects from an Entity SQL Statement

Problem

You want to execute an Entity SQL statement that queries your model and returns objects.

Solution

Let’s say you have a model like the one in Figure 3-4. The model contains a single Customer entity type.
The Customer entity type has a Name and an Email property. You want to query this model using Entity
SQL.
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“¢  Customer 3

= Properties
# Customerld
ﬁ;' Mame
5 Email

= Navigation Properties

Figure 3-4. A model with a Customer entity

To query the model using Entity SQL, follow the pattern in Listing 3-3. The code in Listing 3-3
demonstrates executing and Entity SQL statement using both Object Services and EntityClient.

Listing 3-3. Executing an Entity SQL statement using both Object Services and EntityClient
using (var context = new EFRecipesEntities())

var cusl = new Customer { Name = "Robert Stevens”,

Email = "rstevens@mymail.com" };
new Customer { Name = "Julia Kerns",

Email = "julia.kerns@abc.com" };
var cus3 = new Customer { Name = "Nancy Whitrock",

Email = "nrock@myworld.com" };
context.Customers.AddObject(cus1);
context.Customers.AddObject(cus2);
context.Customers.AddObject(cus3);
context.SaveChanges();

var cus2

}

// using object services
using (var context = new EFRecipesEntities())

Console.WriteLine("Customers...");

string esql = "select value c from Customers as c";
var customers = context.CreateQuery<Customer>(esql);
foreach (var customer in customers)

{
Console.WriteLine("{0}'s email is: {1}",
customer.Name, customer.Email);
}
}
Console.WriteLine();

// using EntityClient
using (var conn = new EntityConnection("name=EFRecipesEntities"))

Console.WriteLine("Customers...");
var cmd = conn.CreateCommand();
conn.Open();
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cmd.CommandText = "select value c from EFRecipesEntities.Customers as c";
using (var reader = cmd.ExecuteReader(CommandBehavior.SequentialAccess))

while (reader.Read())
{

Console.WriteLine("{0}'s email is: {1}",
reader.GetString(1), reader.GetString(2));

The following is the output from the code in Listing 3-3:

Customers...
Robert Stevens's email is: rstevens@mymail.com
Julia Kerns's email is: julia.kerns@abc.com

Nancy Whitrock's email is: nrock@myworld.com

Customers...
Robert Stevens's email is: rstevens@mymail.com
Julia Kerns's email is: julia.kerns@abc.com

Nancy Whitrock's email is: nrock@myworld.com

How It Works

In Listing 3-4, we create three customers, add them to the object context, then call SaveChanges () to save
these new customers to the database.

After we have these customers in the database, we use two different approaches to retrieve them
using Entity SQL. In the first approach, we use the CreateQuery() method on the object context to create
an ObjectQuery. When we iterate over the customers, the query is executed in the database and the
resulting collection is printed to the console. Because each element in the collection is an instance of our
Customer entity type, we can use the properties of the Customer entity type.

In the second approach, we use EntityClient in a pattern that is very similar to how we would use
SqlClient or any of the other client providers in ADO.NET. We start by creating a connection to the
database. With the connection in hand, we create a command object and open the connection. Next we
initialize the command object with the text of the Entity SQL statement we want to execute. We execute
the command using ExecuteReader() and obtain an EntityDataReader, which is a type of the familiar
DbDataReader. We iterate over the resulting collection using the Read() method.
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The Entity SQL statement in Listing 3-3 uses the value keyword. This keyword is useful when we
need the entire entity. If our Entity SQL statement forms a projection of the columns (that is, we use
some of the columns and/or create columns using Entity SQL expressions), we can dispense with the
value keyword. When using Object Services, this means working with a DbDataRecord directly. The code
in Listing 3-4 demonstrates this.

Listing 3-4. Projecting with both Object Services and EntityClient

// using object services without the VALUE keyword
using (var context = new EFRecipesEntities())

Console.WriteLine("Customers...");

string esql = "select c.Name, c.Email from Customers as c";
var records = context.CreateQuery<DbDataRecord>(esql);
foreach (var record in records)

var name = record[0] as string;
var email = record[1] as string;
Console.WriteLine("{0}'s email is: {1}", name, email);
}
}

Console.WriteLine();

// using EntityClient without the VALUE keyword
using (var conn = new EntityConnection("name=EFRecipesEntities"))

Console.WriteLine("Customers...");

var cmd = conn.CreateCommand();

conn.Open();

cmd.CommandText = @"select c.Name, C.Email from
EFRecipesEntities.Customers as c";

using (var reader = cmd.ExecuteReader(CommandBehavior.SequentialAccess))

while (reader.Read())
{

Console.WriteLine("{0}'s email is: {1}",
reader.GetString(0), reader.GetString(1));

When you form a projection in Entity SQL, the results are returned in a DbDataRecord object that
contains one element for each column in the projection. With the value keyword, the single object
resulting from the query is returned in the first element of the DbDataRecord.
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3-4. Specifying Fully Qualified Names in Entity SQL

Problem

You want to fully qualify an entity type with the correct namespace inside of an Entity SQL statement.

Solution
Let’s say you have a simple model using Table per Type inheritance, as shown in Figure 3-5.
= Properties
#4 personld

ﬁ]Name

=l Navigation Properties

“¢ Teacher & @y Lawyer x
=* Perscn =* Perscn
= Properties = Properties
4 [sProfessor 0 Cases
= Navigation Properties = Navigation Properties

Figure 3-5. A model using Table per Type inheritance with the derived entities Teacher and Lawyer

In Figure 3-5, we have two entities, Teacher and Lawyer, which are derived from the Person entity
type. Because we're using Table per Type inheritance, each of the derived types is represented in a
separate table.

To query the model for all the Teachers using Object Services, we need to qualify the Teacher entity
type with the Recipe4 namespace. This is the CLR namespace that contains our object context and our
entities. Because we are interested in only the Teacher entities, we use the Entity SQL 0fType() operator
passing in the People entity set that contains our Teacher entity and the fully qualified Teacher entity.
This is the first query in Listing 3-5.

The same query using EntityClient requires that we qualify the entity set with the Entity Container
name EFRecipesEntities and the Teacher entity type with the namespace of the conceptual model,
EFRecipesModel. This is shown in the second query in Listing 3-5.

Listing 3-5. Retrieving the teachers using Object Services and EntityClient
using (var context = new EFRecipesEntities())

context.People.AddObject(new Teacher { Name = "Janet Dietz",



b MULIITIINA TUE Il Wi v et

IsProfessor = true });
context.People.AddObject(new Teacher { Name = "Robert Kline",

IsProfessor = false });
context.People.AddObject(new Lawyer { Name = “Jenny Dunlap", Cases = 3 });
context.People.AddObject(new Lawyer { Name = "Karen Eads", Cases = 7 });
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

var esql = "select value p from OfType(People,Recipe4.Teacher) as p";
var teachers = context.CreateQuery<Teacher>(esql);
Console.WriteLine("Teachers...Using Object Services");

foreach (var teacher in teachers)

{
Console.WriteLine("{0} is{1} a professor", teacher.Name,
teacher.IsProfessor ? "" : " not");

}

Console.WriteLine();
using (var conn = new EntityConnection("name=EFRecipesEntities"))

conn.Open();

var esql = @"select value p from
0fType(EFRecipesEntities.People,EFRecipesModel.Teacher) as p";

var cmd = conn.CreateCommand();

cmd.CommandText = esql;

Console.WriteLine("Teachers...Using EntityClient");

using (var reader = cmd.ExecuteReader(CommandBehavior.SequentialAccess))

while (reader.Read())
{

Console.WriteLine("{0} is{1} a professor", reader.GetString(1),
reader.GetBoolean(2) ? "" : " not");

The following is the output of the code in Listing 3-5:

Teachers...Using Object Services
Janet Dietz is a professor

Robert Kline is not a professor

73



Rl b MULITIHNA U RNl nin v e

74

Teachers...Using EntityClient
Janet Dietz is a professor

Robert Kline is not a professor

How It Works

In Listing 3-5, we referenced the People entity set in each query. Normally, when you reference an entity
set, it is qualified by the Entity Container name. In our case, this is EFRecipesEntities. In the first query,
we didn’t need to fully qualify the entity set because we are executing the query in the object context and
the entity set is in the default container for the context. In the second query, the one in which we execute
against EntityClient, we need to fully qualify the entity set with the Entity Container name.

In the first query, we qualified the Teacher entity type with the CLR namespace in which the entity
was generated. This namespace is, by default, the namespace of the project. You can change the
namespace for the generated code in the Custom Tool Namespace property of the model. To change this
namespace, right-click the .edmx file, select Properties and change the Custom Tool Namespace.

For the second query, we qualified the Teacher entity type with the namespace of the conceptual
model. For the EntityClient approach, we are not using the generated code so we can’t use the CLR
namespace. To find the conceptual model namespace, right-click the model design surface and select
Properties. The conceptual model namespace is listed under the Namespace property.

If you have a more complex query, you can make it somewhat more readable with the Entity SQL
using clause. Like the using statement in C#, this clause allows you to factor out the qualifiers and
simplify the code. We could rewrite the first Entity SQL statement as follows:

"using Recipe4; select value p from OfType(People,Teacher) as p";

3-5. Finding a Master that Has Detail in a
Master-Detail Relationship

Problem

You have two entities in a one-to-many association (a.k.a. Master-Detail) and you want to find all the
master entities that have at least one associated detail entity.

Solution

Imagine you have a model for blog posts and the comments associated with each post. Some posts have
lots of comments. Some posts have few or no comments. The model might look something like the one
in Figure 3-6.
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¢ BlogPost 3 ¢ Comment E3

= Properties = Properties
# postld # Commentld
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Figure 3-6. A model for blog posts and the associated comments

You want to find all the blog posts that have at least one comment. To do this using either LINQ to
Entities or Entity SQL, follow the pattern in Listing 3-6.

Listing 3-6. Finding the masters that have detail using both LINQ and Entity SQL
using (var context = new EFRecipesEntities())

var postl = new BlogPost { Title = "The Joy of LINQ",
Description = "101 things you always wanted to know about LINQ" };
var post2 = new BlogPost { Title = "LINQ as Dinner Conversation”,
Description = "What wine goes with a Lambda expression?” };
var post3 = new BlogPost {Title = "LINQ and our Children",
Description = "Why we need to teach LINQ in High School"};
var commentl = new Comment {
Comments = "Great post, I wish more people would talk about LINQ" };
var comment2 = new Comment {
Comments = "You're right, we should teach LINQ in high school!" };
posti.Comments.Add(comment1);
post3.Comments.Add(comment2);
context.BlogPosts.AddObject(post1);
context.BlogPosts.AddObject(post2);
context.BlogPosts.AddObject (post3);
context.SaveChanges();

}
using (var context = new EFRecipesEntities())

Console.WriteLine("Blog Posts with comments...(LINQ)");
var posts = from post in context.BlogPosts

where post.Comments.Any()

select post;
foreach (var post in posts)

Console.WriteLine("Blog Post: {0}", post.Title);
foreach (var comment in post.Comments)

Console.WriteLine("\t{0}", comment.Comments);

}

75



Rl b MULITIHNA U RNl nin v e

}

Console.WriteLine();
using (var context = new EFRecipesEntities())

Console.WriteLine("Blog Posts with comments...(ESQL)");

var esql = "select value p from BlogPosts as p where exists(p.Comments)";
var posts = context.CreateQuery<BlogPost>(esql);

foreach (var post in posts)

Console.WriteLine("Blog Post: {0}", post.Title);
foreach (var comment in post.Comments)

{
}

Console.WriteLine("\t{0}", comment.Comments);

The following is the output of the code in Listing 3-6:

Blog Posts with comments...(LINQ)
Blog Post: The Joy of LINQ

Great post, I wish more people would talk about LINQ
Blog Post: LINQ and our Children

You're right, we should teach LINQ in high school!

Blog Posts with comments...(ESQL)
Blog Post: The Joy of LINQ

Great post, I wish more people would talk about LINQ
Blog Post: LINQ and our Children

You're right, we should teach LINQ in high school!

How It Works

We start off the code in Listing 3-6 by inserting a few blog posts and comments into the database. We left
one of the blog posts without any comments to make sure our query is doing the right thing.
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In the LINQ query, we use the Any() method in the where clause to determine whether there are
comments for a given post. The query finds all the posts for which the Any() method returns true. And
that’s just what we want: all the posts for which there is at least one comment.

For the Entity SQL approach, we use the exists() operator, again in a where clause, to determine
whether the given post has at least one comment.

There are, of course, other ways to get the same results. We could have used the Count() method in
the LINQ query’s where clause and tested if the count is greater than 0. For the Entity SQL approach, we
could use count(select value 1 from p.Comments) > 0 in the where clause. Either of these approaches
would work. The code in Listing 3-6 seems a bit cleaner and, if it’s any consolation, the semantics behind
Any() and exists() don’t require the enumeration of the entire collection on the server, whereas count()
does require a full enumeration on the server.

3-6. Setting Default Values in a Query

Problem

You want to assign a default value to a property that has null value in a query.

Solution

Let’s say you have a model like the one shown in Figure 3-7. You want to query the model for employees.
In the database, the table representing employees contains a nullable YearsWorked column. This is the
column mapped to the YearsWorked property in the Employee entity. You want the rows that contain a
null value for the YearsWorked to default to the value 0.

“: Employee &
= Properties

¥ Employeeld

ﬁ] Mame

ﬁ] YearsWorked

= Navigation Properties

Figure 3-7. A model with an Employee entity type containing an Employeeld property, a Name property,
and a YearsWorked property

There are a couple of different approaches you can take here. The simplest is to change the Default
Value property on YearsWorked to 0. To do this, right-click YearsWorked and select Properties. In the
Properties window, change the Default Value to 0.

You can also assign default values via a query as in Listing 3-7. Note that the pattern in Listing 3-7
doesn’t really materialize instances of the Employee entity type with the default value. Instead, it
projects the results of the query into a collection of an anonymous type whose YearsWorked property is
0 whenever the underlying value is null.
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Listing 3-7. Using both LINQ and Entity SQL to fill in default values for nulls
using (var context = new EFRecipesEntities())

context.Employees.AddObject (new Employee { Name = "Robin Rosen",

YearsWorked = 3 });
context.Employees.AddObject (new Employee { Name = "John Hancock" });
context.SaveChanges();

}
using (var context = new EFRecipesEntities())

Console.WriteLine("Employees (using LINQ)");
var employees = from e in context.Employees
select new {Name = e.Name, YearsWorked = e.YearsWorked ?? 0};
foreach(var employee in employees)
{
Console.WriteLine("{0}, years worked: {1}",employee.Name,
employee.Yearshorked);

}
using (var context = new EFRecipesEntities())

Console.WriteLine("Employees (using ESQL)");
string esql = @"select

e.Name,

case when e.YearsWorked is null then 0

else e.YearsWorked
end as YearsWorked
from Employees as e";

var employees = context.CreateQuery<DbDataRecord>(esql);
foreach (var employee in employees)

Console.WriteLine("{0}, years worked: {1}", employee.GetString(0),
employee.GetInt32(1).ToString());

}
using (var context = new EFRecipesEntities())

Console.WriteLine("Employees (using ESQL w/named constructor)");
string esql = @"select value Recipe6.Employee(e.Employeeld,

e.Name,

case when e.YearsWorked is null then 0

else e.YearsWorked end)
from Employees as e";

var employees = context.CreateQuery<Employee>(esql);
foreach(var employee in employees)

Console.WriteLine("{0}, years worked: {1}",employee.Name,
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employee.YearsWorked.ToString());

The following is the output of the code in Listing 3-7:

Employees (using LINQ)

Robin Rosen, years worked: 3

John Hancock, years worked: 0

Employees (using ESQL)

Robin Rosen, years worked: 3

John Hancock, years worked: 0

Employees (using ESQL w/named constructor)
Robin Rosen, years worked: 3

John Hancock, years worked: 0

How It Works

As we mentioned, the simple solution is to set the Default Value to 0 for the YearsWorked property. This
will cause the instances of the Employee entity type to be materialized with a 0 for the YearsWorked
property when the underlying value is null.

The other approach is to use either LINQ or ESQL to project the results into a collection of an
anonymous type. The query sets the YearsWorked to 0 when the underlying value is null.

For the LINQ approach, we use the null-coalescing operator ?? to assign the value of 0 when the
underlying value is null. We project the results into a collection of an anonymous type.

For Entity SQL we use a case statement to assign the value of 0 to YearsWorked when the underlying
value is null.

In the last bit of code, we show how to use Entity SQL to materialize instances of the Employee
entity type without setting the Default Value property for the entity. To do this, we use the named
constructor for the entity type. This constructor assigns the values from the parameters to the properties
in the same order as the properties are defined in the entity. In our case, the properties for the Employee
entity are defined in the following order: Employeeld, Name, and YearsWorked. The parameters to the
constructor follow this same order. We also changed the type for the CreateQuery() method from
DbDataRecord to Employee.

Unfortunately, there is no corresponding name constructor syntax for LINQ to Entities.
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3-7. Returning Multiple Result Sets From a Stored Procedure

Problem

You have a stored procedure that returns multiple result sets and you want to materialize entities from
each result set.

Solution

Suppose you have a model like the one in Figure 3-8 and a stored procedure like the one in Listing 3-8
that returns both jobs and bids.

¢ Bid %
“¢ Job &
= Properties
=l Properties 4 Bidld
#4 Jobld ﬁonbId
= JobDetails 1 * ﬁ“f-\.mount
=l Navigation Properties 7 Bidder
= Bid = Navigation Properties
X Bids
= Job

Figure 3-8. A model representing jobs and bids for the jobs

Listing 3-8. A stored procedure that returns multiple result sets

create procedure [Chapter3].[GetBidDetails]
as
begin
select * from Chapter3.Job
select * from Chapter3.Bid
end

In our model, for each job we have zero or more bids. Our stored procedure returns all the jobs and
all the bids. We want to execute the stored procedure and materialize all the jobs and all the bids from
the two result sets. To do this, follow the pattern in Listing 3-9.

Listing 3-9. Materializing jobs and bids from the two result sets returned by our stored procedure
using (var context = new EFRecipesEntities())

var jobl = new Job { JobDetails
var job2 = new Job { JobDetails
job1.Bids.Add(new Bid { Amount
job1.Bids.Add(new Bid { Amount
job2.Bids.Add(new Bid { Amount
context.Jobs.AddObject(job1);

"Re-surface Parking Log" };

"Build Driveway" };

948M, Bidder = "ABC Paving" });
1028M, Bidder = "TopCoat Paving" });
502M, Bidder = "Ace Concrete" });
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context.Jobs.AddObject(job2);
context.SaveChanges();

}
using (var context = new EFRecipesEntities())

var cs = @"Data Source=.;Initial Catalog=EFRecipes;Integrated Security=True";

var conn = new SqlConnection(cs);

var cmd = conn.CreateCommand();

cmd.CommandType = System.Data.CommandType.StoredProcedure;

cmd.CommandText = "Chapter3.GetBidDetails";

conn.Open();

var reader = cmd.ExecuteReader(CommandBehavior.CloseConnection);

var jobs = context.Translate<Job>(reader, "Jobs",
MergeOption.AppendOnly).ToList();

reader.NextResult();

context.Translate<Bid>(reader, "Bids", MergeOption.AppendOnly).ToList();

foreach (var job in jobs)

{
Console.WriteLine("\nJob: {0}", job.JobDetails);
foreach (var bid in job.Bids)
Console.WriteLine("\tBid: {0} from {1}",
bid.Amount.ToString("C"), bid.Bidder);
}
}

The following is the output of the code in Listing 3-8:

Job: Re-surface Parking Log
Bid: $948.00 from ABC Paving

Bid: $1,028.00 from TopCoat Paving

Job: Build Driveway

Bid: $502.00 from Ace Concrete

How It Works

We start out by adding a couple of jobs and a few bids for the jobs. After adding them to the context, we
use SaveChanges() to save them to the database.

The current release of Entity Framework does not directly support working with multiple result sets.
To solve the problem, we read the data using the familiar SqlClient pattern. This pattern involves
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creating a SqlConnection, creating a SqlCommand, setting the command text to the name of the stored
procedure, and calling ExecuteReader() to get a data reader.

With a reader in hand, we use the Translate() method on the object context to materialize
instances of the Job entity from the reader. This method takes a reader, the entity set name, and a merge
option. The entity set name is required because an entity can live in multiple entity sets. Entity
Framework needs to know which to use.

The merge option parameter is a little more interesting. Using MergeOption.AppendOnly causes the
new instances to be added to the object context and tracked. We use this option because we want to use
Entity Framework’s entity span to automatically fix up the associations between jobs and bids. We
simply add to the context all the jobs and all the bids. Through the magic of entity span, Entity
Framework will automatically associate the bids to the right jobs. This saves us a ton of tedious code.
Entity span is not really magic, but it is something that comes in very handy.

A simpler version of the Translate() method does not require a MexgeOption. This version
materializes objects that are disconnected from the object context. This is subtly different from objects
that are not tracked in that the objects are created completely outside of the object context. If you were
to use this simpler Translate() to read the jobs, you would not be able to later materialize bids into the
object context because Entity Framework would not have any reference to the associated jobs. Those
jobs are completely disconnected from the object context.

We used ToList() to force the evaluation of each query. This is required because the Translate()
method returns an ObjectResult<T>. It does not actually cause the results to be read from the reader. We
need to force the results to be read from the reader before we can use NextResult() to advance to the
next result set.

Although we didn’t run into it in this example, it is important to note that Translate() bypasses the
mapping layer of the model. If you try to map an inheritance hierarchy or use an entity that has complex
type properties, Translate() will fail. Translate() requires that the DbDataReader have columns that
match each property on the entity. This matching is done using simple name matching. If a column
name can’t be matched to a property, Translate() will fail.

3-8. Comparing Against a List of Values

Problem

You want to return entities whose property value matches one of the values in a given list.

Solution
Suppose you have a model like the one in Figure 3-9.

“: Book 3

“@¢  Category £
= Properties
= p i
@rope ies 5 Bookid
j; Categoryld R Title
2 Name 0.1

5 Categonyld

= MRy Hop i = Navigation Properties

= Books

B Category

Figure 3-9. A model for books and their categories
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You want to find all the books in a given list of categories. To do this using LINQ or Entity SQL,
follow the pattern in Listing 3-9.

Listing 3-9. Finding books in a list of categories using both LINQ and Entity SQL

using (var context = new EFRecipesEntities())

var catl = new Category { Name = "Programming" };
var cat2 = new Category { Name = "Databases" };
var cat3 = new Category {Name = "Operating Systems"};

context.Books.AddObject(new Book { Title = "F# In Practice", Category = cati });

context.Books.AddObject (new Book { Title = "The Joy of SQL", Category = cat2 });

context.Books.AddObject(new Book { Title = "Windows 7: The Untold Story",
Category = cat3 });

context.SaveChanges();

}

using (var context = new EFRecipesEntities())

Console.WriteLine("Books (using LINQ)");
List<string> cats = new List<string> { "Programming", "Databases" };
var books = from b in context.Books

where cats.Contains(b.Category.Name)

select b;
foreach (var book in books)
{
Console.WriteLine("'{0}' is in category: {1}", book.Title,
book.Category.Name);
}

}

using (var context = new EFRecipesEntities())

Console.WriteLine("Books (using ESQL)");
var esql = @"select value b from Books as b
where b.Category.Name in {'Programming’,'Databases’}";
var books = context.CreateQuery<Book>(esql);
foreach (var book in books)

{
Console.WriteLine("'{0}' is in category: {1}", book.Title,
book.Category.Name);

The following is the output of the code in Listing 3-9:

Books (using LINQ)

"Fi# In Practice' is in category: Programming
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'The Joy of SQL' is in category: Databases
Books (using ESQL)
"F# In Practice' is in category: Programming

'The Joy of SQL' is in category: Databases

How It Works

For the LINQ query, we build a simple list of category names, use this list in a contains clause in the
query. Entity Framework translates this to a SQL statement with an in clause, as shown in Listing 3-10.

Listing 3-10. The SQL statement created for the LINQ expression in Listing 3-9

SELECT

[Extent1].[BookId] AS [BookId],

[Extenta].[Title] AS [Title],

[Extent1].[CategoryId] AS [CategoryId]

FROM [chapter3].[Books] AS [Extent1]

LEFT OUTER JOIN [chapter3].[Category] AS [Extent2] ON [Extenti].[CategoryId] =
[Extent2].[Categoryld]

WHERE [Extent2].[Name] IN (N'Programming',N'Databases’)

It is interesting to note that the generated SQL statement in Listing 3-10 does not use parameters for
the items in the in clause. This is different from the generated code we would see with LINQ to SQL
where the items in the list would be parameterized. With this code, we don’t run the risk of exceeding
the parameters limit that is imposed by SQL Server.

If we are interested in finding all books in a given list of categories or books that are not yet
categorized, we simply include null in the category list. The generated code is shown in Listing 3-11.

Listing 3-11. The SQL statement created for a LINQ expression like the one in Listing 3-9, but with a null
in the list of categories

SELECT
[Extent1].[BookId] AS [BookId],
[Extenta].[Title] AS [Title],
[Extent1].[CategoryId] AS [CategoryId]
FROM [chapter3].[Books] AS [Extent1]
LEFT OUTER JOIN [chapter3].[Category] AS [Extent2] ON [Extenti].[CategoryId] =
[Extent2].[Categoryld]
WHERE [Extent2].[Name] IN (N'Programming',N'Databases"’)
OR [Extent2].[Name] IS NULL
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3-9. Building and Executing a Query Against an
ObjectSet<T>

Problem

You want to build and execute a query against an ObjectSet<T>.

Solution

Let’s suppose you have model like the one in Figure 3-10 and you want to build and execute a query
against the ObjectSet<Patient>.

“z Patient 3

= Properties
#4 patientld
ﬁ:' Mame
B City

= Navigation Properties

Figure 3-10. A model with a Patient entity type

For each of the entities we create in our model, Entity Framework creates code for the object context
that contains a definition of a property of type ObjectSet<T> where T is our entity type. In our case, the
object context contains a property called Patients that is of type ObjectSet<Patient>. To query against
this, follow one of the patterns in Listing 3-12.

Listing 3-12. Using three slightly different approaches to build and execute a query against an
ObjectSet<T>

using (var context = new EFRecipesEntities())

context.Patients.AddObject(new Patient { Name = "Jill Stevens",

City = "Dallas" });
context.Patients.AddObject(new Patient { Name = "Bill Azle",

City = "Fort Worth" });
context.Patients.AddObject(new Patient { Name = "Karen Stanford",

City = "Raytown" });
context.Patients.AddObject(new Patient { Name = "David Frazier",

City = "Dallas" });

context.SaveChanges();

}

using (var context = new EFRecipesEntities())

Console.WriteLine("Using LINQ Builder Methods");
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var patients = context.Patients.Where(p => p.City == "Dallas");
foreach (var patient in patients)

{
}

Console.WriteLine("{0} is in {1}", patient.Name, patient.City);

}

using (var context = new EFRecipesEntities())

Console.WritelLine("\nUsing Entity SQL");
var patients = context.CreateQuery<Patient>(

@"select value p from Patients as p where p.City = 'Dallas'");
foreach (var patient in patients)

Console.WriteLine("{0} is in {1}", patient.Name, patient.City);
}
}
using (var context = new EFRecipesEntities())

Console.WriteLine("\nUsing ESQL Builder Methods");

var patients = context.CreateObjectSet<Patient>("Patients")
Where("it.City = 'Dallas'");

foreach (var patient in patients)

Console.WriteLine("{0} is in {1}", patient.Name, patient.City);

}

The following is the output of the code in Listing 3-12:

Using LINQ Builder Methods
Jill Stevens is in Dallas

David Frazier is in Dallas

Using Entity SQL
Jill Stevens is in Dallas

David Frazier is in Dallas

Using ESOL Builder Methods

Jill Stevens is in Dallas

David Frazier is in Dallas
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How It Works

Each of our entities in a model is exposed as an ObjectSet<T>, which has everything that ObjectQuery<T>
has plus a few methods like AddObject(), Attach(), and DeleteObject(). When we build a query against
ObjectSet<T>, we get an ObjectQuery<T>. Of course, we can continue to compose queries on type of
ObjectQuery<Ts.

In Listing 3-12, we demonstrate three common approaches to building a query. In the first
approach, we use the Where() method and a lambda expression to filter the collection to patients in
Dallas.

In the second approach, we use the CreateQuery() method and an Entity SQL expression to get all
the patients in Dallas.

In the last approach, we use the CreateObjectSet<Patient>() method and the Where() method with
an Entity SQL expression to filter the collection.

Although we didn’t show it in these examples, ObjectSet<T> has a MergeOption property that defines
how the materialized instances of our entities are to be loaded, tracked, and merged in the object
context. Table 3-1 summarizes these merge options.

Table 3-1. Merge Options Available on ObjectSet<T>

Merge Option Description

AppendOnly Default behavior; add new instances to the object context
OverwriteChanges Overwrite any changes made to objects in the object context
PreserveChanges Just reset the original values; don’t overwrite changes in the

object context

NoTracking Don’t track objects in the object context

3-10. Returning a Primitive Type From a Query

Problem

You want to return only a particular property of an entity type from a query.

Solution

Let’s say we have an Organization entity type as shown in the model in Figure 3-11.
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“¢ Organization E3

= Properties
#4 Organizationld
ﬁ:' Mame
B City
ﬁ:' State

=l Navigation Properties

Figure 3-11. A model with an Organization entity type

Suppose that you have a query that you use in several places in your application. In this particular
use, you don’t need the entire entity; you just need one property, say the city, from the entity. For
simplicity, let’s say your query returns all the organizations in the state of Texas and you want to get just
the cities from the query.

To get just the cities, follow the pattern in Listing 3-13.

Listing 3-13. Retrieving a primitive type using both LINQ and Entity SQL
using (var context = new EFRecipesEntities())

var ol = new Organization { Name = "ABC Electric", City = "Azle",

State = "TX" };
var o2 = new Organization { Name = "PowWow Pests", City = "Miami”,

State = "FL" };
var 03 = new Organization { Name = "Grover Grass & Seed",

City = "Fort Worth", State = "TX" };
context.0Organizations.AddObject(o1);
context.0Organizations.AddObject(02);
context.0Organizations.AddObject(o3);
context.SaveChanges();

}
using (var context = new EFRecipesEntities())

var query = context.Organizations.Where("it.State = 'TX'");
Console.WriteLine("Cities (using LINQ)");

var cities = query.Select(o => o.City).Distinct().OrderBy(c => c);
foreach (var city in cities)

Console.WriteLine("{0}", city);

}

Console.WriteLine("Cities (using eSQL)");
cities = query.SelectValue<string>("distinct it.City").OrderBy("it");
foreach (var city in cities)

{
}

Console.WriteLine("{0}", city);
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The following is the output of the code in Listing 3-13:

Cities (using LINQ)
Azle

Fort Worth

Cities (using eSQL)
Azle

Fort Worth

How It Works

We start in Listing 3-13 by inserting a few organizations. Once these are in place, we create a new object
context and build our base query. This query simply retrieves all the organizations in the state of Texas.

Next, using LINQ, we use the Select() method to project just the city property from the result set.
This set may contain duplicate cities, so we apply the Distinct() method to eliminate these duplicates.
Finally, just for good measure, we sort the cities.

For Entity SQL, we use the SelectValue() method passing in an Entity SQL expression that uses the
distinct operator to remove duplicates. We sort the results.

In both cases, we take a base query and we use builder methods to compose the additional
operations of projection (using Select() for LINQ and SelectValue() for Entity SQL) and ordering to get
the final collection of city names.

3-11. Filtering Related Entities

Problem

You want to want to retrieve some, but not all, of the related entities.

Solution

Let’s say you have a model like the one in Figure 3-12.
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Figure 3-12. A model for a Worker and their Accidents

In this model, we have a Worker who has experienced zero or more accidents. Each accident is
classified by its severity. We want to retrieve all workers, but we are interested only in serious accidents.
These are accidents with a severity greater than 2.

To retrieve all the workers, but to limit the accidents retrieved to just the serious ones, follow the
pattern in Listing 3-14.

Listing 3-14. Retrieving serious accidents using anonymous types and using CreateSourceQuery/()
using (var context = new EFRecipesEntities())

var workerl = new Worker { Name
var worker2 = new Worker { Name = "Nancy Roberts" };
var worker3 = new Worker { Name = "Karla Gibbons" };
context.Accidents.AddObject(new Accident {

Description = "Cuts and contusions",
Severity = 3, Worker = workeri });
context.Accidents.AddObject(new Accident {
Description = "Broken foot",
Severity = 4, Worker = workeri});
context.Accidents.AddObject(new Accident {
Description = "Fall, no injuries”,
Severity = 1, Worker = worker2});
context.Accidents.AddObject(new Accident {
Description = "Minor burn",
Severity = 3, Worker = worker2});
context.Accidents.AddObject(new Accident {
Description = "Back strain",
Severity = 2, Worker = worker3});
context.SaveChanges();

"John Kearney" };

}

using (var context = new EFRecipesEntities())
context.ContextOptions.LazyloadingEnabled = false;
var query = from w in context.Workers

select new

Worker = w,
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Accidents = w.Accidents.Where(a => a.Severity > 2)
}s

query.Tolist();
var workers = query.Select(r => r.Worker);
Console.WriteLine("Workers with serious accidents...");
foreach (var worker in workers)
{

Console.WriteLine("{0} had the following accidents", worker.Name);

if (worker.Accidents.Count ==

Console.WriteLine("\t--None--");
foreach (var accident in worker.Accidents)

Console.WriteLine("\t{0}, severity: {1}",
accident.Description, accident.Severity.ToString());

}

Console.WriteLine();
using (var context = new EFRecipesEntities())

context.ContextOptions.LazylLoadingEnabled = false;
foreach (var worker in context.Workers)

{
Console.WriteLine("{0} had the following accidents", worker.Name);
var accidents = worker.Accidents.CreateSourceQuery()
.Where(a => a.Severity > 2);
worker.Accidents.Attach(accidents);
if (worker.Accidents.Count == 0)
Console.WriteLine("\t--None--");
foreach (var accident in accidents)
{
Console.WriteLine("\t{0}, severity: {1}",
accident.Description, accident.Severity.ToString());
}
}

The following is the output of the code in Listing 3-14:

Workers with serious accidents...
John Kearney had the following accidents
Cuts and contusions, severity: 3

Broken foot, severity: 4
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Nancy Roberts had the following accidents
Minor burn, severity: 3
Karla Gibbons had the following accidents

--None--

John Kearney had the following accidents
Cuts and contusions, severity: 3
Broken foot, severity: 4

Nancy Roberts had the following accidents
Minor burn, severity: 3

Karla Gibbons had the following accidents

--None- -

How It Works

As you will see in Chapter 5, when we want to eagerly load a related collection, we often use the
Include() method with a query path. However, the Include() method does not allow filtering on the
related entities. In this recipe, we show two slightly different ways to load and filter related entities.

In the first block of code, we create a few workers and assign them accidents of varying levels of
severity. Granted, it’s a little creepy to assign accidents to people, but it’s all in the name of getting some
data to work with.

In the first approach, we select from all the workers and project the results into an anonymous type.
The type includes the worker and the collection of accidents. For the accidents, we filter the collection to
get just the serious accidents.

The very next line is important. Here we force the evaluation of the query by calling the ToList()
method. This brings all the workers and all the serious accidents into the Object Context. The
anonymous type didn’t attach the accidents to the workers, but by bringing them into the Object
Context, Entity Framework will fix up the navigation properties, attaching each collection of serious
accidents to the appropriate worker. This process, commonly known as Entity Span, is a powerful yet
subtle side effect that happens behind the scenes to fix up relationships between entities as they are
materialized in the Object Context.

We've turned off lazy loading (we’ll talk more about lazy loading in Chapter 5) so that only the
accidents in our filter are loaded. With lazy loading on, all the accidents would get loaded when we
referenced each worker’s accidents. That would defeat our filter.

Once we have the collection, we iterate through it, printing out each worker and their serious
accidents. If a worker didn’t have any serious accidents, we print none to indicate their stellar safety
record.

For the second approach, we use the CreateSourceQuery() method to append our filter onto the
query that Entity Framework will use to gather up all the accidents for the worker. We have more to say
about CreateSourceQuery() in Chapter 5. Once we have the collection of serious accidents for the
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worker, we attach() it to the worker. After attaching the collection, we iterate through the collection
printing out the serious accidents.

3-12. Applying a Left Outer Join

Problem

You want to combine the properties of two entities using a left outer join.

Solution
Suppose you have a model like the one in Figure 3-13.

#2  Product ES 4: TopSelling ES

= Properties =l Properties
# Productld ¥ Productld
5 Name 1 0.1 ﬁ“Rating

= Navigaticn Properties =l Navigaticn Properties
5:—!, TopSelling 5:—!, Product

Figure 3-13. Our model with a Product entity type and its related TopSelling entity type

The top-selling products have a related TopSelling entity. Of course, not all products are top sellers,
and that’s why the relationship is one to zero or one. When a product is a top seller, the related TopSeller
entity also contains the customer rating for the product. You want to find all the products and their
related TopSeller entities even if, in some cases, the product is not a top seller. In database terms, this is
called a left outer join.

The code in Listing 3-15 demonstrates three slightly different approaches to this problem.

Listing 3-15. Doing a left outer join between entities

using (var context = new EFRecipesEntities())

var p1 = new Product { Name = "Trailrunner Backpack" };
var p2 = new Product { Name = "Green River Tent",

TopSelling = new TopSelling { Rating =3 } };
var p3 = new Product { Name = "Prairie Home Dutch Oven",

TopSelling = new TopSelling { Rating = 4 } };
var p4 = new Product { Name = "QuickFire Fire Starter”,

TopSelling = new TopSelling { Rating = 2 } };
context.Products.AddObject(p1);
context.Products.AddObject(p2);
context.Products.AddObject(p3);
context.Products.AddObject(p4);
context.SaveChanges();
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using (var context = new EFRecipesEntities())

var products = from p in context.Products
orderby p.TopSelling.Rating descending
select p;
Console.WriteLine("Top selling products sorted by rating");
foreach (var product in products)

if (product.TopSelling != null)
Console.WriteLine("\t{0} [rating: {1}]", product.Name,
product.TopSelling.Rating.ToString());

}
}

using (var context = new EFRecipesEntities())

var products = from p in context.Products
join t in context.TopSellings on
p.ProductId equals t.ProductId into g
from tps in g.DefaultIfEmpty()
orderby tps.Rating descending

select new
{
Name = p.Name,
Rating = tps.Rating == null ? 0 : tps.Rating
b

Console.WriteLine("\nTop selling products sorted by rating");
foreach (var product in products)

if (product.Rating != 0)
Console.WriteLine("\t{o} [rating: {1}]", product.Name,
product.Rating.ToString());

}
}

using (var context = new EFRecipesEntities())

var esql = @"select value p from products as p
order by case when p.TopSelling is null then 0
else p.TopSelling.Rating end desc";
var products = context.CreateQuery<Product>(esql);
Console.WriteLine("\nTop selling products sorted by rating");
foreach (var product in products)

if (product.TopSelling != null)

Console.WriteLine("\t{0} [rating: {1}]", product.Name,
product.TopSelling.Rating.ToString());
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The following is the output of the code in Listing 3-15:

Top selling products sorted by rating
Prairie Home Dutch Oven [rating: 4]
Green River Tent [rating: 3]

QuickFire Fire Starter [rating: 2]

Top selling products sorted by rating
Prairie Home Dutch Oven [rating: 4]
Green River Tent [rating: 3]

QuickFire Fire Starter [rating: 2]

Top selling products sorted by rating
Prairie Home Dutch Oven [rating: 4]
Green River Tent [rating: 3]

QuickFire Fire Starter [rating: 2]

How It Works

In Listing 3-15, we show three slightly different solutions. The first solution is the simplest because Entity
Framework handles the join automatically for related entities. The entities are in a one to zero or one
association. When the product entities are materialized, any associated top sellers are also materialized.
The TopSeller navigation property is either set to the associated TopSeller entity or null if no TopSeller
exists.

In some cases, you might not have a relationship between the entities that you want to join. In these
cases, you can explicitly join the entities projecting the results into an anonymous type. We need to
project into an anonymous type because the unrelated entities won’t have navigation properties so we
wouldn’t otherwise be able to reference the related entity.

The code in the second query block illustrates this approach. Here we join the entities on the
Productld key and put the result into g. Now, from g we apply the DefaultIfEmpty() method to fill in
nulls when g is empty. This gives us the left inner join. We include an orderby clause to order the results
by the rating. Finally, we project the results into an anonymous type.
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In the third solution, we show you how to do the left inner join more explicitly using Entity SQL.

3-13. Ordering by Derived Types

Problem

You are using Table per Hierarchy inheritance and you want to sort results by the derived type.

Solution
Let’s suppose you have a model like the one in Figure 3-14.
= Properties
#4 Mediald

= Title

=l Navigation Properties

_ I

e Article ES 2 Video ES ¢ Picture ES
= Medium = Medium = Medium

= Properties = Properties =l Properties

= Navigation Properties = Navigation Properties =l Navigation Properties

Figure 3-14. A model using Table per Hierarchy inheritance with three derived types

This model uses Table per Hierarchy inheritance. The Medium entity has a discriminator property
whose values determine which derived type is represented by a row from the database. This
discriminator column has a value of 1 for the Article type, a value of 2 for the Video type, and a value of 3
for the Picture type. Because the property is used only to determine the derived type, it is not shown as
part of the entity.

You want to query the model for all media and sort the results by the derived types: Article, Video,
and Picture. To do this, follow the pattern in Listing 3-16.

Listing 3-16. Sorting Table per Hierarchy inheritance by type
using (var context = new EFRecipesEntities())

context.Media.AddObject(new Article {

Title = "Woodworkers' Favorite Tools" });
context.Media.AddObject(new Article {

Title = "Building a Cigar Chair" });
context.Media.AddObject(new Video {
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Title = "Upholstering the Cigar Chair" });
context.Media.AddObject(new Video {

Title = "Applying Finish to the Cigar Chair" });
context.Media.AddObject(new Picture {

Title = "Photos of My Cigar Chair" });
context.Media.AddObject(new Video {

Title = "Tour of My Woodworking Shop" });
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

var allMedia = from m in context.Media
let mediatype = m is Article ? 1 :
m is Video ? 2 : 3
orderby mediatype
select m;
Console.WriteLine("All Media sorted by type...");
foreach (var media in allMedia)

{
Console.WriteLine("Title: {0} [{1}]", media.Title, media.GetType().Name);

The following is the output of the code in Listing 3-16:

All Media sorted by type...

Title: Woodworkers' Favorite Tools [Article]
Title: Building a Cigar Chair [Article]

Title: Upholstering the Cigar Chair [Video]
Title: Applying Finish to the Cigar Chair [Video]
Title: Tour of My Woodworking Shop [Video]

Title: Photos of My Cigar Chair [Picture]

How It Works

When we use Table per Hierarchy inheritance we leverage a column in the table to distinguish which
derived type represents any given row. This column, often referred to as the discriminator column, can’t
be mapped to a property of the base entity. Because we don’t have a property with the discriminator
value, we need to create a variable to hold comparable discriminator values so that we can do the sort.
To do this, we use a let clause creating the mediatype variable. We use a conditional statement to assign
an integer to this variable based on the type of the media. For Articles we assign the value 1. For Videos,
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we assign the value 2. We assign 3 to anything else, which will always be of type Picture because we don’t
have any other derived types left.

3-14. Paging and Filtering

Problem

You want to create query with a filter and paging.

Solution

Let’s say you have a Customer entity type in a model, as shown in Figure 3-15.

“¢  Customer ES
= Properties

# Customerld

ﬁ] Mame

5 Email

= Navigation Properties

Figure 3-15. A model with a Customer entity type

You have an application that displays customers based on a filter. Your company has many
customers (perhaps millions!) and to keep the user experience as responsive as possible, you want to
show only a limited number of customers on each page. To create a query that both filters the customers
and returns a manageable set for each results page in your application, follow the pattern in Listing 3-17.

Listing 3-17. Filtering and paging a query
using (var context = new EFRecipesEntities())

context.Customers.AddObject(new Customer { Name = "Roberts, Jill",
Email = "jroberts@abc.com" });
context.Customers.AddObject(new Customer { Name = "Robertson, Alice",
Email = "arob@gmail.com" });
context.Customers.AddObject(new Customer { Name = "Rogers, Steven",
Email = "srogers@termite.com" });
context.Customers.AddObject(new Customer { Name = "Roe, Allen",
Email = "allenr@umc.com" });
context.Customers.AddObject (new Customer { Name = "Jones, Chris",
Email = “cjones@ibp.com" });
context.SaveChanges();


mailto:jroberts@abc.com
mailto:arob@gmail.com
mailto:srogers@termite.com
mailto:allenr@umc.com
mailto:cjones@ibp.com

b MULIITIINA TUE Il Wi v et

using (var context = new EFRecipesEntities())
string match = "Ro";
int pageIndex = 0;
int pageSize = 3;

var customers = context.Customers.Where(c => c.Name.StartsWith(match))
.OrderBy(c => c.Name)
.Skip(pageIndex * pageSize)
.Take(pageSize);

Console.WriteLine("Customers Ro*");

foreach (var customer in customers)

Console.WriteLine("{0} [email: {1}]", customer.Name, customer.Email);
}
}
using (var context = new EFRecipesEntities())

string match = "Ro%";
int pageIndex = 0;
int pageSize = 3;

var customers = context.Customers.Where("it.Name like @Name",
new ObjectParameter("Name", match))
.Skip("it.Name", "@Skip",
new ObjectParameter("Skip", pageIndex))
.Top("@Limit",
new ObjectParameter("Limit", pageSize));
Console.WriteLine("\nCustomers Ro*");
foreach (var customer in customers)

{
}

Console.WriteLine("{0} [email: {1}]", customer.Name, customer.Email);

}

using (var context = new EFRecipesEntities())

string match = "Ro%";
int pageIndex = 0;
int pageSize = 3;

var esql = @"select value c from Customers as c

where c.Name like @Name

order by c.Name

skip @Skip limit @Limit";
Console.WriteLine("\nCustomers Ro*");
var customers = context.CreateQuery<Customer>(esql, new[]

new ObjectParameter("Name",match),
new ObjectParameter("Skip",pageIndex * pageSize),
new ObjectParameter("Limit",pageSize)

D;
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foreach (var customer in customers)

{
}

Console.WriteLine("{0} [email: {1}]", customer.Name, customer.Email);

The following is the output from the code in Listing 3-17:

Customers Ro*
Roberts, Jill [email: jroberts@abc.com]
Robertson, Alice [email: arob@gmail.com]

Roe, Allen [email: allenr@umc.com]

Customers Ro*
Roberts, Jill [email: jroberts@abc.com]
Robertson, Alice [email: arob@gmail.com]

Roe, Allen [email: allenr@umc.com]

Customers Ro*
Roberts, Jill [email: jroberts@abc.com]
Robertson, Alice [email: arob@gmail.com]

Roe, Allen [email: allenr@umc.com]

How It Works

In Listing 3-17 we show three different solutions to the problem. In the first solution, we use LINQ
builder methods to construct the query. We use the Where() method to filter the results to customers
whose last name starts with Ro. Because we are using the StartsWith() method inside the lambda
expression, we don’t need to use a SQL wildcard expression such as “Ro%”.

After filtering, we use the OrderBy() method to order the results. Ordered results are required by the
Skip() method. We use the Skip() method to move over pageIndex number of pages, each of size
pageSize. We limit the results with the Take() method. We only need to take one page of results.
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In the next solution, we use Entity SQL builder methods to construct the query. We use the Where()
and Skip() builder methods as we did in the LINQ solution but this time with Entity SQL syntax. For
limiting the result set size, we use the Top() method. One difference is that we don’t need to use the
OrderBy() method. The Skip() method takes a parameter to name the column on which to perform the
ordering. Ordering is important for the Skip() method because without it, the query results would not be
repeatable.

For the last solution we construct a complete, parameterized Entity SQL expression. This is perhaps
the most familiar way to solve the problem, but it exposes some of the inherent mismatch between a
query language expressed in a string and executable code expressed, in this case, in C#.

3-15. Grouping by Date

Problem

You have an entity type with a DateTime property and you want to group instances of this type based on
just the date portion of the property.

Solution

Let’s say you have a Registration entity type in your model and the Registration type has a DateTime
property. Your model might look like the one in Figure 3-16.

“¢  Registration &

= Properties
#4 Registrationld
ﬁ] StudentMame
' RegistrationDate

= Navigation Properties

Figure 3-16. A model with a single Registration entity type. The entity type’s RegistrationDate property is a
DateTime.

We want to group all the registrations by just the date portion of the RegistrationDate property. You
might be tempted in LINQ to group by RegistrationDate.Date. Although this will compile, you will
receive a runtime error complaining that Date can’t be translated into SQL. To group by just the date
portion of the RegistrationDate, follow the pattern in Listing 3-18.

Listing 3-18. Grouping by the date portion of a DateTime property
using (var context = new EFRecipesEntities())
context.Registrations.AddObject(new Registration {
StudentName = "Jill Rogers",

RegistrationDate = DateTime.Parse("12/03/2009 9:30 pm") });
context.Registrations.AddObject(new Registration {
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StudentName = "Steven Combs",

RegistrationDate = DateTime.Parse("12/03/2009 10:45 am") });
context.Registrations.AddObject(new Registration {

StudentName = "Robin Rosen",

RegistrationDate = DateTime.Parse("12/04/2009 11:18 am") });
context.Registrations.AddObject(new Registration {

StudentName = "Allen Smith",

RegistrationDate = DateTime.Parse("12/04/2009 3:31 pm") });
context.SaveChanges();

using (var context = new EFRecipesEntities())

var groups = from r in context.Registrations
group r by EntityFunctions.TruncateTime(r.RegistrationDate)

into g
select g;
foreach (var element in groups)
{
Console.WriteLine("Registrations for {0}",
((DateTime)element.Key).ToShortDateString());
foreach (var registration in element)
Console.WriteLine("\t{0}", registration.StudentName);
}
}

The following is the output of the code in Listing 3-18:

Registrations for 12/3/2009
Jill Rogers
Steven Combs
Registrations for 12/4/2009
Robin Rosen

Allen Smith

How It Works

The key to grouping the registrations by the date portion of the RegistrationDate property is to use the
Truncate() function. This built-in Entity Framework function extracts just the date portion of the
DateTime value. We’ll have a lot more to say about functions in Chapter 11.
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3-16. Flattening Query Results

Problem

You have two entity types in a one-to-many association and you want, in one query, to obtain a flatten
projection of all the entities in the association.

Solution

Let’s say you have a couple of entity types in a one-to-many association. Perhaps your model looks
something like the one in Figure 3-17.

¢ AssodiateSalary %

2 Assodiate S
= Properties
= Properties ¥ Salaryld
@j‘ Associateld ﬁj Associateld
ﬁ] Mame 1 * = Salary

5 SalaryDate

=l Navigation Properties

=l Navigation Properties

3_—1 AssociateSalaries

3_—1 Associate

Figure 3-17. A model with an Associate entity type representing an associate, and an AssociateSalary entity
type representing the salary history for the associate

You want to get all the associates and all their salary history in one query. There may be some new
hires that are in the system but don’t yet have a salary set. You want your query results to include these
associates as well.

To query the model and get the results you want, follow the pattern in Listing 3-19.

Listing 3-19. Flattening out the results using both LINQ and Entity SQL

using (var context = new EFRecipesEntities())

var assocl = new Associate { Name = "Janis Roberts" };
var assoc2 = new Associate { Name = "Kevin Hodges" };
var assoc3 = new Associate { Name = "Bill Jordan" };

var salaryl = new AssociateSalary { Salary = 39500M,
SalaryDate = DateTime.Parse("8/14/09") };
var salary2 = new AssociateSalary { Salary = 41900M,
SalaryDate = DateTime.Parse("2/5/10") };
var salary3 = new AssociateSalary { Salary = 33500M,
SalaryDate = DateTime.Parse("10/08/09") };
assoc2.AssociateSalaries.Add(salary1);
assoc2.AssociateSalaries.Add(salary2);
assoc3.AssociateSalaries.Add(salary3);
context.Associates.AddObject(assoc1);
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context.Associates.AddObject(assoc2);
context.Associates.AddObject(assoc3);
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

Console.WriteLine("Using LINQ...");
var allHistory = from a in context.Associates
from ah in a.AssociateSalaries.DefaultIfEmpty()
orderby a.Name
select new
{
Name = a.Name,
Salary = (decimal ?) ah.Salary,
Date = (DateTime ?) ah.SalaryDate
)
Console.WriteLine("Associate Salary History");
foreach (var history in allHistory)

if (history.Salary.HasValue)

Console.WriteLine("{0} Salary on {1} was {2}", history.Name,
history.Date.Value.ToShortDateString(),
history.Salary.Value.ToString("C"));

else
Console.WriteLine("{0} --", history.Name);

}
using (var context = new EFRecipesEntities())

Console.WriteLine("\nUsing Entity SQL...");
var esql = @"select a.Name, h.Salary, h.SalaryDate
from Associates as a outer apply
a.AssociateSalaries as h order by a.Name";
var allHistory = context.CreateQuery<DbDataRecord>(esql);
foreach (var history in allHistory)

if (history["Salary"] != DBNull.Value)
Console.WriteLine("{0} Salary on {1:d} was {2:c}", history["Name"],
history["SalaryDate"], history["Salary"]);
else
Console.WriteLine("{0} --",history["Name"]);

The following is the output of the code in Listing 3-19:
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Using LINQ...

Associate Salary History

Bill Jordan Salary on 10/8/2009 was $33,500.00
Janis Roberts --

Kevin Hodges Salary on 8/14/2009 was $39,500.00
Kevin Hodges Salary on 2/5/2010 was $41,900.00
Using Entity SOL...

Bill Jordan Salary on 10/8/2009 was $33,500.00
Janis Roberts --

Kevin Hodges Salary on 8/14/2009 was $39,500.00

Kevin Hodges Salary on 2/5/2010 was $41,900.00

How It Works

To flatten the query results we followed the strategy in Recipe 12 in this chapter and used a nested from
clause and the DefaultIfEmpty() method to get a left outer join between the tables. The
DefaultIfEmpty() method ensured that we have rows from the left side (the Associate entities), even if
there are no corresponding rows on the right side (AssociateSalary entities). We project the results into
an anonymous type being careful to capture null values for the salary and salary date when there are no
corresponding AssociateSalary entities.

For the Entity SQL solution, we use the outer apply operator to create unique pairings between each
Associate entity and AssociateSalary entity. Both the cross and outer apply operators were introduced in
SQL Server 2005.

3-17. Grouping by Multiple Properties

Problem

You want to group the results of a query by multiple properties.
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Solution

Let’s say you have a model with an Event entity type like the one in Figure 3-18. Event has a name, city,
and state. You want to group events by state and then by city.

@2 Event ES

= Properties
#4 Eventld
ﬁ;' Mame
ﬁ;' State
5 City

=l Navigation Properties

Figure 3-18. A model with an Event entity type which as properties for the event’s name, state, and city

To get all the events grouped by state and then city, follow the pattern in Listing 3-20.
Listing 3-20.
using (var context = new EFRecipesEntities())

context.Events.AddObject(new Event { Name = "TechFest 2010",

State = "TX", City = "Dallas" });
context.Events.AddObject(new Event { Name = "Little Blue River Festival",

State = "MO", City = "Raytown" });
context.Events.AddObject(new Event { Name = "Fourth of July Fireworks",

State = "MO", City = "Raytown" });
context.Events.AddObject(new Event { Name = "BBQ Ribs Championship",

State = "TX", City = "Dallas" });
context.Events.AddObject(new Event { Name = "Thunder on the Ohio",

State = "KY", City = "Louisville" });
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

Console.WriteLine("Using LINQ");
var results = from e in context.Events
group e by new { e.State, e.City } into g
select new
{
State = g.Key.State,
City = g.Key.City,
Events = g }
Console.WriteLine("Events by State and City...");
foreach (var item in results)

Console.WriteLine("{0}, {1}", item.City, item.State);
foreach (var ev in item.Events)

{
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Console.WriteLine("\t{0}", ev.Name);

}
}

using (var context = new EFRecipesEntities())

Console.WriteLine("\nUsing Entity SQL");
var esql = @"select e.State, e.City, GroupPartition(e) as Events
from Events as e
group by e.State, e.City";
var records = context.CreateQuery<DbDataRecord>(esql);
Console.WriteLine("Events by State and City...");
foreach (var rec in records)

{
Console.WriteLine("{0}, {1}", rec["City"], rec["State"]);
var events = (List<Event>)rec["Events"];
foreach (var ev in events)
{
Console.WriteLine("\t{0}", ev.Name);
}
}
}
The following is the output of the code in Listing 3-20:
Using LINQ

Events by State and City...
Louisville, KY

Thunder on the Ohio
Raytown, MO

Little Blue River Festival

Fourth of July Fireworks
Dallas, TX

TechFest 2010

BBQ Ribs Championship
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Using Entity SQL
Events by State and City...
Louisville, KY

Thunder on the Ohio
Raytown, MO

Little Blue River Festival

Fourth of July Fireworks
Dallas, TX

TechFest 2010

BBQ Ribs Championship

How It Works

In Listing 3-20, we show two different solutions. The first solution uses LINQ and the group by operator
to group the results by state and city. When using the group by operator for multiple properties, we
create an anonymous type for the grouping. We use an into clause to send the groups to g.

We project the results from g into a new anonymous type getting the State from the group key’s
State field (from the first anonymous type) and the City from the group key’s City field. For the events,
we simply select all the members of the group.

For the Entity SQL approach, we can only project columns used in the group by clause, a constant
value, or a computed value from using an aggregate function. In our case, we project the state, city, and
the collection of events for each grouping.

3-18. Using Bitwise Operators in a Filter

Problem

You want to use bitwise operators to filter a query.

Solution

Let’s say you have an entity type with an integer property that you want to use as a set of bit flags. You'll
use some of the bits in this property to represent the presence or absence of some particular attribute for
the entity. For example, suppose you have an entity type for patrons of a local art gallery. Some patrons
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contribute money. Some volunteer during gallery hours. A few patrons serve on the board of directors. A
few patrons support the art gallery in more than one way. A model with this entity type is shown in
Figure 3-19.

>

“¢ Patron

= Properties
# patronld
ﬁ:' Mame
2 SponsorType

= Navigation Properties

Figure 3-19. A Patron entity type with a SponsorType property that we use as a collection of bit flags
indicating the sponsorship type for the patron

We want to query for patrons and filter on the type of sponsorship provided by the patron. To do
this, follow the pattern in Listing 3-21.

Listing 3-21. Using bitwise operators in a query
static void Main(string[] args)

RunExample();

public enum SponsorTypes

ContributesMoney = 1,

Volunteers = 2,

IsABoardMember = 4
b

static void RunExample()

{

using (var context = new EFRecipesEntities())

context.Patrons.AddObject(new Patron { Name = "Jill Roberts",
SponsorType = (int)SponsorTypes.ContributesMoney });
context.Patrons.AddObject(new Patron { Name = "Ryan Keyes",
SponsoxType = (int)(SponsorTypes.ContributesMoney |
SponsoxrTypes.IsABoardMember)});
context.Patrons.AddObject(new Patron {Name = "Karen Rosen",
SponsoxType = (int)SponsorTypes.Volunteers});
context.Patrons.AddObject(new Patron {Name = “"Steven King",
SponsoxType = (int)(SponsorTypes.ContributesMoney |
SponsoxrTypes.Volunteers)});
context.SaveChanges();

}

using (var context = new EFRecipesEntities())
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Console.WriteLine("Using LINQ...");
var sponsors = from p in context.Patrons
where (p.SponsorType &
(int)SponsorTypes.ContributesMoney) != 0
select p;
Console.WriteLine("Patrons who contribute money");
foreach (var sponsor in sponsors)

{
}

Console.WriteLine("\t{0}", sponsor.Name);

using (var context = new EFRecipesEntities())

Console.WriteLine("\nUsing Entity SQL...");
var esql = @"select value p from Patrons as p
where BitWiseAnd(p.SponsorType, @type) <> 0";
var sponsors = context.CreateQuery<Patrons(esql,
new ObjectParameter("type", (int)SponsorTypes.ContributesMoney));
Console.WriteLine("Patrons who contribute money");
foreach (var sponsor in sponsors)

Console.WriteLine("\t{0}", sponsor.Name);

}

The following is the output of the code in Listing 3-21:

Using LINQ...

Patrons who contribute money

Jill Roberts
Ryan Keyes

Steven King

Using Entity SQL...

Patrons who contribute money
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Ryan Keyes

Steven King

How It Works

In our model, the Patron entity type packs multiple bit flags into a single integer property. A patron can
sponsor the gallery in a number of ways. Each type of sponsorship is represented in a different bit in the
SponsorType property. We represented each of the ways a sponsor can contribute in the SponsorTypes
enum. We were careful to assign integers in power of 2 increments for each sponsor type. This means that
each will have exactly one unique bit in the bits of the SponsorType property.

When we inserted a few patrons, we assign the sponsorship type to the SponsorType property. For
patrons that contribute in more than one way, we simply use the bitwise OR (I) operator to build the bit
pattern representing all the ways the patron contributes to the gallery.

For the LINQ query, we use the bitwise AND (&) operator to extract the bit for the ContributesMoney
flag from the SponsorType property value. If the result is non-zero, then the patron has the
ContributesMoney flag set. If we needed to find patrons that contribute in more than one way, we would
OR all the SponsorTypes we're interested in together before we used the AND operator to extract one or
more set bits.

The second solution demonstrates the same approach using Entity SQL. Here we use the
BitWiseAnd() function to extract the set bit. Entity SQL supports a full complement of bitwise functions.

3-19. Joining on Multiple Columns

Problem

You want to join two entity types on multiple properties.

Solution

Let’s say you have the model like the one in Figure 3-20. The Account entity type is in a one-to-many
association with the Order type. Each account may have many orders while each order is associated with
exactly one order. You want to find all the orders that are being shipped to a same city and state as the
account.
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% Orders g P

=
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Figure 3-20. A model with an Account entity type and its associated Order entity type

To find the orders, follow the pattern in Listing 3-22.

Listing 3-22. Using a join on multiple properties to find all the orders being shipped to the account’s city
and state

using (var context = new EFRecipesEntities())

var al = new Account { City = "Raytown", State = "MO" };

a1.0rders.Add(new Order { Amount = 223.09M, ShipCity = "Raytown",
ShipState = "MO" });

a1.0rders.Add(new Order { Amount = 189.32M, ShipCity = "Olathe",
ShipState = "KS" });

var a2 = new Account { City = "Kansas City", State = "M0" };
a2.0rders.Add(new Order { Amount = 99.29M, ShipCity = "Kansas City",
ShipState = "MO" });

var a3 = new Account { City = "North Kansas City", State = "M0"};

a3.0rders.Add(new Order { Amount = 102.29M, ShipCity = "Overland Park",
ShipState = "KS" });

context.Accounts.AddObject(a1);

context.Accounts.AddObject(a2);

context.Accounts.AddObject(a3);

context.SaveChanges();

}
using (var context = new EFRecipesEntities())

var orders = from o in context.Orders
join a in context.Accounts on
new {Id = o.AccountId, City = o.ShipCity, State = o.ShipState }
equals
new {Id = a.AccountId, City = a.City, State = a.State }
select o;

Console.WriteLine("Orders shipped to the account's city, state...");
foreach (var order in orders)
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Console.WriteLine("\tOrder {0} for {1}", order.AccountId.ToString(),
order.Amount.ToString("C"));

The following is the output of the code in Listing 3-21:

Orders shipped to the account's city, state...
Order 31 for $223.09

Order 32 for $99.29

How It Works

To solve this problem, you could find all the accounts and then go through each Orders collection and
find the orders that are in the same city and state as the account. For a small number of accounts, this
may be a reasonable solution. But in general, it is best to push this sort of processing into the store layer
where can be handled much more efficiently.

In the solution, we form the join by creating an anonymous type on each side of the equals clause.
This is required when we join on more than one property. We need to make sure that both anonymous
types are the same. They must have the same properties in the same order.
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CHAPTER 4

Using Entity Framework in ASP.NET

In this chapter, we show you how to use the Entity Framework in your ASP.NET web pages. You could, of
course, use many of the methods shown throughout this book in the code behind for your pages, but in
this chapter we focus specifically on using the declarative approach provided by EntityDataSource and
ObjectDataSource controls.

The EntityDataSource control together with the QueryExtender control provide a powerful, yet easy-
to-understand way for you to build ASP.NET web pages that leverage much of the capabilities of the
Entity Framework. The recipes in this chapter cover everything from simple searching to building a
complete insert, update, delete, and search page. The last recipe in this chapter shows you how to use
the ObjectDataSource control with Entity Framework.

Each of the recipes in this chapter starts with a new Empty ASP.NET Web Application. We've tried to
keep things simple by not including all of extra code that comes with the default new ASP.NET Web
Application template.

4-1. Building a Search Query

Problem

You want to declaratively build a search query in an ASP.NET page using EntityDataSource.

Solution
Let’s say you have a model like the one in Figure 4-1.

2 Customer 3

= Properties
# Customerld
ﬁ;' Mame
B City
ﬁ;' State

=l Navigation Properties

Figure 4-1. A model with a Customer entity
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In Listing 4-1, we use three basic parts to build our search page: a table to structure the query
parameters, a ListView to present the results, and an EntityDataSource to define the query. The code
behind for page in Listing 4-2, simply populates the database with some test data in the Page_Load()
event handler.

Listing 4-1. Using EntityDataSource to build a search query

<body>
<form id="form1" runat="server">
<div>
<table>
<tr>
<td>Name</td>
<td><asp:TextBox ID="Name" runat="server" /></td>
</tr>
<trs
<td>City</td>
<td><asp:TextBox ID="City" runat="server" /></td>
</tr>
<trs
<td>State</td>
<td><asp:TextBox ID="State" runat="server" /»></td>
</tr>
<tr>
<td colspan="2">
<asp:Button ID="SearchCustomer" Text="Search" runat="server" />
</td>
</tr>
</table>

<asp:EntityDataSource ID="CustomerList" runat="server"
ConnectionString="name=EFRecipesEntities"
DefaultContainerName="EFRecipesEntities"
Where="(@State is null || it.State = @State) &&
(@City is null || it.City = @City) &&
(@Name is null || it.Name LIKE '%' + @Name + '%')"
EntitySetName="Customers">
<WhereParameters>
<asp:ControlParameter Name="Name" ControlID="Name" Type="String" />
<asp:ControlParameter Name="City" ControlID="City" Type="String" />
<asp:ControlParameter Name="State" ControlID="State" Type="String" />
</WhereParameters>
</asp:EntityDataSource>

<asp:ListView ID="CustomerListView" runat="server"
DataSourceID="CustomerList">
<ItemTemplate>
<tr>
<td><%# Eval("Name") %></td>
<td><%# Eval("City") %></td>
<td><%# Eval("State") %></td>
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</tr>
</ItemTemplate>
<LayoutTemplate>
<table>
<tr>
<th>Name</th>
<th>City</th>
<th>State</th>
</tr>
<tr id="ItemPlaceHolder" runat="server" />
</table>
</LayoutTemplate>
</asp:ListView>
</div>
</foxrm>
</body>

Listing 4-2. The code behind that builds the data to test our search page
public partial class Default : System.Web.UI.Page

protected void Page_Load(object sender, EventArgs e)

{

using (var context = new EFRecipesEntities())

// delete any previous data we might have

MU N DAY VT TN A LNt

context.ExecuteStoreCommand("delete from chapter4.customexr");

// insert some data

context.Customers.AddObject(new Customer { Name = "Robin Rosen",
City = "Olathe", State = "KS" });
context.Customers.AddObject (new Customer { Name = "John Wise",
City = "Springtown", State = "TX" });
context.Customers.AddObject(new Customer { Name = "Karen Carter",
City = "Raytown", State = "M0" });

context.SaveChanges();

In the browser, the page looks something like the one in Figure 4-2.
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Figure 4-2. The rendered page shown in a browser

How It Works

In the first section of the page (refer to Listing 4-1), we format the query fields using a table. Nothing
fancy here. The idea is to provide some structure to capture the three query fields: Name, City, and State.
These values, or the lack of them, will be used in the EntityDataSource to form the filter for the query.

Next, we use an EntityDataSource to provide a data source for the results. In the EntityDataSource,
we reference the connection string that was added to our web.config when the model was added to the
project. In this recipe, the connection string is named EFRecipesEntities. In the EntityDataSource, we
provide the entity state name for our query. In this case, the entity set name is Customers.

The Where attribute and the nested WhereParameters define the filter for our query. The Where
attribute is set to a parameterized eSQL query. In the WhereParameters, we map the eSQL parameters to
controls on the page. We map the @Name parameter to the TextBox with the Name ID, the @City
parameter to the TextBox with the City ID, and the @State parameter to the TextBox with the State ID.

We use a ListView to display the results. The ListView is bound the EntityDataSource. In the
ItemTemplate for the ListView, we format each Customer entity from the EntityDataSource as a row in a
table. In the LayoutTemplate, we provide the placement of the items inside the well-formed table along
with the header row.

The code behind, shown in Listing 4-2, is used just to populate the database with some usable test
data. Here we do all the work in the Page_Load() event. We start off by deleting any rows that might be in
the database. Next, we populate the database with a few Customers.
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4.2. Building CRUD Operations in an ASP.NET Web Page

Problem

You want to build an ASP.NET page that allows inserting, updating, deleting, and reading from your
model.

Solution

Let’s say you have an application that manages the membership in a local club. You have a model like
the one in Figure 4-3.

2 Member S

= Properties
#4 Memberld
ﬁ]Name
5 Email

= Navigation Properties

Figure 4-3. A model with a Member entity that contains a member’s name and email address

The model contains a Member entity. You want to create a simple ASP.NET page shows all the club
members and allows the user to create a new member, update an existing member, and delete a
member. There are lots of ways to do this, but you want to use an EntityDataSource control to do as
much of the work declaratively as possible.

To create this page, we’ll need three basic parts. First, we'll need a way to show all the club
members. We'll use a ListView to do this. Next, we’ll need a way to populate the ListView will the club
member. We'll use an EntityDataSource for this. Finally, our club may grow large enough that we can’t
reasonably display all the members on a single web page. We will need a way to break up the display into
multiple pages. We’ll use a DataPager control to do this.

The code for the ASP.NET page is shown in Listing 4-3. We'll also need some code behind to handle
a few events. The code behind is shown in Listing 4-4.

Listing 4-3. The ASP.NET page with the three core parts: ListView, EntityDataSource, and DataPager

<body>
<form id="form1" runat="server">
<div style="font-size:larger; margin: 10px;">Manage Club Members</div>
<div>
<asp:Button ID="Insert" Text="Insert New Member" runat="server"
OnClick="InsertMember" />
<asp:ListView ID="memberslList" runat="server"
DataSourceID="membersDataSource"
DataKeyNames="MemberId" OnItemInserted="membersList_ItemInserted">
<LayoutTemplate>
<table>
<tr>
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<th colspan="2">&nbsp;</th>
<th>Name</th>
<th>Email</th>
</tr>
<tr id="itemPlaceholder" runat="server" />
</table>
</LayoutTemplate>
<ItemTemplate>
<tr>
<td><asp:LinkButton Text="Delete" CommandName="Delete"
Tunat="server" /></td>
<td><asp:LinkButton Text="Edit" CommandName="Edit"
Tunat="server" /></td>
<td><%# Eval("Name") %></td>
<td><%# Eval("Email™) %></td>
</tr>
</ItemTemplate>
<InsertItemTemplate>
<tr>
<td colspan="4">
<table>
<tr>
<td>Name:</td>
<td><asp:TextBox ID="Name" runat="server"
Text="<%# Bind("Name") %>' /></td>
</tr>
<tr>
<td>Email:</td>
<td><asp:TextBox ID="Email" runat="server"
Text="<%# Bind("Email") %»' /></td>
</tr>
<tr>
<td colspan="2">
<asp:Button Text="Insert" CommandName="Insert"
runat="server" />&nbsp;
<asp:Button Text="Cancel" CommandName="Cancel"
OnClick="CancelClick" runat="server" />
</td>
</tr>
</table>
</td>
</tr>
</InsertItemTemplate>

<EditItemTemplate>
<tr>
<td colspan="4">
<table>
<tr>
<td>Name:</td>
<td><asp:TextBox ID="Name" runat="server"
Text="'<%# Bind("Name") %>' /></td>
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</tr>
<tr>
<td>Email:</td>
<td><asp:TextBox ID="Email" runat="server"
Text="'<%# Bind("Email") %>' /></td>
</tr>
<tr>
<td colspan="2">
<asp:Button Text="Update" CommandName="Update"
runat="server" /> &nbsp;
<asp:Button Text="Cancel" CommandName="Cancel"
runat="server" />
</td>
</tr>
</table>
</td>
</tr>
</EditItemTemplate>
</asp:ListView>

<asp:EntityDataSource ID="membersDataSource" runat="server”
ConnectionString="name=EFRecipesEntities"”
DefaultContainerName="EFRecipesEntities"
EnableInsert="true" EnableUpdate="true" EnableDelete="true"
EntitySetName="Members" />

<asp:DataPager ID="Pager" runat="server" PagedControlID="membersList"
PageSize="2">
<Fields>
<asp:NumericPagerField ButtonCount="10" />
</Fields>
</asp:DataPager>
</div>
</form>
</body>

Listing 4-4. The code behind that handles the events for our ASP.NET page
public partial class Default : System.Web.UI.Page
{
protected void Page_Load(object sender, EventArgs e)
if (!Page.IsPostBack)
{
using (var context = new EFRecipesEntities())
context.ExecuteStoreCommand("delete from chapter4.Member");
context.Members.AddObject(new Member { Name = "Robert Dewey",
Email = "RobertD@gmail.com" });
context.Members.AddObject(new Member { Name = "Nancy Steward",

Email = "NSteward@AOL.com" });
context.Members.AddObject(new Member { Name = "Robin Rosen",
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Email = "RRosen@Regenix.com" });
context.SaveChanges();

}

protected void membersList_ItemInserted(object sender,
ListViewInsertedEventArgs e)

if (e.Exception == null)

membexsList.InsertItemPosition = InsertItemPosition.None;

}
}
protected void CancelClick(object sender, EventArgs e)
{
membersList.InsertItemPosition = InsertItemPosition.None;
}

protected void InsertMember(object sender, EventArgs e)

membersList.InsertItemPosition = InsertItemPosition.FirstItem;

The page in Listing 4-3 and the code in Listing 4-4 displays a page that lists the club members, along
with buttons for inserting new members as well as editing and deleting current members. The listing
page is shown in Figure 4-4. The insert page is shown in Figure 4-5. The edit page is shown in Figure 4-6.

x (B snagit B =

iz Favorites | 55 @ Suggested Sites ¥ & Get More Add-ons ~

& Entity Framework Recip... M- - [] g v Pagew

Manage Club Members
Insert New Member

Name Email
Delete Edit Robert Dewey RobertD(@gmail.com
Delete Edit Nancy Steward NSteward@AOL.com
12

€ Internet | Protected Mode: Off fg = ®IB% ~

Figure 4-4. The listing of the club members. The data pager at the bottom allows the user to move forward
and backward through the pages containing members.
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Figure 4-5. Inserting a new member. The TextBoxes allow the user to enter the member information.

Clicking the Insert button causes the new record to be added to the database.
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Figure 4-6. Clicking the Edit button on a member shows this view allowing editing of the member.
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How It Works

The code in Listing 4-3 can be broken up into three parts: the ListView that handles much of the user
interface, the EntityDataSource that handles connection to the model, and the DataPager that provides
paging for the members.

The ListView is the largest part of the code and is the heart of the user interface. In the ListView, we
use the DataSourcelD attribute to bind to the data from our model via the EntityDataSource. We use the
DataKeyNames attribute to indicate the MemberId property that contains the key for our Members. The
various templates allow us to provide the layout for the listing, editing, and inserting layouts.

The ItemTemplate provides our read-only, listing view of the members. Notice that we introduce
two buttons on each row. One button triggers editing of the member, and the other button triggers
deleting the member. The CommandName attributes for the buttons trigger the actions. If the user
clicks the Edit link button, the view is switched to the EdititemTemplate.

In the EditItemTemplate, we show a TextBox to edit the Name property and a TextBox to edit the
Email property. We use Bind() to retrieve the current value from the selected entity and push the
changed value to the property.

Just like with the EdititemTemplate, in the InsertitemTemplate we show a TextBox for the Name
property value and a TextBox for the Email property value. We also use Bind() to push the values to the
new Member entity.

The EntityDataSource control connects the model to the ListView control. In the EntityDataSource
control, we enabled inserting, deleting, and updating. The ConnectionString and EntitySetName
attributes bind this EntityDataSource control to our model and Members entity set within the model.

Finally, the DataPager control allows us to show a set number of members per page. This makes the
user interface much more manageable as the number of club members grows. Here we’ve limited a page
to just two members to keep things short.

The ListView control is tied to the EntityDataSource control through IDs. The ListView control’s
DataSourcelD is the EntityDataSource’s ID. The DataPager’s PagedControlID is the ID of the ListView.

There are a handful of events that we hand in the code behind in Listing 4-4. In the Page_Load()
event, we delete any previous data from the database and populate it with our initial test data. Of course,
you wouldn’t normally do this, but it makes it easy to demonstrate what’s going on. For the other events,
we revert back to the listing view when an insert is successful or when the user clicks Cancel. When the
Insert New Member button is clicked, we handle the event by showing in the InsertitemTemplate.

4-3. Executing Business Logic When Changes Are Saved

Problem

You are using an EntityDataSource control and you want to make sure that your business logic is
executed inside the SavingChanges event.

Solution

Let’s say our model looks something like the one in Figure 4-7.
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2 PurchaseOrder (%

= Properties
# OrderNumber
ﬁ:' CreateDate
= Company
ﬁ:' Amount

=l Navigation Properties

Figure 4-7. A model with a single PurchaseOrder entity

We have a purchase order with a company name and an amount. We want the CreateDate property
to be set automatically. To do this, we need to intercept the SavingChanges event and set the CreateDate
property to the current date and time if the entity is newly added. We want to do this while using an
EntityDataSource control on our page.

To do this, follow the pattern in Listings 4-5 and 4-6.

Listing 4-5. The code for the ASP.NET page that captures the Company name and Amount

<body>
<form id="form1" runat="server">
<div>
<asp:DetailsView ID="detailsView" runat="server"
AutoGenerateRows="false" DataSourceID="orderSource"
DefaultMode="Insert">
<Fields>
<asp:BoundField DataField="Company" HeaderText="Company" />
<asp:BoundField DataField="Amount" HeaderText="Amount" />
<asp:CommandField ShowInsertButton="true" />
</Fields>
</asp:DetailsView>

<asp:EntityDataSource ID="orderSource" runat="server"

ConnectionString="name=EFRecipesEntities"
ContextTypeName="Recipe3.EFRecipesEntities"
DefaultContainerName="EFRecipesEntities"”
EnableInsert="true" EntitySetName="PurchaseOrders" />

</div>

</form>

</body>

Listing 4-6. The code behind for the page
public partial class Default : System.Web.UI.Page

protected void Page_Load(object sender, EventArgs e)

{
}
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public partial class EFRecipesEntities
partial void OnContextCreated()
{ this.SavingChanges += (o, €) =>
var orders = this.ObjectStateManager
.GetObjectStateEntries(System.Data.EntityState.Added)

.Select(en => en.Entity as PurchaseOrder);
foreach (var order in orders)

order.CreateDate = DateTime.Now;

};

The resulting page is shown in a browser in Figure 4-8.

Recipe 3 - Windows Int

15[ [ x Jo ag

57 Favorites | 55 @& Suggested Sites * & | Get More Add-ons ~

@EntityFrameworkRecip... & B = Qé; v Page~

Company Moren Hightower, Inc.
Amount 129.95
Insert Cancel

& Internet | Protected Mode: Off
Figure 4-8. The simple input form used to capture the Company name and Amount

How It Works

In the code behind in Listing 4-6, we use the partial method OnContextCreated() to wire in our event
handler for the SavingChanges event. In our handler, we gather up all the PurchaseOrder entities that are
in the added state and assign the current date and time to the CreateDate property.
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4-4. Loading Related Entities

Problem

You are using EntityDataSource in your ASP.NET page and you want to load related entities.

Solution

Suppose you have a model like the one in Figure 4-9.

“#2 Order ES

¢ WebCustomer (2
= Properties
= Properties %% Orderld
@ﬁ] Customerld ﬁji—\mount
4 Name 1 * 57 OrderDate
=l Navigation Properties 7 Customerld
= Ord =l Navigation Properties
52 Orders
3_—1 WebCustomer

Figure 4-9. A model for a web customer and her orders

In our model, each web customer can have many orders. We want to use an EntityDataSource
control to load the orders and include the customer associated with each of the orders.

To eagerly load the customer associated with each order, use the Include attribute on the
EntityDataSource control, as illustrated in Listing 4-7.

Listing 4-7. The ASP.NET page to display our customer’s orders

<body>
<form id="form1" runat="server">
<div>
<asp:lListView ID="orderslist" runat="server" DataSourceId="orders">
<LayoutTemplate>
<table>
<tr>
<th>Name</th>
<th>Amount</th>
<th>OrderDate</th>
</tr>
<tr id="itemPlaceHolder" runat="server" />
</table>
</LayoutTemplate>
<ItemTemplate>
<tr>
<td><%# Eval("WebCustomer.Name") %></td>
<td><%# Eval("Amount") %></td>
<td><%tt Eval("OrderDate") %></td>

Nt
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</tr>
</ItemTemplate>
</asp:ListView>
<asp:EntityDataSource ID="orders" runat="server"
DefaultContainerName="EFRecipesEntities" Include="WebCustomer"
ConnectionString="name=EFRecipesEntities" EntitySetName="Orders" />
</div>
</form>
</body>

In the code behind in Listing 4-8, we handle the Page_Load event by deleting any previous test data
and populating the WebCustomers and Orders with fresh test data.

Listing 4-8. The code behind for our ASP.NET page
public partial class Default : System.Web.UI.Page

protected void Page_Load(object sender, EventArgs e)

{

using (var context = new EFRecipesEntities())

context.ExecuteStoreCommand("delete from chapter4.[order]");
context.ExecuteStoreCommand("“delete from chapter4.webcustomer”);
var custl = new WebCustomer { Name
var cust2 = new WebCustomer { Name = "Allen Colbert" };
var cust3 = new WebCustomer { Name = "Phil Marlowe" };
var orderl = new Order { Amount = 29.95M,

OrderDate = DateTime.Parse("3/18/2010") };
var order2 = new Order { Amount = 84.99M,

OrderDate = DateTime.Parse("3/20/2010") };
var order3 = new Order { Amount = 99.95M,

OrderDate = DateTime.Parse("4/10/2010") };
orderi.WebCustomer = custi;
order2.WebCustomer = cust2;
order3.WebCustomer = cust3;
context.Orders.AddObject(order1);
context.Orders.AddObject(order2);
context.0Orders.AddObject(order3);
context.SaveChanges();

"Joan Steward" };

The resulting page is shown in a browser in Figure 4-10.
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x (B snagit B E&f

77 Favorites | 95 (@ Suggested Sites * & Get More Add-ons ~

'_féEntityFrameworkRecip... & & =L géa v Page~

Name Amount OrderDate
Joan Steward 29.95  3/18/2010 12:00:00 AM
Allen Colbert 84.99  3/20/2010 12:00:00 AM
Phil Marlowe 99.95  4/10/2010 12:00:00 AM

& Internet | Protected Mode: Off

Figure 4-10. Web customers with their orders

How It Works

By default, Entity Framework does not load the related entities like our WebCustomer. To eagerly load
them when using an EntityDataSource control, use the Include attribute and provide the path through
the navigation properties of all the related entities you want loaded.

4-5, Searching with QueryExtender

Problem

You want to use a QueryExtender control with an EntityDataSource control to implement searching in
your ASP.NET page.

Solution

Suppose you have a model like the one in Figure 4-11.
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“  Supplier E “¢  Product E “¢  OrderDetail &
= Properties = Properties = Properties
#4 Supplierd # productld # OrderDetailld
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= Country 2 ProductDescripti.. | 1 * # UnitPrice
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#4 Categoryld 1 * %] OrderDetails
5 CategoryMame = supplier 1 0.1 | = Properties
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= products 5 UnitPrice
=l Navigation Properties
-5_—1 Product

Figure 4-11. A model for products, suppliers, and orders

In our model, a product has a supplier, is in a category, and may have some orders. We want to build
an ASP.NET page using an EntityDataSource control and a QueryExtender control to search our model
across these related entities.

The QueryExtender control provides a good deal of flexibility in formulating a search query. We
want to map TextBoxes for a number of properties to the QueryExtender control to build a query. We
want to display the results of the query in a grid. To do this, follow the pattern in Listing 4-9.

Listing 4-9. The ASP.NET search page

<body>
<form id="form1" runat="server"»
<div>
<table>

<tr>
<td>Name or Description</td>
<td><asp:TextBox ID="ProductName" runat="server" /></td>
</tr>
<tr>
<td>Discontinued</td>
<td>
<asp:DropDownList ID="Discontinued” runat="server">
<asp:ListItem Text="Al1l" Value="" />
<asp:ListItem Text="Yes" Value="true" />
<asp:ListItem Text="No" Value="false" />
</asp:DropDownList>
</td>
</tr>
<tr>
<td>Category</td>
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<td><asp:TextBox ID="CategoryName" runat="server" /></td>
</tr>
<tr>
<td>Units In Stock</td>
<td><asp:TextBox ID="UnitsInStock" runat="server" /></td>
</tr>
<tr>
<td>Price From</td>
<td><asp:TextBox ID="FromPrice" runat="server" /> &nbsp;&nbsp;
Price To <asp:TextBox ID="ToPrice" runat="server" />
</td>
</tr>
<tr>
<td>Supplier Country</td>
<td><asp:TextBox ID="SupplierCountry" runat="server" /></td>
</tr>
<tr>
<td>Total Sales</td>
<td><asp:TextBox ID="TotalSales" runat="server" /></td>
</tr>
<tr>
<td align="left" colspan="2" > <asp:Button ID="SearchButton"
Text="Search" runat="server" /></td>
</tr>
</table>

<asp:GridView ID="GridView1" runat="server" AllowPaging="true"
PageSize="50" AutoGenerateColumns="false" DataSourceID="DataSource">
<Columns>
<asp:BoundField DataField="ProductName" HeaderText="Product Name" />
<asp:BoundField DataField="ProductDescription"
HeaderText="Product Description" />
<asp:CheckBoxField DataField="Discontinued" HeaderText="Discontinued" />
<asp:TemplateField HeaderText="UnitPrice">
<ItemTemplate><%# Eval("ProductDetail.UnitPrice","{0:C}") %>
</ItemTemplate>
</asp:TemplateField>
<asp:TemplateField HeaderText="CategoryName">
<ItemTemplate><%# Eval("Category.CategoryName") %></ItemTemplate>
</asp:TemplateField>
<asp:BoundField DataField="UnitsInStock" HeaderText="Units In Stock" />
<asp:TemplateField HeaderText="Supplier Country">
<ItemTemplate><%# Eval("Supplier.Country") %></ItemTemplate>
</asp:TemplateField>
<asp:TemplateField HeaderText="Total Sales">
<ItemTemplate><%# Eval(“"TotalSales","{0:C}") %></ItemTemplate>
</asp:TemplateField>
</Columns>
</asp:Gridview>

<asp:EntityDataSource ID="DataSource" runat="server"
ConnectionString="name=EFRecipesEntities"
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Include="Category,ProductDetail,Supplier,OrderDetails"
DefaultContainerName="EFRecipesEntities"”
EnableFlattening="false" EntitySetName="Products" />

<asp:QueryExtender ID="QueryExtender1" runat="server"
TargetControlID="DataSource">
<asp:SearchExpression SearchType="Contains"
DataFields="ProductName,ProductDescription">
<asp:ControlParameter ControlID="ProductName" />
</asp:SearchExpression>
<asp:0rderByExpression DataField="UnitsInStock" Direction="Descending">
<asp:ThenBy DataField="ProductDetail.UnitPrice"
Direction="Ascending" />
</asp:0rderByExpression>
<asp:PropertyExpression>
<asp:ControlParameter Name="Discontinued" ControlID="Discontinued" />
<asp:ControlParameter Name="UnitsInStock" ControlID="UnitsInStock" />
<asp:ControlParameter Name="Supplier.Country"
ControlID="SupplierCountry" />
</asp:PropertyExpression>
<asp:RangeExpression DataField="ProductDetail.UnitPrice"
MinType="Inclusive" MaxType="Exclusive">
<asp:ControlParameter ControlID="FromPrice" />
<asp:ControlParameter ControlID="ToPrice" />
</asp:RangeExpression>
<asp:CustomExpression OnQuerying="ProductsWithCategory">
<asp:ControlParameter Name="CategoryName" ControlID="CategoryName" />
</asp:CustomExpression>
<asp:MethodExpression MethodName="ProductWithSalesGreaterThan">
<asp:ControlParameter Name="TotalSales" Type="Decimal"
ControlID="TotalSales" />
</asp:MethodExpression>
</asp:QueryExtender>
</div>
</form>

</body>
Listing 4-10. The code behind for our search page
public partial class Default : System.Web.UI.Page

protected void Page Load(object sender, EventArgs e)

{

using (var context = new EFRecipesEntities())

// cleanup from previous tests
context.ExecuteStoreCommand("delete from chapter4.productdetail®);
context.ExecuteStoreCommand("“delete from chapter4.orderdetail”);
context.ExecuteStoreCommand("delete from chapter4.product");
context.ExecuteStoreCommand("delete from chapter4.category");
context.ExecuteStoreCommand("delete from chapter4.supplier");

132



// add in our test data
new Supplier { CompanyName = "Backcountry Supply",
Country = "USA" };

var si =

var s2

var s3

var c1
var c2
var pdi
var pd2
var pd3
var pl =

var p2

var p3

var odl =
var od2 =
var od3 =

Rl AL L L

new Supplier { CompanyName = "Alpine Tent",

Country = "Italy" };

new Supplier { CompanyName = "Ace Footware",

Country = "USA" };

new Category { CategoryName = "Tents" };
new Category { CategoryName = "Shoes/Boots" };

new ProductDetail { UnitPrice
new ProductDetail { UnitPrice
new ProductDetail { UnitPrice

99.95M };
129.95M };
39.95M };

new Product { ProductName = "Pup Tent",

ProductDescription = "Small and packable tent",

Discontinued = true, UnitsInStock = 4 };
new Product { ProductName = "Trail Boot",

ProductDescription = "Perfect boot for hiking",
Discontinued = false, UnitsInStock = 19 };

new Product { ProductName = "Family Tent",

ProductDescription = "Sleeps 2 adults + 2 children",
Discontinued = false, UnitsInStock = 10 };
new OrderDetail { UnitPrice
new OrderDetail { UnitPrice
new OrderDetail { UnitPrice

pi.Supplier = s2;
pl.Category = c1;

pl.ProductDetail = pd3;
p1.0rderDetails.Add(od1);

p2.Supplier = s3;
p2.Category = c2;

p2.0rderDetails.Add(od2);
p2.ProductDetail = pd2;

p3.Supplier = si;
p3.Category = c1;

p3.ProductDetail = pdi;
p3.0rderDetails.Add(od3);

context.Products.AddObject(p1);
context.Products.AddObject(p2);
context.Products.AddObject(p3);

context.SaveChanges();

}

protected void ProductsWithCategory(object sender,

CustomExpressionEventArgs e)

if (e.Values[“CategoryName"] != null)

var catnames = e.Values["CategoryName"].ToString().Split(',");

e.Query = from p in e.Query.Cast<Product>()

where catnames.Contains(p.Category.CategoryName)

select p;

L L LB L A L T

39.95M, Quantity = 1};
129.95M, Quantity = 2 };
99.95M, Quantity = 1 };

Nt
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}

static public IQueryable<Product> ProductWithSalesGreaterThan(
IQueryable<Product> query,
decimal totalSales)

{
return from p in query
where p.OrderDetails
.Sum(od => od.UnitPrice * od.Quantity) > totalSales
select p;
}

}

public partial class Product

public decimal TotalSales

{
get

{

return this.OrderDetails.Sum(od => od.UnitPrice * od.Quantity);

The resulting search page is shown in Figure 4-12. The user can enter the search parameters in any
or all of the TextBoxes to filter the results displayed in the grid.
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Name or Description

Discontinued Al [~]

Category

Units In Stock

Price From Price To
Supplier Country

Total Sales

Units .
Product Prot?uc't Discontinued UnitPrice CategoryName In Supplier  Total
Name Description : Stock Country Sales

Trail  Perfect boot for $129.95 Shoes/Boots 19  USA $259.90
Boot hiking

Family  Sleeps 2 adults
Tent + 2 children $99.95  Tents 10 USA $99.95

Small and

Pup Tent packable tent $3995 Tents Italy $39.95

& Internet | Protected Mode: Off

Figure 4-12. The completed search page implemented with an EntityDataSource control and a
QueryExtender control

How It Works

The model is a little involved, and the code in Listings 4-9 and 4-10 seem to reflect this. Let’s break down
the ASP.NET page part by part.

The first part of Listing 4-9 is a table providing structure for the properties we want to use for
searching. There’s nothing too complex here, just a bunch of TextBoxes and a DropDownList formatted
in a table.

The next part is a GridView control. This provides the structure for the results. We bind the control
to the EntityDataSource control through the DataSourcelD attribute. The columns are mapped to
properties of the objects returned by the EntityDataSource control. This is not much different from the
binding we’ve seen in the previous recipes in this chapter. There is one difference to note here: we're
binding to a TotalSales property that is not present in our model. This property represents the total sales
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for the product. To get this value, we added a TotalSales property to the Product entity in the code
behind shown in Listing 4-10.

As with the previous recipes, we use the EntityDataSource control to load the data. We've use the
Include attribute to eagerly load the Category, ProductDetail, Supplier, and OrderDetails navigation
properties. This causes the related entities to be loaded along with each Product entity.

And finally, we have the QueryExtender control. This control provides the filtering that we need to
implement searching. We set the TargetControlID to the ID of the EntityDataSource control. This ties the
QueryExtender control to our EntityDataSource control. We are exercising quite a few expression types
in our QueryExtender control. Each of these is used to extend the query.

In the SearchExpression, we set the SearchType to Contains and map the DataFields to the
ProductName and ProductDescription properties. The expression will get its filter value from the
ProductName TextBox. When not empty, this expression will filter the result set to product’s that
contain the string in the ProductName TextBox in either the ProductName or ProductDescription
properties.

The OrderByExpression orders the result set first by UnitsInStock and then by UnitPrice.

The PropertyExpression filters the result set by the Discontinued, UnitsInStock, and the Supplier’s
country. The corresponding TextBoxes are mapped through their IDs.

The RangeExpression is used to filter the result set by a range of values for the UnitPrice property.
We denote this in our search TextBoxes with the Price From and Price To fields.

We use the CustomExpression to add on our own arbitrary query to the one built by the
QueryExtender control. We've implemented this in the ProductsWithCategory() method. Here we
additionally filter by products that are in the given category.

With the MethodExpression we use a method outside of our class to perform additional filtering.
The method is passed an IQueryable<Product> and a total sales threshold and returns an
IQueryable<Product> that filters by the threshold. This is implemented in Listing 4-10 in the
ProductWithSalesGreaterThan() method.

The result of all of this is the search page shown in Figure 4-12. Nearly all the logic is implemented
declaratively in the ASP.NET page.

4-6. Retrieving a Derived Type Using an
EntityDataSource Control

Problem

You want to load a derived type from your Table per Hierarchy inheritance model using an
EntityDataSource control.

Solution

Suppose you have a model like the one in Figure 4-13.
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2 Contact &

= Properties
@ﬁ Contactld
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= Contact = Contact
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5 Emnail 5! HireDate
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Figure 4-13. A model using Table per Hierarchy inheritance with derived types Customer and Employee

The model in Figure 4-13 uses Table per Hierarchy inheritance with Customer and Employee as
derived types. The discriminator values for the derived types are the strings “Customer” and
“Employee.”

To filter the result set to a specific derived type using an EntityDataSource control, name the type
using the EntityTypeFilter attribute. The code in Listings 4-11 and 4-12 illustrate retrieving both the
Employees and Customers using an EntityDataSource control. The resulting page is shown in Figure
4-14.

Listing 4-11. The ASP.NET page using an EntityDataSource to retrieve derived types

<body>
<form id="form1" runat="server"s
<div>
<h2>Employees</h2>
<asp:GridView ID="GridViewl" runat="server" DataSourceID="EmployeesSource"
AutoGenerateColumns="true" />
<asp:EntityDataSource ID="EmployeesSource" runat="server"
ConnectionString="name=EFRecipesEntities"
DefaultContainerName="EFRecipesEntities” EnableFlattening="false"
EntitySetName="Contacts" EntityTypeFilter="Employee" />

<h2>Customers</h2>

<asp:GridView ID="GridView2" runat="server" DataSourceID="CustomersSource"
AutoGenerateColumns="true" />

<asp:EntityDataSource ID="CustomersSource" runat="server"
ConnectionString="name=EFRecipesEntities"
DefaultContainerName="EFRecipesEntities"” EnableFlattening="false"
EntitySetName="Contacts" EntityTypeFilter="Customer" />

</div>
</form>

</body>
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Listing 4-12. The code behind for the page
protected void Page_Load(object sender, EventArgs e)
using (var context = new EFRecipesEntities())

// delete the previous test data
context.ExecuteStoreCommand("delete from chapter4.contact");

// insert some new test data
context.Contacts.AddObject(new Customer { Name = "Joan Ryan",

Email = "joanr@gmail.com" });
context.Contacts.AddObject(new Customer { Name = “"Robert Kelly",

Email = "rkelly@gmail.com" });
context.Contacts.AddObject(new Employee { Name = “"Karen Stanford",

HireDate = DateTime.Parse("1/21/2010")});
context.Contacts.AddObject(new Employee { Name = "Phil Marlowe",
HireDate = DateTime.Parse("2/12/2009") });

context.SaveChanges();

The resulting web page as rendered in a browser is shown in Figure 4-14.

x Esnagit B &

{\3 Favorites Y;:?, @ Suggested Sites ¥ & | Get More Add-ons ~

@ Entity Framework Recip... | - B -~ [ mm - Page~w
Employees
HireDate Contactld Name
1/21/2010 12:00:00 AM 3 Karen Stanford
2/12/2009 12:00:00 AM 4 Phil Marlowe
Customers
Email Contactld Name
joanr@gmail.com 1 Joan Ryan
rkelly(@gmail.com 2 Robert Kelly
& Internet | Protected Mode: OFf 3 v HIB% -

Figure 4-14. The web page showing the properties of the derived entities Employee and Customer
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How It Works

The code in Listing 4-11 for the ASP.NET page uses an EntityDataSource control to load instances of a
specific derived type and a GridView control to display the result set. We do this for the Employee
derived type and the Customer derived type.

The code behind in Listing 4-12 deletes the previous test data and populates the model with the new
test data. This is done in the Page_Load() event handler.

4-7. Filtering with ASP.NET’s URL Routing

Problem

You want to simplify the URLs on your site using a RouteTable and want to leverage these routes to filter
the result sets from an EntityDataSource control.

Solution

Suppose your model looks like the one in Figure 4-15.

: s Ttem E3
¢ MemCategory %
- = Properties
= Properties @4 Ttemld
@j:‘ ItemCategoryld : 5 Name
7 Name 1 F [temCategonyld
= I'javigation Properties = Navigation Properties
= Ttems = temCategory

Figure 4-15. A model for items and their categories

In Figure 4-15, we’ve modeled our products, represented here by the Item entity, together with their
categories. On a typical eCommerce website, we would show products by category. We want to avoid
exposing query strings like “/Product.aspx?Category=Tents” in our URLs. These cryptic URLs simplify
programming a little, but don’t help us much when it comes to search engine optimization. We would
rather have URLs that look more like “/Products/Tents”. We can get this more SEO-friendly URL
structure by using routing.

Routes are typically created in the Application_Start() event handler in Global.asax. The code in
Listing 4-13 illustrates adding a route for our Products.aspx page.

Listing 4-13. Adding the Route in Global.asax
protected void Application_Start(object sender, EventArgs e)

RouteTable.Routes.MapPageRoute("Products”, "Products/{category}",
"~/Products.aspx");
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In our Products.aspx, we use the category name bound to the “category” parameter in a
QueryExtender control as illustrated in Listing 4-14. We use the code behind in Listing 4-15 to clear out
any previous test data and populate our model with fresh test data. Figures 4-16 and 4-17 show the
rendered pages for categories Tents and Cooking Equipment.

Listing 4-14. The Products.aspx page that displays the products filtered by category

<body>
<form id="form1" runat="server">
<div>
<asp:Gridview ID="GridView1" runat="server" AutoGenerateColumns="false"
DataSourceID="itemSource">
<Columns>
<asp:BoundField DataField="Name" HeaderText="Product" />
<asp:TemplateField HeaderText="Category">
<ItemTemplate><%# Eval("ItemCategory.Name") %></ItemTemplate>
</asp:TemplateField>
</Columns>
</asp:Gridview>

<asp:EntityDataSource ID="itemSource" runat="server"
EntitySetName="Items" Include="ItemCategory"
ConnectionString="name=EFRecipesEntities"
DefaultContainerName="EFRecipesEntities" />
<asp:QueryExtender ID="search" TargetControlID="itemSource" runat="server">
<asp:PropertyExpression>
<asp:RouteParameter Name="ItemCategory.Name" RouteKey="category" />
</asp:PropertyExpression>
</asp:QueryExtender>
</div>
</form>
</body>

Listing 4-15. The code behind that populates the model with the test data
public partial class Products : System.Web.UI.Page

protected void Page_ Load(object sender, EventArgs e)

{

using (var context = new EFRecipesEntities())

// delete any previous test data
context.ExecuteStoreCommand("delete from chapterg.item");
context.ExecuteStoreCommand("delete from chapter4.itemcategory");

// populate with some test data

var catl = new ItemCategory { Name = "Tents" };

var cat2 = new ItemCategory { Name = "Cooking Equipment" };

context.Items.AddObject(new Item { Name = "Backpacking Tent",
ItemCategory = catl });

context.Items.AddObject(new Item { Name = "Camp Stove",
ItemCategory = cat2 });
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context.Items.AddObject(new Item { Name = "Dutch Oven",
ItemCategory = cat2 });
context.Items.AddObject(new Item { Name = "Alpine Tent",
ItemCategory = catl });
context.Items.AddObject(new Item { Name = "Fire Starter”,
ItemCategory = cat2 });
context.SaveChanges();

.ﬂ:f_ﬁmﬁ— - | O x

o9 P SEEE

% (& Snagit H S

77 Favorites | 55 (@ Suggested Sites * & Get Mor: -ons ¥
] »
| /& Entity Framework Recipes - Recipe 7 | & = v [ mm v Page~ Safetyr Tools~ @v

Product Category
Backpacking Tent Tents
Alpine Tent Tents

Tents Category

& Internet | Protected Mode: Off

Figure 4-16. Using the route /Products/Tents, the result set is filtered to the “Tents” category.
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Product Category \
Camp Stove Cooking Equipment
Dutch Oven Cooking Equipment
Fire Starter Cooking Equipment

Cooking Equipment Category

Done & Internet | Protected Mode: Off

Figure 4-17. Using the route /Products/Cooking Equipment, the result set is filtered to the “Cooking
Equipment” category.
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How It Works

In the Application_Start() event handler in Global.asax, we mapped the route /Products/{category} to
the ~/Products.aspx page. The route key, category, is bound to the actual category string in the URL. In
the QueryExtender control in Products.aspx, we used the category route key in a RouteParameter to filter
the result set to just those products in the given category.

If you need more control over the filtering or don’t want to use a QueryExtender control, you can
use the OnQueryCreated attribute on the EntityDataSource control to inject your own filter on the result
set.

In Listings 4-16 and 4-17, we have the same GridView as in Listing 4-14, but we have replaced the
QueryExtender control with our own OnQueryCreated handler.

Listing 4-16. The same products page but without the QueryExtender control

<body>
<form id="form1" runat="server">
<div>
<asp:GridView ID="GridViewl" runat="server" AutoGenerateColumns="false"
DataSourceID="itemSource">
<Columns>
<asp:BoundField DataField="Name" HeaderText="Product" />
<asp:TemplateField HeaderText="Category">
<ItemTemplate><%# Eval("ItemCategory.Name") %></ItemTemplate>
</asp:TemplateField>
</Columns>
</asp:Gridviews

<asp:EntityDataSource ID="itemSource" runat="server" EntitySetName="Items"
Include="ItemCategory” ConnectionString="name=EFRecipesEntities"
DefaultContainerName="EFRecipesEntities"
OnQueryCreated="ProdFilter" />
</div>
</form>

</body>
Listing 4-17. The OnQueryCreated event handler in our code behind for our alternate products page

protected void ProdFilter(object sender, QueryCreatedEventArgs e)

{
var catvalue = (string)Page.RouteData.Values["category"];
e.Query = from p in e.Query.Cast<Item>()
where p.ItemCategory.Name == catvalue
select p;
}

The resulting pages look just like the ones in Figures 4-16 and 4-17. The only difference is that we
have more control of the filtering and don’t need to use a QueryExtender control.
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4-8. Building CRUD Operations with an
ObjectDataSource Control

Problem

You want to build an ASP.NET page that allows inserting, updating, deleting, and reading from your
model using an ObjectDataSource control.

Solution

Suppose you have a model like the one in Figure 4-18.

“¢  Reservation %
“¢ Hotel ES = Properties
#4 Reservationld
= Properties ﬁ] ReservationDate
#4 Hotelld 5 Rate
4 Name 1 * | B Hotelld
=l Navigation Properties ﬁ:‘TimeStamp
3_—1 Reservations 57 Name
=l Navigation Properties
3_—1 Hotel

Figure 4-18. A model for hotel reservations

Our model represents hotels and their reservations. We want to use an ObjectDataSource control to
perform inserts, updates, deletes, and, of course, select operations against this model. To do this, we first
need to create a couple of objects that will serve as the sources of our data. We loosely follow the
Repository Pattern in Listing 4-18 in building these objects.

Listing 4-18. Our HotelRepository and ReservationRepository classes
public class HotelRepository

private EFRecipesEntities context;

public HotelRepository()

this.context = new EFRecipesEntities();

}
public void Dispose()
{
this.context.Dispose();
}
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public List<Hotel> GetHotels()

return this.context.Hotels.OrderBy(h => h.Name).ToList();
}
}

public class ReservationRepository

{
private EFRecipesEntities context;
public ReservationRepository()

this.context = new EFRecipesEntities();

}
public void Dispose()
{
this.context.Dispose();
}

public List<Reservation> GetReservations(string sort,
int startRowIndex, int maximumRows)

return this.context.Reservations.Include("Hotel")
.OrderBy("it." + (sort == string.Empty ? "Name" : sort))
.Skip(startRowIndex).Take(maximumRows).ToList();

}
public int ReservationCount()
{
return this.context.Reservations.Count();
}

public void Insert(Reservation reservation)

this.context.Reservations.AddObject(reservation);
context.SaveChanges();

}

public void Update(Reservation reservation)

{
this.context.Reservations.Attach(reservation);
this.context.ObjectStateManager

.ChangeObjectState(reservation, EntityState.Modified);

this.context.SaveChanges();

}

public void Delete(Reservation reservation)

this.context.Reservations.Attach(reservation);
this.context.Reservations.DeleteObject(reservation);
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this.context.SaveChanges();

}

Once we have the object that will supply our data, we can construct the ASP.NET page that uses the
ObjectDataSource control to perform the inserts, update, deletes, and selection of the data. This page is
shown in Listing 4-19. The code behind for the page is shown in Listing 4-20.

Listing 4-19. The ASP.NET page using the ObjectDataSource control

<body>
<form id="form1" runat="server"s
<div>
<asp:ListView ID="reservationList" runat="server"
DataSourceld="reservationSource" DataKeyNames="ReservationId,TimeStamp"
InsertItemPosition="LastItem">
<EditTItemTemplate>
<tr>
<td>
<asp:Button runat="server" CommandName="Update" Text="Update" />
<asp:Button runat="server" CommandName="Cancel" Text="Cancel" />
</td>
<td>
<asp:TextBox ID="nameTextBox" runat="server"
Text="<%# Bind("Name") %>' />
</td>
<td>
<asp:DropDownList ID="hotel" runat="server"
AppendDataBoundItems="true"
SelectedValue = '<%# Bind("HotelId") %>"
DataSourceID="HotelSource" DataTextField="Name"
DataValueField="HotelId">
<asp:ListItem Text="Select" Value="" />
</asp:DropDownlList>
<asp:0ObjectDataSource ID="hotelSource" runat="server"
TypeName="Recipe8.HotelRepository"”
SelectMethod="GetHotels" />
</td>
<td>
<asp:TextBox ID="ResDateTextBox" runat="server"
Text="<%# Bind("ReservationDate") %>' />
</td>
<td>
<asp:TextBox ID="RateTextBox" runat="server"
Text="<%# Bind("Rate") %>' />
</td>
</tr>
</EditItemTemplate>
<InsertItemTemplate>
<tr>
<td>
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<asp:Button runat="server" CommandName="Insert" Text="Insert" />
<asp:Button runat="server" CommandName="Cancel" Text="Cancel" />
</td>
<td>
<asp:TextBox ID="nameTextBox" runat="server"
Text="<%# Bind("Name") %>' />
</td>
<td>
<asp:DropDownlList ID="hotel" runat="server"
AppendDataBoundItems="true"
Selectedvalue='<%# Bind("HotelId") %>’
DataSourceID="hotelSource"
DataTextField="Name" DataValueField="HotelId">
<asp:ListItem Text="Select" Value="" />
</asp:DropDownlList>
<asp:0bjectDataSource ID="hotelSource" runat="server"
TypeName="Recipe8.HotelRepository" SelectMethod="GetHotels" />
</td>
<td>
<asp:TextBox ID="ResDateTextBox" runat="server"
Text="<%# Bind("ReservationDate") %>' />
</td>
<td>
<asp:TextBox ID="RateTextBox" runat="server"
Text="<%# Bind("Rate") %' />
</td>
</tr>
</InsertItemTemplate>
<ItemTemplate>
<tr>
<td>
<asp:Button runat="server" CommandName="Delete" Text="Delete" />
<asp:Button runat="server" CommandName="Edit" Text="Edit" />
</td>
<td><%# Eval("Name") %></td>
<td><%# Eval("Hotel.Name") %></td>
<td><%# Eval("ReservationDate") %»></td>
<td><%# Eval("Rate") %></td>
</tr>
</ItemTemplate>
<LayoutTemplate>
<table>
<tr>
<th></th>
<th>
<asp:LinkButton runat="server" CommandName="Sort"
CommandArgument="Name" Text="Name" />
</th>
<th>
<asp:LinkButton runat="server" CommandName="Sort"
CommandArgument="Hotel.Name" Text="Hotel" />
</th>
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<th>
<asp:LinkButton runat="server" CommandName="Sort"
CommandArgument="ReservationDate" Text="Reservation Date" />
</th>
<th>
<asp:LinkButton runat="server" CommandName="Sort"
CommandArgument="Rate" Text="Daily Rate" />
</th>
</tr>
<tr ID="itemPlaceholder" runat="server" />
</table>
</LayoutTemplate>
</asp:ListView>
<asp:DataPager ID="pager" runat="server"
PagedControlID="reservationList" PageSize="2">
<Fields>
<asp:NumericPagerField />
</Fields>
</asp:DataPager>
<asp:0bjectDataSource ID="reservationSource" runat="server"
DataObjectTypeName="Recipe8.Reservation"
DeleteMethod="Delete" InsertMethod="Insert"
SelectMethod="GetReservations" UpdateMethod="Update"
EnablePaging="true" SortParameterName="sort"
SelectCountMethod="ReservationCount”
TypeName="Recipe8.ReservationRepository" />
</div>
</form>

</body>

Listing 4-20. The code behind for the page in Listing 4-19

public partial class Default : System.Web.UI.Page
protected void Page Load(object sender, EventArgs e)

if (!this.IsPostBack)
{

using (var context = new EFRecipesEntities())

// delete all test data
context.ExecuteStoreCommand("delete from chapter4.reservation”);
context.ExecuteStoreCommand("“delete from chapter4.hotel");

// insert new test data
var hi = new Hotel { Name = "Riverside Inn" };
var h2 = new Hotel { Name = "Greenville Inn" };
context.Reservations.AddObject(new Reservation {
Name = "Robin Rosen",
ReservationDate = DateTime.Parse("4/20/2010"),
Rate = 99.95M, Hotel = h1 });
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context.Reservations.AddObject(new Reservation {
Name = "James Marlowe",
ReservationDate = DateTime.Parse("5/18/2010"),
Rate = 105.00M, Hotel = h2 });
context.SaveChanges();

€ | http://localhost:1060/Default.aspx v | & | 42| X > 8ing P~
E snagit B 1
507 Favorites | 55 (@ Suggested Sites v & | Get More Add-ons ~
& Entity Framewark Recipes - Recipe 8 i~ B v ®mm v Pagev Safetyv Tookw @+
Name Hotel Reservation Date Daily Rate
Delste | | Edit | James Marlowe Greenville Inn  5/18/2010 12:00:00 AM 105.00
Delete | [ Edit | Robin Rosen Riverside Inn  4/20/2010 12:00:00 AM 99.95
Insert | | Cancel Select [~]
1
€ Intemet | Protected Mode: Off fa v H1B% ~

Figure 4-19. The page supporting inserts, updates, deletes, and listing

How It Works

Part of the solution is the two classes, HotelRepository and ReservationRepository, which provide the
needed operations on the underlying entities. These classes very roughly follow the widely used
Repository Pattern. Our ObjectDataSource control uses these two classes to perform the CRUD
operations. The bulk of the code in the ASP.NET page is used in the ListView control for InsertTemplate,
EditTemplate, and LayoutTemplate.

It is important to note here that the startRowIndex and maximumRows parameters to the
ReservationRepository’s GetReservations() method are not arbitrary names. These are the default
parameter names used by the ObjectDataSource control for paging. If you need to use different
parameter names, these must be specified in the definition of the ObjectDataSource control using the
StartRowIndexParameterName and MaximumRowsParameterName attributes. For the Reservation
entity we use both the Reservationld and TimeStamp properties to avoid a concurrency violation on
updates. We set both Reservationld and TimeStamp as DataKeyNames for the ListView. On post back,
the ListView control saves the keys in the control state to preserve the original values. On update, the
ObjectDataSource control gets the new values from the Bind() parameters and the original
Reservationld and TimeStamp values from the ListView control.

In the Update() method of the ReservationRepository, we Attach() the reservation and then change
its status using the ChangeObjectStatus() method. The drawback to this approach is that we end up
marking all the scalar properties except the entity key and the currency column, as modified. All these
properties changed or not, will be part of the update statement. Because our model uses foreign key
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associations, when we change the Hotelld property for a reservation, we are also changing the
association to the hotel as well.

The Delete() method also uses Attach() and ChangeObjectState() to change the state of the object
to Deleted. For this, we need only the entity key.

4-9, Using Entity Framework With MVC

Problem
You want to use Entity Framework with ASP.NET MVC.

Solution

Suppose you have a table in your database like the one shown in Figure 4-20.

Movie (Chapter4)
% Movield
Title
Director
Budget

Figure 4-20. A table with some information about a movie

This table holds some information about movies. You want to create a simple ASP.NET MVC web
application that uses Entity Framework. To create a web application that provides for inserting,
updating, and deleting movies in our Movie table, do the following:

1. Add anewASP.NET MVC 2 Empty Web Application to your solution.

2. Right-click the Models folder and select Add » New Item. Add an ADO.NET
Entity Data Model. Import the movie table in Figure 4-20. The model should
look like the one in Figure 4-21.

3. Right-click the Controllers folder and select Add » Controller. Name the new
controller HomeController. Check the box: Add action methods for Create,
Update, and Details scenarios. Click Add.

4. Add a private variable to the HomeController to hold the context:
private EFRecipesEntities context = new EFRecipesEntities();

5. Change the Index() method in the HomeController to return the list of movies.
Use the following code:

public ActionResult Index()

return View(context.Movies.TolList());
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Right-click the Index() method and select Add » View. Uncheck Select master
page. Select Movie for the view data class and List as the content. See Figure 4-
22.

Change the Details() method in the HomeController to return a single movie
based on the Movield. Use the following code:

public ActionResult Details(int id)
{

10.

11.

var movie = context.Movies.Single(m => m.Movield == id);
return View(movie);

Right-click the Details() method and select Add » View. Set the view data
class to Movie and the view content to Details. See Figure 4-23.

Right-click the Create() method and select Add > View. Set the view data class
to Movie and the view content to Create. See Figure 4-24.

Use the code in Listing 4-21 to replace the code for the overloaded Create()
method that takes a FormCollection. This is the method that is decorated with
the HttpPost attribute.

Change the Edit() method in the HomeController to return a single movie
based on the id. Use the following code:

public ActionResult Edit(int id)

{

12.

13.

14.

15.

16.

var movie = context.Movies.Single(m => m.Movield == id);
return View(movie);

Right-click the Edit() method and select Add » View. Set the view data class to
Movie and view content to Edit. See Figure 4-25.

The second Edit() method that takes a FormsCollection is called when the
user has modified the movie’s properties and has submitted the form to the
server. Use the code in Listing 4-22 to replace the code for this second Edit()
method.

We need to add a Delete button to the Index.aspx page in the Views » Home
folder. Use the code in Listing 4-23 to add this button next to the Edit link.

Add aDelete() method to handle the Delete button click. Use the code in
Listing 4-24 to implement the Delete() method in HomeController.cs file.

Run the web application and add a few movies. After you have added a few
movies, the web application should look something like the one shown in
Figure 4-26.
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Figure 4-21. The model created from the Movie table

Add View

View name:

Index
[[] Createa partial view (.ascx)
Create a strongly-typed view
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Figure 4-22. Adding a view for the Index() method

Add View

View name:
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[ Create a partial view (.ascx)
Create a strongly-typed view

View data class:
Reciped.Models.Movie

View content:
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ContentPlaceHolder ID:
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Figure 4-23. Adding a view for theDetails() method
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Add View

View name:

Create
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View data class:
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Figure 4-24. Adding a view for the Create() method
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Figure 4-25. Adding a view for the Edit() method
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Listing 4-21. The code for the second Create() method that handles posts

[HttpPost]
public ActionResult Create([Bind(Exclude = "MovieId")] Movie movie)

{
try

context.Movies.AddObject(movie);
context.SaveChanges();
return RedirectToAction("Index");

catch

return View();

}
Listing 4-22. The code for the second Edit() method that handles posts

[HttpPost]
public ActionResult Edit(int id, Movie movie)

{
try

{
movie.Movield = id;
context.Movies.Attach(movie);
context.ObjectStateManager.ChangeObjectState(movie,
EntityState.Modified);
context.SaveChanges();
return RedirectToAction("Index");

catch

return View();

}
Listing 4-23. Adding the Delete button to the Index.aspx page

<td>
<% using (Html.BeginForm("Delete", "Home", new { id = item.Movield }))
{ % <input type="submit" value="Delete" /> <% } %>
</td>

Listing 4-24. TheDelete() method that handles the Delete button click

[AcceptVerbs(HttpVerbs.Post)]
public ActionResult Delete(int id)

{
try

{
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var movie = new Movie { Movield = id };
context.Movies.Attach(movie);
context.Movies.DeleteObject(movie);
context.SaveChanges();

return RedirectToAction("Index");

}
catch

return View();

}
/& Index - Windows Internet Explorer | = | = 2 |
@u - |g. http://localhost:1137/ v| ] | "?| A | |b Bing P -
x (B snagit B E&f
57 Favorites | 55 @& Suggested Sites * & | Get More Add-ons ~
I@Index | il B ~-= EEA * Page~ Safety> Tools~ l@lv >
Movield Title Director Budget
Edit | Details 3 Star Wars: Episode 1 George Lucas  52000000.00
Edit | Details 4 Titanic James Cameron 34000000.00
Edit | Details 5 Spider-Man Sam Raimi 28000000.00
Edit | Details 6 Finding Nemo Andrew Stanton 51000000.00
Create New
Done & Internet | Protected Mode: Off i v H1B% v

Figure 4-26. The rendered Index.aspx page with a few movies from our database

How It Works

We created a very simple ASP.NET MVC web application that uses the Entity Framework model in Figure
4-21 that we created by importing the database table in Figure 4-20. The web application lists the current
movies and supports editing, creating, and deleting movies from the database.
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CHAPTER S

Loading Entities and
Navigation Properties

Entity Framework provides a rich modeling environment representing a conceptual view of the
underlying objects and relationships in data storage. The recipes in this chapter show you how to control
the loading of instances of related entities in your queries.

The default behavior for Entity Framework is to load only the entities directly accessed by your
application. In general, this is exactly what you want. If Entity Framework aggressively loaded all the
entities related through one or more associations, you would likely end up loading more entities than
you needed. This would increase the memory footprint of your application and slow it down.

In Entity Framework, you can control when the loading of related entities occurs and optimize the
number of database queries executed. Carefully managing when related entities are loaded can increase
performance and simplify your code.

We start off this chapter with a number of recipes illustrating how to load some or all of the related
entities in a single query. This type of loading, also called eager loading, is used to both reduce the
number of round trips to the database and to more precisely control which related entities are loaded.

Sometimes you need to defer loading of certain related entities because they may be expensive to
load or are not used very often. We'll cover a number of scenarios using the Load() method to precisely
control when to load one or more related entities.

5-1. Loading Related Entities

Problem

You want to load an entity along with some related entities in a single round trip to the database.

Solution

Let’s say you have a model like the one shown in Figure 5-1.
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Figure 5-1. A model with a Customer and its related information

In this model, we have a Customer entity with a single CustomerType and perhaps many
CustomerEmail addresses. The association with CustomerType is one-to-many with CustomerType on
the one side of the association. This is an entity reference.

The association with CustomerEmail is also one-to-many but with CustomerEmail on the many side
of the association. This is an entity collection.

To include all the instances of the related CustomerEmail entity as well as the instance of the related
CustomerType entity when retrieving instances of the Customer entity, use the Include() method syntax
as shown in Listing 5-1.

Listing 5-1. Eager loading of instances of Customertype and Customeremail along with instances of
Customer

using (var context = new EFRecipesEntities())

var web = new CustomerType { Description = "Web Customer”,
CustomerTypeld = 1 };
var retail = new CustomerType { Description = "Retail Customer",
CustomerTypeld = 2 };

var customer = new Customer { Name = "Joan Smith", CustomerType = web };
customer.CustomerEmails.Add(new CustomerEmail

{ Email = "jsmith@gmail.com" });
customer.CustomerEmails.Add(new CustomerEmail { Email = "joan@smith.com" });
context.Customers.AddObject(customer);
customer = new Customer { Name = "Bill Meyers", CustomerType = retail };
customer.CustomerEmails.Add(new CustomerEmail

{ Email = "bmeyers@gmail.com" });
context.Customers.AddObject (customer);
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

var customers = context.Customers.Include("CustomerType")
.Include("CustomerEmails");

Console.WriteLine("Customers");

Console.WriteLine("=========");

foreach (var customer in customers)
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Console.WriteLine("{0} is a {1}, email address(es)", customer.Name,
customer.CustomerType.Description);
foreach (var email in customer.CustomerEmails)

{
}

Console.WriteLine("\t{0}", email.Email);

}

using (var context = new EFRecipesEntities())

var customTypes = context.CustomexTypes.Include("Customers.CustomerEmails");
Console.WriteLine("\nCustomers by Type");

Console.WriteLine(" ");

foreach (var customerType in customTypes)

{

Console.WriteLine("Customer type: {0}", customerType.Description);
foreach (var customer in customerType.Customers)

{
Console.WriteLine("{0}", customer.Name);
foreach (var email in customer.CustomerEmails)

Console.WriteLine("\t{0}", email.Email);

}

The output of the code in Listing 5-1 is the following:

Customers

Joan Smith is a Web Customer, email address(es)
jsmith@gmail.com
joan@smith.com

Bill Meyers is a Retail Customer, email address(es)

bmeyers@gmail.com

Customers by Type
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Customer type: Web Customer
Joan Smith
jsmith@gmail.com
joan@smith.com
Customer type: Retail Customer
Bill Meyers

bmeyers@gmail.com

How It Works

By default, Entity Framework loads only entities that you specifically request. This is an important
principle to keep in mind. The alternative, always loading every associated entity, may cause a much
larger part of the object graph to be loaded into memory than you might need.

In this example, we used the Include() method to eagerly load the related parts of the object graph.
Include() takes a string representation of the part of the object graph you want to load. This string
representation of the partial object graph is also called a path and is made of the navigation property
names separated by the ‘.” character.

In Listing 5-1, we create a couple of instances of the CustomerType entity and use these together
with instances of the CustomerEmail entity to create a couple of Customers.

To get the object graph from the Customer, we use the Include() method twice. In the first use, we
include the entity reference to the CustomerType entity. This is on the one side of the one-to-many
association. In the second use of Include(), we get the many side of the one-to-many association
bringing along all the instances of the CustomerEmail entity for the customer. By using the Include()
method twice, we pull in all the referenced entities from both of the Customer’s navigation properties.

To get the object graph from the CustomerType, we invoke Include() just once, but this time we
pass in a path that includes both the Customers and the CustomerEmails.

Both of these queries resulted in a load of the entire object graph into the object context. In our
example, this wasn’t much, but for databases with thousands or millions of customers, we could end up
using lots of memory if we’re not careful.

The Include() method has some important performance implications. On the one hand, loading a
large part of the object graph into the object context (that is, into memory), can end up using a lot of
memory. If we had millions of customers, this would definitely be a problem. On the other hand, the
Include() method loads the object graph in one trip to the database. If your application will end up
loading each entity in the graph separately, requiring lots of trips to the database, you may end up with a
lot less database traffic with the use of the Include() method.

There is one more performance issue. To get everything in one trip to the database, Entity
Framework might construct a rather unwieldy SQL statement with lots of joins. The SQL statement from
our first query is shown in Listing 5-2. Not only is the query getting a little complicated but it’s also
bringing back duplicate information, as shown in Figure 5-2. When materializing the object graph, Entity
Framework has to remove the duplicate information.
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The bottom line is that Include(), used carefully, can improve performance over piecemeal loading
of the entities. Keep in mind the extra memory footprint and the extra work done at the database layer
and in Entity Framework.

Listing 5-2. The SQL query resulting from our use of the Include() method

SELECT

Project1].[CustomerId] AS [CustomerId],

Project1].[Name] AS [Name],

[Project1].[CustomerTypeld] AS [CustomerTypeId],

Project1].[CustomerTypeIdi] AS [CustomerTypeIdi],

Project1].[Description] AS [Description],

Project1].[C1] AS [C1],

Project1].[CustomerEmailld] AS [CustomerEmailld],

Project1].[CustomerIdi] AS [CustomerIdi],

Project1].[Email] AS [Email]

FROM ( SELECT
[Extent1].[CustomerId] AS [CustomerId],
[Extent1].[Name] AS [Name],
[Extent1].[CustomerTypeId] AS [CustomerTypeld],
[Extent2].[CustomerTypeld] AS [CustomerTypeIdi],
[Extent2].[Description] AS [Description],
[Extent3].[CustomerEmailId] AS [CustomerEmailld],
[Extent3].[CustomerId] AS [CustomerIdi],
[Extent3].[Email] AS [Email],
CASE WHEN ([Extent3].[CustomerEmailId] IS NULL) THEN CAST(NULL AS int) ELSE 1 END AS

[C1]

FROM  [Chapter5].[Customer] AS [Extent1]

LEFT OUTER JOIN [Chapter5].[CustomerType] AS [Extent2] ON [Extenti].[CustomerTypeld] =
[Extent2]. [CustomerTypeld]

LEFT OUTER JOIN [Chapter5].[CustomerEmail] AS [Extent3] ON [Extent1].[CustomerId] =
[Extent3].[CustomerId]
) AS [Projecti]
ORDER BY [Projecti].[CustomerId] ASC, [Projecti].[CustomerTypeId1i] ASC, [Project1].[C1] ASC

[ Results _'_:1 Messages
Customerld ~ Name CustomerTypeld  CustomerTypeld1  Description C1 CustomerEmailld  Customerld1  Email
Joan Smith 1 1 Web Customer 1 51 M jsmith@gmail.com
Joan Smith 1 1 Web Customer 1 52 M joan@smith.com
35 Bill Meyers 2 2 Retail Customer 1 53 35 bmeyers@gmail.com

Figure 5-2. Redundant data resulting from the Include() method
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5-2. Loading a Complete Object Graph

Problem

You have a model with several related entities and you want to load the complete object graph of all the
instances of each entity in a single query.

Solution

Suppose you have a conceptual model like the one in Figure 5-3. Each course has several sections. Each
section is taught by an instructor and has several students.

s Section %
“¢ Course ES = Properties “¢  Student ES
#4 Sectionld
= Properties P Instructorld = Properties
#4 Courseld 2 Courseld ¥ Studentld
' Title 1 = MNavigation Properties " " 7 Name
=l Navigation Properties & course =l Navigation Properties
3_—1 Sections 3_—1 Instructor 3_—1 Sections

3_—1 Students
w
i1
“¢  Instructor %
= Properties
# Instructorld
ﬁ]Name

=l Navigation Properties

3_—1 Sections

Figure 5-3. A model with a few related entities

To retrieve all the courses, sections, instructors, and students represented in the database in a single
query, use the Include() method with a query path parameter, as shown in Listing 5-3.

Listing 5-3. Retrieving an entire object graph in a single query
using (var context = new EFRecipesEntities())
var course = new Course { Title = "Biology 101" };
var fred = new Instructor { Name = "Fred Jones" };

var julia = new Instructor { Name = "Julia Canfield" };
var sectionl = new Section { Course = course, Instructor = fred };
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var section2 = new Section { Course = course, Instructor = julia };
var jim = new Student { Name = "Jim Roberts" };
jim.Sections.Add(section1);

var jerry = new Student { Name = "Jerry Jones" };
jerry.Sections.Add(section2);
var susan = new Student { Name
susan.Sections.Add(section1);
var cathy = new Student { Name
cathy.Sections.Add(section2);
context.Courses.AddObject(course);
context.SaveChanges();

"Susan 0'Reilly" };

"Cathy Ryan" };

}
using (var context = new EFRecipesEntities())

var graph = context.Courses
.Include("Sections.Instructor")
.Include("Sections.Students");

Console.WriteLine("Courses");

Console.WriteLine("=======");

foreach (var course in graph)

Console.WriteLine("{0}", course.Title);
foreach (var section in course.Sections)

Console.WriteLine("\tSection: {0}, Instrutor: {1}",
section.SectionId.ToString(),
section.Instructor.Name);

Console.WriteLine("\tStudents:");

foreach (var student in section.Students)

{
Console.WriteLine("\t\t{0}", student.Name);

Console.WriteLine("\n");

}
}
}
The code in Listing 5-3 produces the following output:
Courses

Biology 101
Section: 7, Instructor: Fred Jones

Students:
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Susan 0'Reilly

Jim Roberts

Section: 8, Instructor: Julia Canfield
Students:
Cathy Ryan

Jerry Jones

How It Works

A query path is a string parameter to the Include() method. A query path represents the entire path of
the object graph that is loaded by the Include() method. The Include() method extends the query to
include the entities referenced along the query path.

In Listing 5-3, we use the Include() method twice. Include() is invoked first with a query path
parameter that includes the part of the graph extending through Section to Instructor. This modifies the
query to include all the Sections and their Instructors. The second invocation includes a path extending
through Section to Student. This modifies the query to include Sections and their Students. The result is
a materialization of the complete object graph including all the Course entities and the entities on each
end of all associations in the model.

You can use query paths that use navigation properties to any depth. This gives you a lot of
flexibility in partial or complete object graph loading. Entity Framework attempts to optimize the final
query generation by pruning off overlapping or duplicate query paths.

The syntax and semantics of the Include() method is deceptively simple. Don’t let the simplicity
fool you into thinking that there is no performance price to be paid when using the Include() method.
Eager loading with several Include() method invocations can rapidly increase the complexity of the
query sent to the database and dramatically increase the amount of data returned from the database.
The complex queries generated can lead to poor performance plan generation and the large amount of
returned data can cause Entity Framework to spend an inordinate amount of time removing duplicate
data.

5-3. Loading Navigation Properties on Derived Types

Problem

You have a model with one or more derived types that are in a has-a relationship with one or more other
entities. You want to eagerly load all the related entities in one round trip to the database.
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Solution

Suppose you have a model like the one in Figure 5-4.

“¢  Location ES

- 2 Tradesman ES
“#2 Phone ES
= M = Properties
@ﬁ;] Locationld ~ M @j‘ Tradesmanld
ﬁ\‘;—\.ddress # Phoneld 5 Name
g;iti * 1 5 Number 5 Email
ﬁ]Z[;;ode : I"\I—]avigatic?n = = Navigation Properties
5 Phoneld 55 Locations
=l Navigation Properties
-5_—1 Phone
“¢  Plumber ES
= Tradesman
8 i:tiﬁtion - " Properies
1 " 5 IsCertified
= Properties Fry T % % Locationld
5 JobSiteMame - = Navigation Properties
= Mavigation Properties = Properties & JobSite
'5:1 Foremen 1 ) @j‘ Foremanld
5 Plumbers 2 Locationld
: 2 Name

= Navigation Properties

= Jobsite

Figure 5-4. A model for Plumbers with their JobSite and other related entities

In this model, the Plumber entity extends the Tradesman entity. A Plumber has a JobSite that is
represented by a one-to-many association. The JobSite type extends the Location entity. Location has a
Phone, which is represented by a one-to-many association. Finally, a JobSite can have zero or more
Foremen. This is also represented by a one-to-many association.

Suppose you want to retrieve a plumber, the jobsite she works on, the jobsite’s phone number, and
all the foremen at the jobsite. You want to retrieve all this in one round trip to the database.

The code in Listing 5-4 illustrates one way to use the Include() method to eagerly load the related
entities in one query.

Listing 5-4. Retrieving related entities in one round trip to the database using eager loading with the
Include() method

using (var context = new EFRecipesEntities())

var foremanl = new Foreman { Name = "Carl Ramsey" };
var foreman2 = new Foreman { Name = "Nancy Ortega" };
var phone = new Phone { Number = "817 867-5309" };
var jobsite = new JobSite { JobSiteName = "City Arena",
Address = "123 Main", City = "Anytown",
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State
Phone
jobsite.Foremen.Add(foreman1);
jobsite.Foremen.Add(foreman2);
var plumber = new Plumber { Name = "Jill Nichols",
Email = "JINichols@plumbers.com”,
JobSite = jobsite };
context.Tradesmen.AddObject (plumber);
context.SaveChanges();

"TX", ZIPCode = "76082",
phone };

using (var context = new EFRecipesEntities())

var plumber = context.Tradesmen.0fType<Plumber>()
.Include("JobSite.Phone")
.Include("JobSite.Foremen").First();
Console.WriteLine("Plumber's Name: {0} ({1})", plumber.Name, plumber.Email);
Console.WriteLine("Job Site: {0}", plumber.JobSite.JobSiteName);
Console.WriteLine("Job Site Phone: {0}", plumber.JobSite.Phone.Number);
Console.WriteLine("Job Site Foremen:");
foreach (var boss in plumber.J]obSite.Foremen)

Console.WriteLine("\t{0}", boss.Name);

}

The following output is produced by code in Listing 5-4:

Plumber's Name: Jill Nichols (JINichols@plumbers.com)
Job Site: City Arena
Job Site Phone: 817 867-5309
Job Site Foremen:
Carl Ramsey

Nancy Ortega

How It Works

Our query starts by selecting instances of the derived type Plumber. To get these, we use the
0fType<Plumber> () method. The 0fType<>() method select instances of the given subtype from the entity
set.

From Plumber, we want to load the related JobSite and the Phone for the JobSite. Notice that the
JobSite entity does not have a Phone navigation property, but JobSite derives from Location, which does
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have a Phone navigation property. Because Phone is a property of the base entity, it’s also available on
the derived entity. That’s the beauty of inheritance. This makes the query path simply: “JobSite.Phone”.

We used the Include() method again with a query path that references the Foreman entities from
the JobSite entity. Here we have a one-to-many association JobSite and Foreman. Notice the navigation
property was pluralized by the wizard (from Foreman to Foremen).

Finally, we use the First() method to select just the first Plumber instance.

The resulting query is somewhat complex, involving several joins and subselects. The alternative,
using the Load() method for each related entity, would require several round trips to the database and
would result in a performance hit, especially if we retrieved many Plumbers.

5-4. Using Include() with Other LINQ Query Operators

Problem

You have a LINQ query that uses operators such as group by, join, and where; and you want to use the
Include() method to eagerly load additional entities.

Solution

Let’s say you have a model like the one shown in Figure 5-5.

: s Event E3
“@¢ Club E3
= . = Properties
Properties % Eventld
@ﬁ:‘ Cubd 4 2 EventName
ﬁj N.ame 1 * = EventDate
B City 4 Clubld
= Navigation Properties =l Navigation Properties
] Events = cub

Figure 5-5. A simple model with a one-to-many association between Club and Event

To use the Include() method in combination with a group by clause, form the LINQ expression
without the Include() method first; then cast the expression as an ObjectQuery<T» and invoke the
Include() method. The code in Listing 5-5 demonstrates this approach.

Listing 5-5. Casting to ObjectQuery<T> and Invoking Include()

using (var context = new EFRecipesEntities())

var club = new Club { Name = "Star City Chess Club", City

context.Clubs.AddObject(club);

new Event { EventName = "Mid Cities Tournament",
EventDate = DateTime.Parse("1/09/2010"), Club

new Event { EventName = "State Finals Tournament",

"New York" };

club };
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EventDate = DateTime.Parse("2/12/2010"), Club = club };
new Event { EventName = "Winter Classic",
EventDate = DateTime.Parse("12/18/2009"), Club = club };

context.SaveChanges();

}

using (var context = new EFRecipesEntities())

var events = from ev in context.Events

where ev.Club.City == "New York"

group ev by ev.Club into g

select g.FirstOrDefault(el =>

el.EventDate == g.Min(evt => evt.EventDate));

var e = ((ObjectQuery<Event>)events).Include("Club").First();
Console.WriteLine("The next New York club event is:");
Console.WriteLine("\tEvent: {0}", e.EventName);
Console.WriteLine("\tDate: {0}", e.EventDate.ToShortDateString());
Console.WriteLine("\tClub: {0}", e.Club.Name);

The output of the code in Listing 5-5 is the following:

The next New York club event is:
Event: Winter Classic
Date: 12/18/2009

Club: Star City Chess Club

How It Works

We start by creating a Club and three Events. The code looks a little strange. We created the events
without assigning them to anything! Well, not quite. The initializer for each assigns the Club property the
instance of the club we created at the top. This is all that is needed to add the events to the club’s event
entity collection. There is no reason to keep another set of references to the events. They are already
referenced by the club.

In the query, we grab all the events at clubs in New York, group them by club, and find the first one
in date order. The events variable holds just the expression. It hasn’t executed anything on the database
yet.

Next, we cast the expression to ObjectQuery<Event>. This is required because the LINQ expressions
are of type IQueryable<T>. Because ObjectQuery<T> implements IQueryable<T»,and our LINQ to Entities
expression is really of type ObjectQuery<T>, it’s safe to do the cast. But why do we need to cast it? Because
IQueryable<T> doesn’t have an Include() method, but ObjectQuery<T> does have it. The cast gives us
access to the Include() method.

Many developers find the Include() method a little confusing. In some cases, Intellisense will not
show it as available (because of the type of the expression). In some cases, it will be silently ignored at
runtime. Surprisingly, the compiler rarely complains unless it cannot determine the resulting type. The
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problems usually show up at runtime when they can be a more difficult fix. Here are some simple rules
to follow when using Include():

1. Include() applies only to the final query results. When Include() is applied to a
subquery, join, or nested from clause, it is ignored when the command tree is
generated.

2. The Include() method is an extension method on type ObjectQuery<T>. If the
expression is of type IQueryable<T>, it must be cast to ObjectQuery<T> before
the Include() method will be available.

3. Include() can be applied only to results that are entities. If the expression
projects results that are not entities, Include() will be ignored.

4. The query cannot change the type of the results between the Include() and the
outermost operation. A group by clause, for example, changes the type of the
results.

5. The query path used in the Include() expression must start at a navigation
property on the type returned from the outermost operation. The query path
cannot start at an arbitrary point.

Let’s see how these rules apply to the code in Listing 5-5.

The query groups the events by the sponsoring club. The group by operator changes the result type
from Event to a grouping result. Here Rule 4 says that we need to invoke the Include() method after the
group by clause has changed the type. We do this by invoking Include() at the very end. If we applied
the Include() method earlier as in from ev in context.Events.Include(), the Include() method would
have been silently dropped from the command tree and never applied.

If you mouse over the events variable, you will notice that Intellisense shows the type as
IQueryable<Event>. Rule 2 says that IQueryable<T> does not implement the Include() method. However,
we know that events is really of type ObjectQuery<Event>, so following Rule 2, we cast events to
ObjectQuery<Event> and then invoke the Include() method.

5-5. Deferred Loading of Related Entities

Problem

You have an instance of an entity and you want to defer load two or more related entities in a single
query.

Solution

Suppose you have a model like the one in Figure 5-6.
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“¢  Department &
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Figure 5-6. A a model with an employee, her department, and the department’s company

In the model shown in Figure 5-6, an Employee is associated with exactly one Department. Each
Department is associated with exactly one Company.

Given an instance of an Employee, you want to load both his department and the department’s
company. What makes this problem somewhat unique is that we already have an instance of Employee
and we want to avoid going back to the database to get another copy of the Employee just so that we can
use the Include() method to obtain the related instances of Company and Department. Perhaps in your
real-world problem, Employee is a very expensive entity to retrieve and materialize.

We could use the Load() method twice to load the related Department instance and then again to
load the related Company instance. However, this would generate two round trips to the database. To
load the related instances using just one query, we can either re-query the Employee entity set using the
Include() method with a query path including the Department and the Company, or use the
CreateSourceQuery() method on the DepartmentReference property. The code in Listing 5-6 shows both
approaches.

Listing 5-6. Inserting into the model and retrieving the related entities using two slightly different
approaches

using (var context = new EFRecipesEntities())

var company = new Company { Name = "Acme Products" };
var acc = new Department { Name = "Accounting", Company = company };

var ship = new Department { Name = "Shipping", Company = company };
var empl = new Employee { Name = "Jill Carpenter", Department = acc };
var emp2 = new Employee { Name = "Steven Hill", Department = ship };

context.Employees.AddObject(emp1);
context.Employees.AddObject (emp2);
context.SaveChanges();

}

// first approach
using (var context = new EFRecipesEntities())

// assume we already have an employee
var jill = context.Employees.Where(o => o.Name == "Jill Carpenter").First();

// now get Jill's department and company
var results = context.Employees.Include("Department.Company")
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.Where(o => o.Employeeld == jill.Employeeld).First<Employee>();
Console.WriteLine("{0} works in {1} for {2}", jill.Name,
jill.Department.Name, jill.Department.Company.Name);

}

// more efficient, does not retrieve employee again
using (var context = new EFRecipesEntities())

// assume we already have an employee
var jill = context.Employees.Where(o => o.Name == "Jill Carpenter").First();

var moreResults = jill.DepartmentReference.CreateSourceQuery()
.Include("Company").First();
context.Attach(moreResults);
Console.WriteLine("{0} works in {1} for {2}", jill.Name,
jill.Department.Name, jill.Department.Company.Name);

The following is the output of the code in Listing 5-6:

Jill Carpenter works in Accounting for Acme Products

Jill Carpenter works in Accounting for Acme Products

How It Works

If we didn’t already have an instance the Employee entity, we could simply use the Include() method
with a query path “Department.Company”. This is essentially the approach we take in the first query.
The disadvantage of this approach is that it retrieves all the columns for the Employee entity. In many
cases, this might be an expensive operation. Because we already have this object in the context, it seems
wasteful to gather these columns again from the database and transmit them across the wire.

In the second query, we use the CreateSourceQuery() method available on the
DepartmentReference property to retrieve the related instance of the Department entity as well as the
instance of the Company entity. This second approach is more efficient because it does not retrieve the
Employee columns. Our use of the Attach() method to attach the retrieved Department instance to the
object context is not strictly required in this case because of relationship span.

5-6. Filtering and Ordering Related Entities

Problem

You have an instance of an entity and you want to load a related EntityCollection applying both a filter
and an ordering.
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Solution

Suppose you have a model like the one shown in Figure 5-7.

@2 Hotel E3
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Figure 5-7. A model for a hotel reservation system

Let’s assume we have an instance of a Hotel entity. To retrieve the executive suite rooms for the
hotel, see which have reservations, and order them by room rate, use the pattern shown in Listing 5-7.

Listing 5-7. Filtering and ordering an entity collection using CreateSourceQuery()
using (var context = new EFRecipesEntities())

var hotel = new Hotel { Name = "Grand Seasons Hotel" };

var r101 = new Room { Rate = 79.95M, Hotel = hotel };

var es201 = new ExecutiveSuite { Rate = 179.95M, Hotel = hotel };

var es301 = new ExecutiveSuite { Rate = 299.95M, Hotel = hotel };

var resl = new Reservation { StartDate = DateTime.Parse("3/12/2010"),
EndDate = DateTime.Parse("3/14/2010"),
ContactName = "Roberta Jones", Room = es301 };

var res2 = new Reservation { StartDate = DateTime.Parse("1/18/2010"),
EndDate = DateTime.Parse("1/28/2010"),
ContactName = "Bill Meyers", Room = es301 };
var res3 = new Reservation { StartDate = DateTime.Parse("2/5/2010"),

EndDate = DateTime.Parse("2/6/2010"),
ContactName = "Robin Rosen", Room = ri101 };
context.Hotels.AddObject(hotel);
context.SaveChanges();
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using (var context = new EFRecipesEntities())

// assume we have an instance of hotel
var hotel = context.Hotels.First();

var rooms = hotel.Rooms.CreateSourceQuery()
.Include("Reservations")
.Where(r => r is ExecutiveSuite &
r.Reservations.Any())
.OrderBy(r => r.Rate);
Console.WriteLine("Executive Suites for {0} with reservations", hotel.Name);
hotel.Rooms.Attach(rooms);
foreach (var room in hotel.Rooms)

{
Console.WriteLine("\nExecutive Suite {0} is {1} per night",
room.RoomId.ToString(), room.Rate.ToString("C"));
Console.WriteLine("Current reservations are:");
foreach (var res in room.Reservations.OrderBy(r => r.StartDate))
{

Console.WriteLine("\t{o} thru {1} ({2})",
res.StartDate.ToShortDateString(),
res.EndDate.ToShortDateString(),
res.ContactName);

}
}

The following is the output of the code shown in Listing 5-7:

Executive Suites for Grand Seasons Hotel with reservations

Executive Suite 84 is $299.95 per night
Current reservations are:
1/18/2010 thru 1/28/2010 (Bill Meyers)

3/12/2010 thru 3/14/2010 (Roberta Jones)

How It Works

The code in Listing 5-7 uses the CreateSourceQuery() method to get access to the query that is used to
retrieve the entity collection on the navigation property. We apply the Include() method to eagerly load
the associated reservations for each room. We apply Include() before the where clause because prior to
the where clause, the expression is of type ObjectQuery<Roomy, which exposes the Include() method.
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After the where clause, the expression is of type IQueryable<Room>, which does not have the Include()
method.

The where clause filters the collection to rooms of type ExecutiveSuite that have at least one
reservation. We then order the collection by room rate using an OrderBy clause.

After we obtain the filtered and ordered collection of rooms with their reservations, we use the
Attach() method to connect the collection to the instance of the Hotel entity. Once attached, we iterate
through the rooms. For each room, we order the reservations for the room by start date. This second
ordering is done in memory on the entity collection while the first ordering and filtering was performed
in the database.

One way to simplify the filter is to use the 0fType<T>() method, as shown in the code snippet in
Listing 5-8. This approach relies on .NET 4.0’s new support for covariance and contravariance. Now the
type of rooms passed to the Attach() method is I0rderedQueryable<ExecutiveSuite>, which defines
methods whose signatures reference the ExecutiveSuite type that is derived from the Room entity.

Listing 5-8. Using Of Type<T> to filter by derived type
var rooms = hotel.Rooms
.CreateSourceQuery()
.Include("Reservations")
.0fType<ExecutiveSuite>()

Where(r => r.Reservations.Any()).0rderBy(r => r.Rate);
hotel.Rooms.Attach(rooms);

5-7. Executing Aggregate Operations on Related Entities

Problem

You want to apply an aggregate operator on a related entity collection without loading the collection.

Solution

Suppose you have a model like the one shown in Figure 5-8.
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Figure 5-8. Orders and their associated order items
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In Figure 5-8, we have a simple model composed of an order and the products (collection of
OrderItems) shipped for the order. One way to get the total amount for the order is to use the Load()
method to load the EntityCollection of order items and then iterate through this collection, calculating
the sum of the amount for each order item.

Another way to get the same result is to push the iteration to the data store layer, letting it compute
the total amount. The advantage to this second approach is that we avoid the potentially costly overhead
of materializing each order item for the sole purpose of summing the total order amount. To implement
this second approach, follow the pattern shown in Listing 5-9.

Listing 5-9. Applying an aggregate operator on related entities without loading them
using (var context = new EFRecipesEntities())

var order = new Order { CustomerName = "Jenny Craig",
OrderDate = DateTime.Parse("3/12/2010") };

var itemi = new OrderItem { Order = order, Shipped = 3, SKU = 2827,
UnitPrice = 12.95M };
var item2 = new OrderItem { Order = order, Shipped = 1, SKU = 1918,

UnitPrice = 19.95M };
var item3 = new OrderItem { Order = order, Shipped = 3, SKU
UnitPrice = 8.95M };
context.0Orders.AddObject(order);
context.SaveChanges();

392,

}

using (var context = new EFRecipesEntities())

// assume we have an instance of Order
var order = context.Orders.First();

// get the total order amount
var amt = order.OrderItems.CreateSourceQuery()

.Sum(o => (o.Shipped * o.UnitPrice));
Console.WriteLine("Order Number: {0}", order.OrderId.ToString());

Console.WriteLine("Order Date: {0}", order.OrderDate.ToShortDateString());
Console.WriteLine("Order Total: {o}", amt.ToString("C"));

The following is the output of the code in Listing 5-9:

Order Number: 6
Oxder Date: 3/12/2010

Order Total: $85.65
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How It Works

In Listing 5-9, we use the CreateSourceQuery() method to get access to the query used to retrieve the
order item EntityCollection. Once we have the query, we apply the Sum() method, passing in a lambda
expression that calculates the item total. The resulting sum over the collection is the order total. This
entire expression is converted to the appropriate store layer commands and executed in the storage
layer, saving the cost of materializing each order item.

This simple example demonstrates the flexibility of the CreateSourceQuery() method to modify the
query used to retrieve the underlying associated entity collection. In this case, we leveraged the query
without actually loading the collection.

5-8. Testing Whether an Entity Reference or
Entity Collection Is Loaded

Problem

You want to test whether the related entity or entity collection is loaded in the object context.

Solution

Entity Framework exposes the IsLoaded property that, under most circumstances, is true if the entity or
entity collection is loaded and available in the object context. IsLoaded is available on the navigation
property if it is an entity collection. For entity references, IsLoaded is available on a property with the
same name as the navigation property with the word “Reference” appended. For example, if the
navigation property is Order, IsLoaded would be available on the OrderReference property.

To demonstrate the use of IsLoaded, let’s assume you have a model like the one shown in Figure

5-9.
2 Project % S —
2: Manager & “+ Contractor x
2 Manager x *
= Properties
= Properi
= Properties ¥ ProjectlD @rope 1es
5 ManagerD § Name | g ;:r:r:cterID
) * ManagerlD 1 *
' Name 1 g AT
ProjectlD
=l Navigation Properties = Mavigation Properties = f‘ . Jt . ;
=] projects = Contractors ﬂawga.lon roperties
. & Manager 5 Project

Figure 5-9. A model for projects, managers, and contractors

The model in Figure 5-9 represents projects, the managers for the projects, and the contractors that
work on the project. To test whether an entity or entity reference is loaded into the object context, follow
the pattern in Listing 5-10.
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Listing 5-10. Using IsLoaded to determine whether an entity or entity collection is in the object context

using (var context = new EFRecipesEntities())

var manl = new Manager { Name = "Jill Stevens" };

var proj = new Project { Name = "City Riverfront Park", Manager = mani };
var conl = new Contractor { Name = "Robert Alvert", Project = proj };
var con2 = new Contractor { Name = "Alan Jones", Project = proj };

var con3 = new Contractor { Name = "Nancy Roberts", Project = proj };

context.Projects.AddObject(proj);
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

var project = context.Projects.Include("Manager").First();
if (project.ManagerReference.IslLoaded)
Console.WriteLine("Manager entity is loaded.");
else
Console.WriteLine("Manager entity is NOT loaded.");
if (project.Contractors.IsLoaded)
Console.WriteLine("Contractors are loaded.");
else
Console.WriteLine("Contractors are NOT loaded.");

Console.WriteLine("Calling project.Contractors.Load()...");
project.Contractors.Load();

if (project.Contractors.IsLoaded)
Console.WriteLine("Contractors are now loaded.");
else
Console.WriteLine("Contractors failed to load.");

The following is the output from the code in Listing 5-10:

Manager entity is loaded.
Contractors are NOT loaded.
Calling project.Contractors.Load()...

Contractors are now loaded.
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How It Works

We use the Include() method to eagerly load the project together with its related manager in the original
query. After the query, we check whether the manager instance is loaded using the
project.ManagerReference.IsLoaded property. Because this is an entity reference, the IsLoaded property
is available on ManagerReference property rather than on Manager property, which is null.

Next, we check whether the Contractor entity collection is loaded. It is not loaded because we didn'’t
eagerly load it with the Include() method nor did we load it directly (yet) with the Load() method. Once
we use the Load() method, IsLoaded is set to true.

If lazy loading is enabled on the object context by setting DeferredLoadingEnabled to true, then
IsLoaded is set to true when the entity or entity collection is referenced. The DeferredLoadingEnabled
flag causes Entity Framework to automatically load the entity or entity collection when referenced.

When you use the CreateSourceQuery() method to grab the query for loading the entity or entity
collection, Entity Framework will not set IsLoaded when the query is executed.

The exact meaning of IsLoaded can be a little more confusing than it seems it should be. IsLoaded is
set by the results of a query, by calling the Load() method, or implicitly by the span of relationship keys.
When you query for an entity, there is an implicit query for the key of the related entity. If the result of
this implicit query is a null key value, then IsLoaded is set to true, indicating there is no related entity in
the database. This is the same value for IsLoaded we would expect if we did an explicit load on the
relationship and found no related entity.

5-9. Loading Related Entities Explicitly

Problem

You want to directly load related entities.

Solution
Let’s say you have a model like the one in Figure 5-10.

“¢  Appointment &

#; Doctor ES = Properties #; Ppatient %
# Appointmentld
= Properties 7 Date = Properties
#4 Doctorld f Reason ¥ Patientld
ﬁ]Name 1 " ﬁ]Fee " 1 ﬁ]Name
=l Navigation Properties 7 Doctorld =l Navigation Properties
B Appcintments ZF Patientld B Appcintments

=l Navigation Properties
3_—1 Doctor
[l patient

Figure 5-10. A model for doctors, their patients, and appointments
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The model depicted in Figure 5-10 represents doctors, their patients, and appointments. To

explicitly load related entities, follow the pattern in Listing 5-11.

Listing 5-11. Using the Load() method

using (var context = new EFRecipesEntities())

}

var docl = new Doctor { Name = "Joan Meyers" };

var doc2 = new Doctor { Name = "Steven Mills" };

var patl = new Patient { Name = "Bill Rivers" };

var pat2 = new Patient { Name = "Susan Stevenson" };

var pat3 = new Patient { Name = "Roland Marcy" };

var appl = new Appointment { Date = DateTime.Today, Doctor = doci,

Fee = 109.92M, Patient = pati,
Reason = "Checkup" };
var app2 = new Appointment { Date = DateTime.Today, Doctor = doc2,
Fee = 129.87M, Patient = pat2,
Reason = "Arm Pain" };
var app3 = new Appointment { Date = DateTime.Today, Doctor = doci,
Fee = 99.23M, Patient = pat3,
Reason = "Back Pain" };
context.Doctors.AddObject(doc1);
context.Doctors.AddObject(doc2);
context.SaveChanges();

using (var context = new EFRecipesEntities())

var doc = context.Doctors.First(o => o.Name == "Joan Meyers");
if (!doc.Appointments.IsLoaded)
{

doc.Appointments.Load();
Console.WriteLine("Dr. {0}'s appointments were lazy loaded.", doc.Name);

Console.WriteLine("Dr. {0} has {1} appointment(s).", doc.Name,
doc.Appointments.Count().ToString());

foreach (var app in context.Appointments)

{
if (lapp.DoctorReference.IsLoaded)
app.DoctorReference.Load();
Console.WriteLine("Dr. {0} was lazy loaded.", app.Doctor.Name);
}
else
Console.WriteLine("Dr. {0} was already loaded.", app.Doctor.Name);
}

Console.WriteLine("There are {0} appointments for Dr. {1}",
doc.Appointments.Count().ToString(), doc.Name);

doc.Appointments.Cleax();

Console.WriteLine("Collection clear()'ed");
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Console.WriteLine("There are now {0} appointments for Dr. {1}",
doc.Appointments.Count().ToString(), doc.Name);

doc.Appointments.Load();

Console.WriteLine("Collection loaded()'ed");

Console.WriteLine("There are now {0} appointments for Dr. {1}",
doc.Appointments.Count().ToString(), doc.Name);

doc.Appointments.Load(MergeOption.OverwriteChanges);

Console.WriteLine("Collection loaded()'ed with MergeOption.OverwriteChanges");

Console.WriteLine("There are now {0} appointments for Dr. {1}",
doc.Appointments.Count().ToString(), doc.Name);

The output of the code in Listing 5-11 is the following:

Dr. Joan Meyers's appointments were lazy loaded.
Dr. Joan Meyers has 2 appointment(s).

Dr. Steven Mills was lazy loaded.

Dr. Joan Meyers was already loaded.

Dr. Joan Meyers was already loaded.

There are 2 appointments for Dr. Joan Meyers
Collection clear()'ed

There are now O appointments for Dr. Joan Meyers
Collection loaded()'ed

There are now O appointments for Dr. Joan Meyers
Collection loaded()'ed with MergeOPtion.OverwriteChanges

There are now 2 appointments for Dr. Joan Meyers

How It Works

After inserting some sample data into our database, the first bit of code retrieves an instance of the
Doctor entity. It is good practice to use the IsLoaded property to check whether the entity or entity
collection is already loaded. In the code, we check whether the doctor’s appointments are loaded. If not,
we use the Load() method to load them.

In the foreach loop, we iterate through the appointments, checking if the associated doctor is
loaded. Notice in the output that one doctor was already loaded while the other one was not. This is
because our first query retrieved this doctor. During the retrieval process for the appointments, Entity
Framework connected the loaded instance of the doctor with her appointments. This process is
informally referred to as relationship span. Relationship span will not fix up all associations. In
particular, it will not tie in entities across a many-to-many association.

In the last bit of code, we print the number of appointments we have for the doctor. Then we clear
the collection from the context using the Clear() method. The Clear() method empties the entity
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collection; it does not remove the instances from memory because they are still in the object context—
they are just no longer connected to this instance of the Doctor entity.

Somewhat surprisingly, after we call Load() to reload the appointments, we see from the output that
no appointments are in our collection! What happened? It turns out that the Load() method is
overloaded to take a parameter that controls how the loaded entities are merged into the object context.
The default behavior for the Load() method is MergeOption.AppendOnly, which simply appends instances
that are not already in the object context. In our case, none of the appointments was actually removed
from the object context. Our use of the Clear() method simply removed them from the entity collection,
not the object context. When we called Load() with the default MergeOption.AppendOnly, no new
instances were found, so nothing was added to the entity collection. Other merge options include
NoTracking, OverwriteChanges, and PreserveChanges. When we use the OverwriteChanges option, the
appointments appear in the Doctor’s Appointments.

The NoTracking option turns off object state tracking for the loaded instances. With NoTracking,
Entity Framework will not track changes to the object and will not be aware that the object is loaded into
the context. The NoTracking option can be used on a navigation property of an object only if the object
was loaded with the NoTracking option. NoTracking has one additional side effect. If we had loaded an
instance of the Doctor entity with NoTracking, loading the appointments with the Load() method would
also occur with NoTracking, regardless of the default AppendOnly option.

The OverwriteChanges option will replace the current instance with the one found in the database.
This option is particularly useful if you need to discard changes made in the context and refresh them
from the database. This would be helpful, for example, in implementing an “undo” operation in an
application.

The PreserveChanges option is, essentially, the opposite of the OverwriteChanges option and is
typically used to force changes to objects in certain error recovery scenarios.

There are some restrictions on when you can use Load(). Load() cannot be called on an entity that is
in the Added, Deleted, or Detached state.

The Load() method can be helpful in improving performance by restricting how much of a
collection is loaded at any one time. For example, suppose our doctors had lots of appointments, but in
many cases we needed to work with just a few of them. In the rare case we need the entire collection, we
can simply call Load() to append the remaining appointment instances to the object context. This is
demonstrated in the code snippet in Listing 5-12.

Listing 5-12. Code snippet demonstrating partial loading of an entity collection
using (var context = new EFRecipesEntities())

// load the first doctor and attach just the first appointment

var doc = context.Doctors.First(o => o.Name == "Joan Meyers");

doc.Appointments.Attach(doc.Appointments.CreateSourceQuery().Take(1));

Console.WriteLine("Dr. {0} has {1} appointments loaded.", doc.Name,
doc.Appointments.Count().ToString());

// when we need all of the remaining appointments, simply Load() them
doc.Appointments.Load();

Console.WriteLine("Dr. {0} has {1} appointments loaded.", doc.Name,
doc.Appointments.Count().ToString());

The output of the code snippet in Listing 5-12 is the following:
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Dr. Joan Meyers has 1 appointments loaded.

Dr. Joan Meyers has 2 appointments loaded.

5-10. Filtering an Eagerly Loaded Entity Collection

Problem

You want to filter an eagerly loaded collection.

Solution

Entity Framework does not support a filtering predicate with the Include() method, but we can
accomplish the same thing by creating an anonymous type that includes the entity along with the
filtered collection of related entities.

Let’s assume you have a model like the one in Figure 5-11.

@z Movie ES
#2 Category 3
= Properties
=P i
@mpe = B Movield
Hcategontd | = Name
iTI Name 1 * = Rating
% ReleaseType

= Categoryld

~ A e = =l Navigation Properties

) i E
Z, Movies E category

Figure 5-11. A model for movies and their categories

To eagerly load and filter both the categories and their associated movies, follow the pattern in
Listing 5-13.

Listing 5-13. Filtering an eagerly loaded entity collection

using (var context = new EFRecipesEntities())
var catl = new Category { Name = "Science Fiction", ReleaseType = "DVD" };
var cat2 = new Category { Name = "Thriller", ReleaseType = "Blu-Ray" };

new Movie { Name
new Movie { Name

"Return to the Moon", Category = cat1, Rating = "PG-13" };
"Street Smarts", Category = cat2, Rating = "PG-13" };

new Movie { Name = "Alien Revenge", Category = cati, Rating = "R" };

new Movie { Name = "Saturday Nights", Category = cat1, Rating = "PG-13" };
context.Categories.AddObject(cat1);

context.Categories.AddObject(cat2);

context.SaveChanges();
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using (var context = new EFRecipesEntities())

// filter on ReleaseType and Rating

// create collection of anonymous types

var cats = from ¢ in context.Categories
where c.ReleaseType == "DVD"

select new
{
category = c,
movies = c.Movies.Where(m => m.Rating == "PG-13")
b
Console.WriteLine("PG-13 Movies Released on DVD");
Console.WriteLine(" ");
foreach (var c in cats)
{
Category category = c.category;
Console.WriteLine("Category: {0}", category.Name);
foreach (var m in category.Movies)
{
Console.WriteLine("\tMovie: {0}", m.Name);
}

The code in Listing 5-13 produces the following output:

PG-13 Movies Released on DVD

Category: Science Fiction
Movie: Return to the Moon

Movie: Saturday Nights

How It Works

We start off in Listing 5-13 creating and initializing the categories and movies. To keep things short,
we’ve created only a couple of categories and four movies. Notice that we don’t really need to keep
references to the movies we create because we connect them immediately to their category. All we need
to do is add the categories to the object context and call SaveChanges (). Entity Framework does the work
of saving the entire object graph to the database.

In the query, we create a collection of anonymous types with the category instance and the filtered
collection of movies in the category. The query also filters the category collection retrieving only
categories whose movies are released on DVD. In this example, just one category was released on DVD.
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Here we rely on relationship span to attach the movies to the categories. There is no need to explicitly
Attach() the movies.

5-11. Using Relationship Span

Problem

You have a self-referencing association and you want to load all the entities and create the hierarchy
without explicitly traversing the entire graph.

Solution

Suppose you have a model like the one in Figure 5-12.
“s  Assodate ES

= Properties
# Associateld
. ﬁ] Mame
0.1 Zf ReportsTo
| = Navigation Properties

-5_—1 TeamMembers

Bl Manager

¢ Supervisor E “¢ ProjectManager |% “s CEO x
=* Asscciate =* Asscciate =* Asscciate

= Properties = Properties = Properties

= Navigation Properties = Navigation Properties = Navigation Properties

Figure 5-12. A model with a self-referencing association

The model in Figure 5-12 describes an associate reporting hierarchy for three types of associates:
Project Manager, Supervisor, and CEO. The key feature of the model is the self-referencing association
that defines the reporting hierarchy.

We have discussed in other recipes how to traverse a hierarchy such as this using recursion on both
the client side and the server (database) side. Our goal here is to load the entire hierarchy letting
relationship span fix up the associations to form the hierarchy.

In Listing 5-14, we use the ToList() method to cause the materialization of all the associates and the
fix-up of the relationships. Once all the associates are in memory, we use the recursive PrintDetails()
method to print the reporting hierarchy.
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Listing 5-14. Using ToList() to cause the creation of the entire hierarchy via relationship span

static void RunExample()

{
using (var context = new EFRecipesEntities())
var ceo = new CEO { Name = "Joan Miller" };
var super = new Supervisor { Name = "Bill Mayer", Manager = ceo };
var pm = new ProjectManager { Name = "Jill Williams", Manager = super };
context.Associates.AddObject(ceo);
context.SaveChanges();
}
using (var context = new EFRecipesEntities())
var ceo = context.Associates.First(a => a.ReportsTo == null);
var associates = context.Associates.ToList();
PrintDetails(ceo);
}
}
static void PrintDetails(Associate associate)
{
Console.WriteLine("{0} is a {1}", associate.Name, associate.GetType().Name);
Console.WriteLine("\t{0} reports to {1}",associate.Name,
associate.Manager != null ? associate.Manager.Name : “No One!");
foreach (var e in associate.TeamMembers)
PrintDetails(e);
}

The following is the output of the code in Listing 5-14:

Joan Miller is a CEO

Joan Miller reports to No One!
Bill Mayer is a Supervisor

Bill Mayer reports to Joan Miller
Jill Williams is a ProjectManager

Jill Williams reports to Bill Mayer

183



P Tl VI STV M iamvidarm e o vl St iy

184

How It Works

The key to Listing 5-14 is using the ToList() method to cause the execution of the query retrieving all the
associates. When the objects are materialized, not only are they brought into the object context but their
associations are also fully realized. This means that the entire hierarchy is created without our code
recursively loading or attaching each level of the hierarchy.

Let’s look a little deeper into relationship span and how Entity Framework wires together all the
associations in scenarios such as the one in Listing 5-14.

When Entity Framework loads an entity, it also loads all the associations that or 0..1 or one-to-one.
Remember, associations are first-class objects just like entities. Entity Framework creates three entries in
the object state manager. First, it creates the entry for the entity. Next, it creates an entry for the
association. Finally, it creates an entry stub for the other end of the association that is not yet loaded.

In our example, when an Associate entity is loaded, Entity Framework creates an entry for the entity,
an entry for the association, and finally, an entry stub for the Associate entity. The stub is a placeholder
for the entity on the other end of the Manager relationship. The stub is a placeholder because the related
associate has not yet been loaded into the object context. The stub has a valid entity key, even though
the entity has not yet been loaded. It is this stub entry with the entity key that allows Entity Framework
to complete the association once the related entity is loaded into the object context.

The process in which the stub entry for the association is replaced with the actual entity when the
related entity is loaded is called relationship span. The result of relationship span is that the association
is completed without your code explicitly connecting the entities. By retrieving all the entities as we did
in Listing 5-14, Entity Framework progressively completed the associations as the entities were loaded.

5-12. Modifying Foreign Key Associations

Problem

You want to modify a foreign key association.

Solution

Entity Framework provides a couple of ways to modify a foreign key association. You can add the
associated entity to a navigation property collection or assign it to a navigation property. You can also
set the foreign key value with the associated entity’s key value.

Suppose you have a model like the one shown in Figure 5-13.

2 Invoice 3
¢ Client 3
= Properties
= Properties ¥ Invoiceld
@j‘ Clientld 7 InvoiceDate
= Name 1 * 7 Amount
=l Navigation Properties 7 Clientld
= Invoi =l Navigation Properties
58 Invoices
B2 Client

Figure 5-13. A model for clients and invoices
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To modify the foreign key association between client entities and invoice entities in two different ways,
do the following:

1. Right-click your project and select Add New » ADO.NET Entity Data Model.
Import the Client and Invoice tables. Be sure to check the Include foreign key
columns in the model check box as shown in Figure 5-14. This will cause the
relationships in the database that are not many-to-many to be imported as
foreign key associations.

2. Use the code in Listing 5-15 to demonstrate the ways in which a foreign key
association can be modified.

Entity Data Model Wizard (2] = |

J— 1 Choose Your Database Objects
—— =

‘Which database objects do you want to include in your model?

(&, F Tables
D'j] Views
[[)% Stored Procedures

Check this to use foreign key associations in the model.

%r singularize generated object names
nclude foreign key columns in the model
Model Namespace:

EFRecipesModel

[ Finish l I Cancel ‘

Figure 5-14. Checking the Include foreign key columns in the model check box means that foreign key
associations will be created for the imported database relationships that are not many-to-many.
Listing 5-15. Demonstrating the ways in which a foreign key association can be modified

using (var context = new EFRecipesEntities())

var clienti = new Client { Name = "Karen Standfield", ClientId = 1 };

var invoicel = new Invoice { InvoiceDate = DateTime.Parse("4/1/10"), Amount = 29.95M };
var invoice2 = new Invoice { InvoiceDate = DateTime.Parse("4/2/10"), Amount = 49.95M };
var invoice3 = new Invoice { InvoiceDate = DateTime.Parse("4/3/10"), Amount = 102.95M };
var invoice4 = new Invoice { InvoiceDate = DateTime.Parse("4/4/10"), Amount = 45.99M };
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// add the invoice
// to the client's collection
client1.Invoices.Add(invoice1);

// assign the foreign key
// directly
invoice2.Clientld = 1;

// Attach() and existing
// row using a "fake" entity
context . ExecuteStoreCommand (

"insert into chapter5.client values (2, 'Phil Marlowe')");
var client2 = new Client { ClientId = 2 };
context.Clients.Attach(client2);
invoice3.Client = client2;

// using the ClientReference
invoice4.ClientReference.Value = clienti;

// save the changes
context.Clients.AddObject(client1);
context.Invoices.AddObject(invoice2);
context.Invoices.AddObject(invoice3);
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

foreach (var client in context.Clients)

{
Console.WriteLine("Client: {0}", client.Name);
foreach (var invoice in client.Invoices)
{

Console.WriteLine("\t{o} for {1}",
invoice.InvoiceDate.ToShortDateString(),
invoice.Amount.ToString("C"));

}
}

The following is the output of the code in Listing 5-15:

Client: Karen Standfield
4/1/2010 for $29.95
4/4/2010 for $45.99

4/2/2010 for $49.95
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Client: Phil Marlowe

4/3/2010 for $102.95

How It Works

Entity Framework supports independent associations and foreign key associations. For an independent
association, the association between the entities is tracked separately from the entities and the only way
to change the association is through object references.

With foreign key associations, you can change the association by changing object references or by
directly changing the foreign key property value. Foreign key associations are not used for many-to-
many relationships.

Table 5-1 illustrates the main differences between foreign key associations and independent
associations.

Table 5-1. The Differences between Foreign Key Associations and Independent Associations

Foreign Key Association Independent Association

Can be set using foreign key Can only be set using a navigation property
and navigation properties

Is mapped as a property and Is tracked independently from the entity which means

does not require a separate changing the association does not change the state of the entity
mapping

Data binding scenarios are Data binding is complicated because you have to manually

easier because can bind to create a property that reads the foreign key value from the

a property value entity key or traverse the navigation property to load the related key
Finding the old value for a Accessing an old relationship is complicated because relationships
foreign key is easier are tracked separately

because it is a property of

an entity

To delete an entity that To delete an entity that uses an independent association, you need
uses a foreign key association the entity key and the original values for all reference keys

you only need the entity key
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Table 5-1. Continued

Foreign Key Association Independent Association

N-Tier scenarios are easier The client must send the related end’s entity key value
because you don’t have to send along with the entity When the entity is attached, Entity.
the related end’s entity key Framework will create a stub entry and the update
along with the entity statement includes the related end’s entity key

Three representations of the Two representations are kept in sync: the reference and
same association are kept in the navigation property

sync: the foreign key, the
reference, and the collection
navigation property on the
other side. This is handled by
Entity Framework with the
default code generation, but
with POCO, you need to keep
these synchronized

When you load a related entity, When you load a related entity, the foreign key value
Entity Framework uses the is read from the database and based on this value, the
foreign key value currently related entity is loaded

assigned on the entity not
the foreign key value in the
database
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CHAPTER 6

Beyond the Basics with Modeling
and Inheritance

By now you have a solid understanding of basic modeling techniques in Entity Framework. In this
chapter you will find recipes that will help you address many common and often complex modeling
problems. The recipes in this chapter specifically address problems you are likely to face in modeling
existing, real-world databases.

We start this chapter working with many-to-many relationships. This type of relationship is very
common in many modeling scenarios in both existing databases and new projects. Next, we’ll look at
self-referencing relationships and explore various strategies for retrieving nested object graphs. We
round out this chapter with several recipes involving more advanced modeling of inheritance and entity
conditions.

6-1. Retrieving the Link Table in a Many-to-Many Association

Problem

You want to retrieve the keys in the link table that connect two entities in a many-to-many association.

Solution

Let’s say you have a model with a many-to-many association between Event and Organizer entities, as
shown in Figure 6-1.

4+ Event E3 4+ Organizer E3
= Properties = Properties
#4 Eventld # Organizerd
ﬁ\‘ Mame * * ﬁ‘ Mame
=l Navigation Properties =l Navigation Properties
%, Organizers %, Events

Figure 6-1. Many-to-many association between Event and Organizer entities
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As we illustrated in several recipes in Chapter 2, a many-to-many relationship is represented in a
database using an intermediate table called a link table. The link table holds the foreign keys on each
side of the relationship (see Figure 6-2). When a link table with no additional columns and the related
tables are imported into Entity Framework, the Entity Data Model Wizard creates a many-to-many
association between the related tables. The link table is not represented as an entity; however, it is used
internally for the many-to-many association.

Event (Chapter6) EventOrganizer (Chapter6) Organizer (Chapter6)
% Ewventld e e | % Eventld s w | ¥ Organizerld
Mame % Organizerld Mame

Figure 6-2. A database diagram showing the EventOrganizer link table holding the foreign keys to the
related Event and Organizer tables

To retrieve the entity keys Eventld and Organizerld, we can use either a nested from clause or the
SelectMany() method. Listing 6-1 shows both approaches.

Listing 6-1. Retrieving a link table using both a nested from clause and the SelectMany() method
using (var context = new EFRecipesEntities())

var org = new Organizer { Name = "Community Charity" };
var evt = new Event { Name = "Fundraiser" };
org.Events.Add(evt);

context.Organizers.AddObject(org);

org = new Organizer { Name = "Boy Scouts" };

evt = new Event { Name = "Eagle Scout Dinner" };
org.Events.Add(evt);

context.Organizers.AddObject(org);
context.SaveChanges();

}
using (var context = new EFRecipesEntities())

var evsorgl = from ev in context.Events

from organizer in ev.Organizers

select new { ev.EventId, organizer.OrganizerId };
Console.WriteLine("Using nested from clauses...");
foreach (var pair in evsorgi)

{

Console.WriteLine("EventId {0}, Organizerld {1}",
pair.EventId.ToString(),
pair.OrganizerId.ToString());

}

var evsorg2 = context.Events
.SelectMany(e => e.Organizers,
(ev, org) => new { ev.Eventld, org.OrganizerId });
Console.WriteLine("\nUsing SelectManay()");
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foreach (var pair in evsorg)

Console.WriteLine("EventId {0}, OrganizerId {1}",
pair.EventId.ToString(), pair.OrganizerId.ToString());

The output of the code in Listing 6-1 should be something like the following:

Using nested from clauses...
EventId 31, Organizerld 87

EventId 32, OrganizerId 88

Using SelectManay()
EventId 31, OrganizerId 87

EventId 32, OrganizerIld 88

How It Works

Alink table is a common way of representing a many-to-many relationship between two tables in a
database. Because it serves no purpose other than defining the relationship between two tables, Entity
Framework represents a link table as a many-to-many association, not as a separate entity.

The many-to-many association between Event and Organizer allows easy navigation from an Event
entity to the associated organizers and from an Organizer entity to all the associated events. However,
you may want to retrieve just the keys in the link table. You may want to do this because the keys are
themselves meaningful or you want to use these keys for operations on these or other entities. The
problem here is that the link table is not represented as an entity so querying it directly is not an option.
In Listing 6-1, we show a couple of ways to get just the underlying keys without materializing the entities
on each side of the association.

The first approach in Listing 6-1 uses nested from clauses to retrieve the organizers for each event.
Using the Organizers navigation property on the instances of the Event entity leverages the underlying
link table to enumerate all the organizers for each of the events. We reshape the results to the pairs of
corresponding keys for the entities. Finally, we iterate through the results, printing the pair of keys to the
console.

In the second approach, we use the SelectMany() method to project the organizers for each event
into the pairs of keys for the events and organizers. As with the nested from clauses, this approach uses
the underlying link table through the Organizers navigation property. We iterate through the results in
the same way as with the first approach.
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6-2. Exposing a Link Table as an Entity

Problem

You want to expose a link table as an entity instead of a many-to-many association.

Solution

Let’s say your database has a many-to-many relationship between workers and tasks and looks
something like the one in the database diagram in Figure 6-3.

Worker (Chapter6) WorkerTask (Chapter6) Task (Chapter6)
% WorkerId e e | % WorkerId becsees Cm | ¥ Taskld
Mame ¥ Taskld Title

Figure 6-3. A many-to-many relationship between workers and tasks

The WorkerTask link table contains nothing more than the foreign keys supporting the many-to-many
relationship. When we import these tables into our model, the designer will create two entities with a
many-to-many association as shown in Figure 6-4.

. Task 2 ¢ Worker ES
= Properties = Properties
4 Taskld # Workerld
ﬁ] Title * * ﬁ] Mame
=l Navigation Properties =l Navigation Properties
3_—1 Workers 3_—1 Tasks

Figure 6-4. A many-to-many association between the Worker and Task entities

To convert the association to an entity representing the WorkerTask link table, follow these steps.

1. Delete the many-to-many association created by the designer. To delete the
association, right-click the link and select Delete. When prompted to delete the
WorkerTask table from the underlying store model, click No (see Figure 6-5).

2. Right-click the design surface and select Add » Entity. Name the new entity
WorkerTask and uncheck the Create key property box.

3. Right-click the WorkerTask entity and select Add » Scalar property. Rename
the property WorkerId. Repeat this step, adding TasklId scalar property.
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4. Right-click each scalar property and select Properties. Change the type for
each property from String to Int32. Mark both properties as entity key
properties by right-clicking the property and selecting Entity Key.

5. Select the WorkerTask entity. In the Mapping Details window select
WorkerTask in the Add Table or View drop-down control. This maps the entity
to the WorkerTask table.

6. Map the WorkerlId and TasklId properties to the WorkerId column and TaskId
columns, respectively. See Figure 6-6.

7. Right-click the design surface and select Add » Association to add a one-to-
many association between the Task entity and the WorkerTask entity. Make
sure that WorkerTask is on the many side of the association. Be sure to
uncheck the Add foreign key properties check box because we’ve already
created the foreign key properties. Repeat this step to create a one-to-many
association between the Worker entity and the WorkerTask entity.

8. Now we need to create a referential constraint between the Task entity and the
WorkerTask entity. This will complete the foreign key association between
these entities. Right-click the association link and select Properties. In the
properties for the association, click the Referential Constraint box. In the
dialog box, choose Task as the Principal and WorkerTask as the Dependent.
Choose Taskld as the Principal Key and TasklId as the Dependent Key. See
Figure 6-7. Repeat this step to build the referential constraint for the
association between the Worker entity and the WorkerTask entity.

The final model should look like the one in Figure 6-8.

Delete Unmapped Tables and Views | ? 22 |

The following tables and views in the store model will no longer be mapped. Do you
want them deleted?

WorkerTask

[ Ys || N || conce |

Figure 6-5. Answer No, don'’t delete the underlying WorkerTask table from the store model
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Mapping Details - WorkerTask

Column Oper... Value/ Property

E | 4 Tables
4 [ Maps to WorkerTask
EY <Add a Condition>
4 [ Column Mappings
2] Workerld : int
@] Taskld: int
B <Add a Table or View>

¥ Workerd : Int32
#4 Taskld : String

te

E UEEENEEE R [, Error List B Output

Figure 6-6. Mapping the WorkerTask table to the WorkerTask entity in the Mapping Details window.
Make sure that the Workerld column is mapped to the Workerld property and the Taskld property is
mapped to the Taskld column.

Referential Constraint | ? 22 |

Principal:

e
WorkerTask

Principal Key Dependent Property
Taskld Taskld

L S

Figure 6-7. Building the referential constraint between the Task entity and the WorkerTask entity. Taskld
is the key on both sides of the constraint.

(2: Task (2: WorkerTask (3 %2 Worker
= Properties = Properties = Properties
4 Taskld - - 5 Workerld - A ¥ workerdd
2 Title 1 | ¥ Taskd * 1| B Name
= Mavigation Properties = Mavigation Properties = Mavigation Properties
'—z%l WorkerTask '—z%l Taszk '—z%l WorkerTask
e = Worker

Figure 6-8. The completed model with the WorkerTask link table exposed as an entity in two one-to-many
associations
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How It Works

When a payload-free link table in a many-to-many relationship is imported into a model, the designer
will create entities to represent the related tables and will represent the link table as a many-to-many
association. During the application development lifecycle, developers often find the need to add payload
to the many-to-many associations that started life payload-free. In this recipe, we show how to surface
the many-to-many association as a separate entity so that additional scalar properties (i.e., payload) can
be added.

Of course, if your many-to-many relationship started life with a payload, the designer will create a
model similar to the one shown in Figure 6-8 when it is imported. Many developers choose to assume
that all many-to-many relationships will ultimately hold a payload and create a synthetic key for the link
table rather than the traditional composite key formed by combining the foreign keys. This new key
becomes a payload and now, when imported, the designer will start off with a model like the one shown
in Figure 6-8.

The downside to our new model is that we do not have a simple way to navigate the many-to-many
association. We have two one-to-many associations that require an additional hop through the linking
entity. The code in Listing 6-2 demonstrates this additional bit of work on both the insert side and the
query side.

Listing 6-2. Inserting into and retrieving Task and Worker entities
using (var context = new EFRecipesEntities())

var worker = new Worker { Name = "Jim" };

var task = new Task { Title = "Fold Envelopes" };

var workertask = new WorkerTask { Task = task, Worker = worker };
context.WorkerTasks.AddObject (workertask);

task = new Task { Title = "Mail Letters" };

workertask = new WorkerTask { Task = task, Worker = worker };
context.WorkerTasks.AddObject (workertask);

worker = new Worker { Name = "Sara" };

task = new Task { Title = "Buy Envelopes” };

workertask = new WorkerTask { Task = task, Worker = worker };

context.WorkerTasks.AddObject (workertask);
context.SaveChanges();

}
using (var context = new EFRecipesEntities())

context.ContextOptions.LazylLoadingEnabled = true;
Console.WriteLine("Workers and Their Tasks");
Console.WriteLine(" ");
foreach (var worker in context.Workers)

{

Console.WriteLine("\n{0}'s tasks:", worker.Name);
foreach (var wt in worker.WorkerTasks)

Console.WriteLine("\t{0}", wt.Task.Title);
}
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The code in Listing 6-2 produces the following output:

Workexrs and Their Tasks

Jim's tasks:
Fold Envelopes

Mail Letters

Sara's tasks:

Buy Envelopes

6-3. Modeling a Many-to-Many, Self-Referencing
Relationship

Problem

You have a table with a many-to-many relationship with itself and you want to model this table and
relationship.

Solution

Let’s say you have a table that has relationship to itself using a link table, as shown in Figure 6-9.

Product (Chapter6) 5 - RelatedProduct (Chapter6)
% Productld % Productld
Mame a—— ¥ RelatedProductld

Price

Figure 6-9. A table with a many-to-many relationship to itself

To create a model, do the following:
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1. Add anew ADO.NET Entity Data Model to your project and import the Product
and RelatedProduct tables.

2. Rename the Productl navigation property to RelatedProducts. Rename the
Products2 navigation property to OtherRelatedProducts.

The completed model is shown in Figure 6-10.

>

“¢  Product

= Properties
# productld
ﬁ] Mame
ﬁ] Price
= Navigation Properties
3_—1 RelatedProducts
3_—1 OtherRelatedProducts

* *

Figure 6-10. Product entity with a many-to-many association with itself

How It Works

As you can see, the Entity Framework designer supports a many-to-many, self-referencing association
with little effort. We imported the existing table and changed the navigation property names to
something more appropriate.

The code in Listing 6-3 inserts a few related products and retrieves the related products. To retrieve
all the related products for a given product, we need to traverse both the RelatedProducts navigation
property and the OtherRelatedProducts navigation property.

Tent is related to Ground Cover through the RelatedProducts navigation property because we added
Ground Cover to Tent’s RelatedProducts collection. Pole is related to Tent through Tent’s
OtherRelatedProducts collection because we added Tent to Pole’s RelatedProducts collection. The
associations go both ways. In one direction, it’s a related product. In the other direction, it’s an
OtherRelatedProduct.

Listing 6-3. Retrieving the related products

using (var context = new EFRecipesEntities())

var productl = new Product { Name = "Pole", Price = 12.97M };

var product2 = new Product { Name = "Tent", Price = 199.95M };

var product3 = new Product { Name = "Ground Cover", Price = 29.95M };
product2.RelatedProducts.Add(product3);
producti.RelatedProducts.Add(product2);
context.Products.AddObject(product1);

context.SaveChanges();
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using (var context = new EFRecipesEntities())

var product2 = context.Products.Include("RelatedProducts")
.Include("OtherRelatedProducts")
.First(p => p.Name == "Tent");
Console.WriteLine("Product: {0} ... {1}", product2.Name,
product2.Price.ToString("C"));
Console.WriteLine("Related Products");
foreach (var prod in product2.RelatedProducts)

Console.WriteLine("\t{0} ... {1}", prod.Name, prod.Price.ToString("C"));
foreach (var prod in product2.OtherRelatedProducts)

Console.WriteLine("\t{0} ... {1}", prod.Name, prod.Price.ToString("C"));
}

The output of Listing 6-3 is the following:

Product: Tent ... $199.95
Related Products
Ground Cover ... $29.95

Pole ... $12.97

The code in Listing 6-3 retrieves only the first level of related products. If we assume that the
“related products” relationship is transitive, we might want to form the transitive closure. The transitive
closure would be all related products regardless of how many hops away they may be. In an eCommerce
application, the first level of related products could be created by product specialists. Additional levels
could be derived by computing the transitive closure. The end result would allow the application to
show the familiar “...you may also be interested in ...” message we often see during the checkout
process.

In Listing 6-4, we use a recursive method to form the transitive closure. In traversing the both the
RelatedProducts and OtherRelatedProducts associations we need to be careful not to get stuck in a cycle.
If product A is related to B, and B is related to A, our application would get trapped in the recursion. To
detect cycles, we use a Dictionary<> to help prune off paths we have already traversed.

Listing 6-4. Forming the transitive closure of the “Related Products” relationship

static void RunExample2()

{
using (var context = new EFRecipesEntities())
var productl = new Product { Name = "Pole", Price = 12.97M };
var product2 = new Product { Name = "Tent", Price = 199.95M };

var product3 = new Product { Name = "Ground Cover", Price = 29.95M };
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product2.RelatedProducts.Add(product3);
producti.RelatedProducts.Add(product2);
context.Products.AddObject(product1);
context.SaveChanges();

}
using (var context = new EFRecipesEntities())

var productl = context.Products.First(p => p.Name == "Pole");
Dictionary<int, Product> t = new Dictionary<int, Product>();
GetRelated(producti, t);

Console.WriteLine("Products related to {0}", producti.Name);
foreach (var key in t.Keys)

{
Console.WriteLine("\t{0}", t[key].Name);
}
}
}
static void GetRelated(Product p, Dictionary<int, Product> t)
{
p.RelatedProducts.Lload();
foreach (var relatedProduct in p.RelatedProducts)
if (!t.ContainsKey(relatedProduct.ProductId))
t.Add(relatedProduct.ProductId, relatedProduct);
GetRelated(relatedProduct, t);
}
}
p.OtherRelatedProducts.Load();
foreach (var otherRelated in p.OtherRelatedProducts)
if (!t.ContainsKey(otherRelated.ProductId))
t.Add(otherRelated.ProductId, otherRelated);
GetRelated(otherRelated, t);
}
}
}

In Listing 6-4, we use the Load() method (see the Recipes in Chapter 5) to ensure that the collections
of related products are loaded. Unfortunately, this means we will end up with many additional round
trips to the database. We might be tempted to load all the rows from the Product table up front and hope
that relationship span would fix up the associations. However, relationship span will not fix up entity
collections, only entity references. Because our associations are many-to-many (entity collections), we
cannot rely on relationship span to help out and we have to resort to using the Load() method.

Following is the output of the code in Listing 6-4. From the first block of code that inserts the
relationships, we can see that a Pole is related to a Tent, and a Tent is related to Ground Cover. The
transitive closure for the products related to a Pole includes a Tent, Ground Cover, and Pole. Pole is
included because it is on the other side of the relationship with Tent, which is a related product.
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Products related to Pole
Tent
Ground Cover

Pole

6-4. Modeling a Self-Referencing Relationship Using Table
per Hierarchy Inheritance

Problem

You have a table that references itself. The table represents several different but related kinds of objects
in your database. You want to model this table using table per hierarchy inheritance.

Solution

Suppose you have a table like the one in Figure 6-11 that describes some things about people. People
often have a hero, perhaps the individual who inspired them the most. We can represent a person’s hero
with a reference to another row in the Person table.

Each person has some role in life. Some people are firefighters. Some people are teachers. Some
people are retired. Of course, there could be many other roles. Information about people can be specific
to their roles. A firefighter is stationed at a firehouse. A teacher teaches at a school. A retired person often
has a hobby.

Person (Chapter6)
# Personld
Name
FireStation
School
FulTimeHobby
Role
Herold

Figure 6-11. Person table containing people with different roles

For our example, the possible roles are firefighter (f), teacher (t), or retired (r). The role for a person is
indicated by a single character in the role column.
To create a model, do the following:
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Add a new ADO.NET Entity Data Model to your project and import the Person
table.

Right-click the design surface and select Add » Entity. Name the new entity
Firefighter and select Person as the base type. Repeat this step, creating
derived entities for Teacher and Retired.

Move the FireStation property from the Person entity to the Firefighter entity.
Move the School property from the Person entity to the Teacher entity. Finally,
move the FullTimeHobby property from the Person entity to the Retired entity.
You can use Cut/Paste to move these scalar properties.

Right-click the Person entity and view its properties. Change the Abstract value
to true. This marks the Person entity as an abstract entity.

Rename the Personl navigation property on the Person entity to Fans. This
navigation property represents the person’s fans (people who consider this
person a hero). Rename the Person2 navigation property to Hero.

Select the Firefighter entity. In the Mapping Details window, select Add a Table
or View to map the entity to the Person table.

In the Mapping Details window for the Firefighter entity, select Add a
Condition. Add the condition for Role = f to conditionally map the Person
table to Firefighter entity when the Role column contains the letter ‘f.

Repeat steps 6 and 7 for the Teacher and Retired entities using the conditions
Role = t andRole = r, respectively.

Remove the Role property from the Person entity.

The resulting model should look like the one in Figure 6-12.

-k; Retired

=* Person
=l Properties
2 FullTimeHobby

0.1 *
#2 Person ES
= Properties
‘?ﬁf Personld
ﬁ“ MName
F Hereld
£ ﬁ‘ <+ Firefighter E3
= Mavigation Properties * 3 Person
&
‘:»'{ Fans = Properties
B H ~
S Hero 7 FireStation

= Navigation Properties =l Navigation Properties

-); Teacher ES
=* Person

=l Properties

5 School

= Navigation Properties

Figure 6-12. A model for the Person type and derived types
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How It Works

The code in Listing 6-5 demonstrates inserting and retrieving from our model. We create a single
instance of each of the derived types and wire in a few hero relationships. We have a teacher who is the
hero of a firefighter and a retired person who is the hero of the teacher. When we set the firefighter as the
hero of the retired person we introduce just enough of a cycle so that Entity Framework generates a
runtime error (an UpdateException) because it cannot determine the appropriate order for inserting the
rows into the table. In the code, we get around this problem by calling the SaveChanges () method before
wiring in any of the hero relationships. Once the rows are committed to the database, and the store-
generated keys are brought back into the object graph, we are free to update the graph with the
relationships. Of course, these changes must be saved with a final call to SaveChanges ().

Listing 6-5. Inserting into and retrieving from our model
using (var context = new EFRecipesEntities())

var teacher = new Teacher { Name = "Susan Smith",
School = "Custer Baker Middle School" };
var firefighter = new Firefighter { Name = "Joel Clark",
FireStation = "Midtown" };
var retired = new Retired { Name = "Joan Collins",
FullTimeHobby = "Scapbooking” };
context.People.AddObject(teacher);
context.People.AddObject(firefighter);
context.People.AddObject(retired);
context.SaveChanges();
firefighter.Hero = teacher;
teacher.Hero = retired;
retired.Hero = firefighter;
context.SaveChanges();

}
using (var context = new EFRecipesEntities())

context.ContextOptions.LazyloadingEnabled = true;
foreach(var person in context.People)

if (person.Hero != null)
Console.WriteLine("\n{0}, Hero is: {1}", person.Name,
person.Hero.Name);
else
Console.WriteLine("{0}", person.Name);
if (person is Firefighter)
Console.WriteLine("Firefighter at station {0}",
((Firefighter)person).FireStation);
else if (person is Teacher)
Console.WriteLine("Teacher at {0}", ((Teacher)person).School);
else if (person is Retired)
Console.WriteLine("Retired, hobby is {0}",
((Retired)person).FullTimeHobby);
Console.WriteLine("Fans:");
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foreach (var fan in person.Fans)

{
}

Console.WriteLine("\t{0}", fan.Name);

The output from the code in Listing 6-5 is the following:

Susan Smith, Hero is: Joan Collins
Teacher at Custer Baker Middle School
Fans:

Joel Clark

Joel Clark, Hero is: Susan Smith
Firefighter at station Midtown
Fans:

Joan Collins

Joan Collins, Hero is: Joel Clark
Retired, hobby is Scapbooking
Fans:

Susan Smith
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6-5. Modeling a Self-Referencing Relationship and Retrieving
a Complete Hierarchy

Problem

You are using a self-referencing table to store hierarchical data. Given a record, you want to retrieve all
associated records that are part of that hierarchy any level deep.

Solution

Suppose you have a Category table like the one in the database diagram in Figure 6-13.

Category (Chapter6)

¥ Categoryld
Name
ParentCategoryld

o

Figure 6-13. Self-referencing Category table

To create our model, do the following:

1.  Add anew ADO.NET Entity Data Model to your project and import the
Category table.

2. Change the navigation property Categoryl to Subcategories. This property
holds the collection of entities that are subcategories of this entity instance.

3. Change the Category2 navigation property to ParentCategory. This navigation
property references the parent category entity instance.

The resulting model should look like the model in Figure 6-14.
s Category S

= Properties
#4 Categoryld
ﬁ] Mame
f ParentCategoryld

Navigation Properties

= sube ategories

Bl ParentCategory

0.1 |

Figure 6-14. Model including the self-referencing Category entity
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In our model, the Category entity has a Subcategories navigation property we can use to get the
collection of all the immediate subcategories of the Category. However, to access them we need to
explicitly load them either using the Load() or the Include() methods. The Load() method requires an
additional round trip to the database, while the Include() method provides only a predefined, limited

depth.

We want to bring the entire hierarchy into the object graph as efficiently as possible. To do this, we
use a Common Table Expression in a stored procedure.
To add the stored procedure to our model, do the following:

1.

Create a stored procedure called GetSubCategories() that makes use ofa
Common Table Expression to return all the subcategories for a Categoryld.
The stored procedure is shown in Listing 6-6.

Right-click the design surface and select Update Model from Database. Select
the GetSubCategories stored procedure.

Now we need to add the stored procedure to the conceptual model. Open the
Model Browser window. If the Model Browser window is not visible, select
View » Other Windows » Entity Data Model Browser. Expand the Store model
and the Stored Procedures levels. Right-click the GetSubCategories stored
procedure and select Add Function Import. On the window, make sure
GetSubCategories stored procedure is selected and leave the function Import
Name as it is. Set the return type of the stored procedure to Category in the
Entities box. Figure 6-15 shows the Add Function Import dialog box with the
correct values.

Function Import Name:

GetSubCategories

Stored Procedure Name:

GetSubCategories

) None

Returns a Collection Of

© Scalars:
©) Complex

@ Entities:

Stored Procedure Column Information

Get Column Information

[category -

Figure 6-15. Add Function Import dialog box, importing the GetSubCategories() stored procedure into

conceptual layer
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Listing 6-6. The GetSubCategories() stored procedure that returns subcategories for a given Categoryld

create proc chapter6.GetSubCategories
(@categoryid int)

as

begin

with cats as

select c1.*

from chapter6.Category c1

where Categoryld = @categoryid

union all

select c2.*

from cats join chapter6.Category c2 on cats.Categoryld = c2.ParentCategoryld

select * from cats where Categoryld != @categoryid
end

With the GetSubCategories() stored procedure imported into the conceptual model, Entity
Framework now exposes a GetSubCategories() method on the object context. We can use this method to
materialize our entire graph of categories and subcategories. The code in Listing 6-7 demonstrates the
use of the GetSubCategories() method.

Listing 6-7. Retrieving the entire hierarchy using the GetSubCategories() method

using (var context = new EFRecipesEntities())

var book = new Category { Name = "Books" };

var fiction = new Category { Name = "Fiction", ParentCategory = book };

var nonfiction = new Category { Name = "Non-Fiction", ParentCategory = book };
var novel = new Category { Name = "Novel", ParentCategory = fiction };

var history = new Category { Name = "History", ParentCategory = nonfiction };
context.Categories.AddObject(book);

context.SaveChanges();

}

using (var context = new EFRecipesEntities())
var root = context.Categories.Where(o => o.Name == "Books").First();
Console.WriteLine("Parent category is {0}, subcategories are:", root.Name);

foreach (var sub in context.GetSubCategories(root.CategoryId))

{
}

Console.WriteLine("\t{0}", sub.Name);

The output from the code in Listing 6-7 is the following:
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Parent category is Books, subcategories are:
Fiction
Non-Fiction
History

Novel

How It Works

Entity Framework supports self-referencing associations, as we have seen in Recipes 6.2 and 6.3. In these
recipes, we directly loaded the entity references and collections using the Load() method. We cautioned,
however, that each Load() results in a round trip to the database to retrieve an entity or entity collection.
For larger object graphs, this database traffic may consume too many resources.

In this recipe, we demonstrated a slightly different approach. Rather than explicitly using Load() to
materialize each entity or entity collection, we pushed the work off to the storage layer by using a stored
procedure to recursively enumerate all the subcategories and return the collection. We used a Common
Table Expression in our stored procedure to implement the recursive query. In our example, we chose to
enumerate all the subcategories. You could, of course, modify the stored procedure to selectively
enumerate elements of the hierarchy.

To use our stored procedure, we first imported it into the model. Then, using the Add Function
Import, we added the imported stored procedure to the conceptual layer. Once added, the stored
procedure was mapped by Entity Framework to a new method, GetSubCategories(), which was available
in the data context. On the conceptual side, the stored procedure is represented in the code snippet
shown in Listing 6-8.

Listing 6-8. GetSubCategories() store procedure represented in the conceptual layer

<Function Name="GetSubCategories" Aggregate="false" BuiltIn="false"
NiladicFunction="false" IsComposable="false"
ParameterTypeSemantics="AllowImplicitConversion” Schema="Chapter6">
<Parameter Name="categoryid" Type="int" Mode="In" />
</Function>

Based on the signature of the stored procedure represented in the FunctionImport tag, Entity
Framework will generate a method in the object context to make the stored procedure available to the
application.
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6-6. Mapping Null Conditions in Derived Entities

Problem

You have a column in a table that allows null. You want to create a model using Table per Hierarchy
inheritance with one derived type representing instances in which the column has a value and another
derived type representing instances in which the column is null.

Solution

Let’s say you have a table describing experimental medical drugs. The table contains a column
indicating when the drug was accepted for production. Until the drug is accepted for production, it is
considered experimental. Once accepted, it is considered a Medicine. We'll start with the Drug table in
the database diagram in Figure 6-16.

Drug (Chapter6)
% Drugld
Name
TargetPrice
PrincipalResearcher
AcceptedDate

Figure 6-16. Drug table with the nullable discriminator column, AcceptedDate

To create a model using the Drug table, do the following:

1. Add anew ADO.NET Entity Data Model to your project and import the Drug
table.

2. Create the Experimental derived entity by right-clicking the design surface and
selecting Add » Entity. Name the entity Experimental. Select Drug as the base
type. Repeat this step to create the Medicine entity.

3. Move the PrincipalResearcher property from the Drug entity to the
Experimental entity. Move the TargetPrice and AcceptedDate properties from
the Drug entity to the Medicine entity. You can use Cut/Paste to move
properties between entities.

4. Mark the Drug entity as abstract. Right-click the Drug entity and select
Properties. Set the Abstract property to true.

5. Select the Medicine entity. In the Mapping Details window, map the entity to
the Drug table by selecting Add a Table or View and choosing the Drug table.
Select Add a Condition and add the AcceptedDate is Not Null condition.

6. Repeat step 5 for the Experimental entity. This time, set the condition to
AcceptedDate Is Null.
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7. Because all instances of Medicine will have a value for the AcceptedDate
property, we need to set the Nullable attribute of this scalar property to False.
This is a key step. Right-click the AcceptedDate property in the Medicine
entity. Select Properties and change the Nullable attribute to False.

The completed model is shown in Figure 6-17.

>

“: Drug

= Properties
# Drugld
ﬁ] Mame

=l Navigation Properties

_

“¢  Medicine S 'W
=* Drug =* Drug
=l Properties = Properties
% TargetPrice 5 PrincipalResearcher
5 AcceptedDate = Navigation Properties

=l Navigation Properties

Figure 6-17. The model for the Experimental and Medicine derived types

How It Works

In this example, we made use of the null and is not null conditions to map a Drug without an
AcceptedDate to an Experimental drug and a Drug with an AcceptedDate to a Medicine. As in many
inheritance examples, we marked the base entity, Drug, as abstract because in our model we would
never have an uncategorized drug.

It is interesting to note that in the Medicine entity we mapped the AcceptedDate discriminator
column to a scalar property. In most scenarios, mapping the discriminator column to scalar property is
prohibited. However, in this example, our use of the null and is not null conditions, as well as marking
the AcceptedDate as not nullable, sufficiently constrains the values for property to allow the mapping.

In Listing 6-9, we insert a couple of Experimental drugs and query the results. We take the
opportunity provided by the exposed AcceptedDate property to demonstrate one way to change an
object from one derived type to another. In our case, we create a couple of Experimental drugs and then
promote one of them to a Medicine.

Listing 6-9. Inserting and retrieving instances of our derived types

class Program

{
static void RunExample()

using (var context = new EFRecipesEntities())
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var exDrugl = new Experimental { Name = "Nanoxol",
PrincipalResearcher = "Dr. Susan James" };

var exDrug2 = new Experimental { Name = "Percosol”,
PrincipalResearcher = "Dr. Bill Minor" };

context.Drugs.AddObject (exDrugl);

context.Drugs.AddObject (exDrug2);

context.SaveChanges();

// Nanoxol just got approved!
exDrugl.PromoteToMedicine(DateTime.Now, 19.99M, "Treatall");
context.Detach(exDrugl); // better not use this instance any longer

}
using (var context = new EFRecipesEntities())

Console.WriteLine("Experimental Drugs");
foreach (var d in context.Drugs.0fType<Experimental>())

{
}

Console.WriteLine("Medicines");
foreach (var d in context.Drugs.0fType<Medicine>())

Console.WriteLine("\t{o} ({1})", d.Name, d.PrincipalResearcher);

Console.WriteLine("\t{0} Retails for {1}", d.Name,
d.TargetPrice.Value.ToString("C"));

}

public partial class Experimental

public void PromoteToMedicine(DateTime acceptedDate, decimal targetPrice,
string marketingName)
{

var drug = new Medicine { Drugld = this.DrugId };
using (var context = new EFRecipesEntities())

context.AttachTo("Drugs", drug);
drug.AcceptedDate = acceptedDate;
drug.TargetPrice = targetPrice;
drug.Name = marketingName;
context.SaveChanges();

We change an Experimental drug to a Medicine using the PromoteToMedicine() method. In the
implementation of this method, we create a new Medicine instance, attach it to a new ObjectContext,
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and initialize it with the appropriate new values. Once the new instance is attached and initialized, we
use the SaveChanges() method on the ObjectContext to save the new instance to the database. Because
the instance has the same key (Drugld) as the Experimental drug, Entity Framework generates an update
statement rather than an insert statement.

We implemented the PromoteToMedicine() method inside the partial class Experimental. This allows
us to seamlessly add the method to the class and provides for a much cleaner implementation.

The following is the output of the code in Listing 6-9:
Experimental Drugs

Percosol (Dr. Bill Minor)

Medicines

Treatall Retails for $19.99

6-7. Modeling Table per Type Inheritance Using a Non-
Primary Key Column

Problem

You have one or more tables that have a one-to-one relationship to a common table using keys that are
not primary keys in the tables. You want to model this using Table per Type inheritance.

Solution

Let’s say your database contains the tables shown in the database diagram in Figure 6-18.

Staff (Chapter6)
@ staffid
MName
¢ ¢
§ §
Principal (Chapter6) Instructor (Chapter6)
# Principalld @ Instructorld
Salary Salary
Bonus Staffld
Staffld

Figure 6-18. A database diagram containing Staff, Principal, and Instructor tables
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In Figure 6-18, we have a Staff table containing the name of the staff member and two related tables
containing information about Principals and Instructors. The important thing to notice here is that the
Principal and Instructor tables have primary keys that are not the foreign keys for the Staff table. This
type of relationship structure is not directly supported in Table per Type inheritance. For Table per
Type, the related tables’ primary keys must also be the foreign key for the primary (base) table. Also
notice that the relationship is one-to-one. This is because we have constrained the Staffld columns in
the Principal and Instructor tables to be unique by creating a unique index on this column in both
tables.

To model the tables and relationships in Figure 6-18 using Table per Type inheritance, do the
following:

1. Add anew ADO.NET Entity Data Model to your project and import the Staff,
Principal, and Instructor tables.

2. Delete the associations between the Principal and the Staff entities and
between the Instructor and the Staff entities.

3. Right-click the Staff entity and choose Add » Inheritance. Select Staff as the
base entity and Principal as the derived entity. Repeat this step by selecting
Staff as the base entity and Instructor as the derived entity.

4. Delete the StaffId property from the Instructor and Principal entities.

5. Right-click the Staff entity and choose Properties. Set the Abstract attribute to
True. This marks the Staff entity as abstract.

6. Because the Staffld is not the primary key in either the Principal or the
Instructor tables, we cannot use the default table mapping to map the
Principal, Instructor, or Staff entities. Select each entity, view the Mapping
Details window, and delete the table mapping. Repeat this for each entity.

7. Create the stored procedures in Listing 6-10. We will map these procedures to
the Insert, Update, and Delete actions for the Principal and Instructor entities.

8. Right-click the design surface and select Update Model from Database. Add
the stored procedures you created in step 7.

9. Select the Principal entity and view the Mapping Details window. Click the
Map Entity to Functions button. This is the bottom button on the left of the
Mapping Details window. Map the Insert, Update, and Delete actions to the
stored procedures. Make sure you map the result columns Staffld and
Principalld from the Insert action. See Figure 6-19.

10. Repeat step 9 for the Instructor entity. Be sure to map the result columns
Staffld and InstructorId from the Insert action.

11. Right-click the .edmx file in the Solution Explorer and select Open With » XML
Editor. This will close the designer and open the .edmx file in the XML editor.
Scroll down to <EntityContainerMapping> tagin the mapping layer. Insert the
QueryView in Listing 6-11 into the <EntitySetMapping> tag.
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Mapping Details - Principal

Parameter / Column Operator  Property Use Origin... Rows Affected Pa...
4 Functions
4 [ ] Insert Using InsertPrincipal

4 [ Parameters

@] Mame : varchar +— % Narme : String

@l Salary: decimal +— 5 Salary : Decimal

@l Bonus: decimal  + % Bonus : Decimal
4 [ Result Column Binding:

2 Staffld -+ 4 Staffld : Int32

E& Principalld —+ 5 Principalld : Int32

E <Add Result Binding>
4 7] Update Using UpdatePrinci
4 [ Parameters
@] Mame : varchar
@l Salary: decimal
@] Bonus : decimal
i@ Staffld : int
@l Principalld : int
4 [ Result Column Binding:
E <Add Result Binding>
4 [7] Delete Using DeletePrincipz
4 [ Parameters
i@ Staffld : int — 4 Staffld : Int32

% Narme : String
5 Salary : Decimal
% Bonus : Decimal
4 Staffld : Int32
5 Principalld : Int32

ttrrt

ooooo

Figure 6-19. Insert, Update, and Delete actions mapped for the Principal entity

Listing 6-10. Stored procedures for the Insert,Update, and Delete Actions for the Instructor and Principal
entities

create procedure [chapter6].[InsertInstructor]
(@Name varchar(50), @Salary decimal)

as
begin
declare @staffid int
insert into Chapter6.Staff(Name) values (@Name)
set @staffid = SCOPE_IDENTITY()
insert into Chapter6.Instructor(Salary,StaffId) values (@Salary,@staffid)
select @staffid as StaffId,SCOPE_IDENTITY() as InstructorId
end
go

create procedure [chapter6].[UpdateInstructor]
(@Name varchar(50), @Salary decimal, @StaffId int, @InstructorId int)

as
begin
update Chapter6.Staff set Name = @Name where StaffId = @Staffld
update Chapter6.Instructor set Salary = @Salary where InstructorId =
@InstructorId
end
go
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create procedure [chapter6].[DeleteInstructor]
(@StaffId int)

as
begin
delete Chapter6.Staff where Staffld = @StaffId
delete Chapter6.Instructor where Staffld = @StaffId
end
go

create procedure [Chapter6].[InsertPrincipal]
(@Name varchar(50),@Salary decimal,@Bonus decimal)
as
begin

declare @staffid int

insert into Chapter6.Staff(Name) values (@Name)

set @staffid = SCOPE_IDENTITY()

insert into Chapter6.Principal(Salary,Bonus,StaffId) values
(@Salary,@Bonus,@staffid)

select @staffid as StaffId, SCOPE_IDENTITY() as Principalld
end

go

create procedure [Chapter6].[UpdatePrincipal]
(@Name varchar(50),@Salary decimal, @Bonus decimal, @StaffId int, @Principalld int)
as
begin
update Chapter6.Staff set Name = @Name where StaffId = @Staffld
update Chapter6.Principal set Salary = @Salary, Bonus = @Bonus where
Principalld = @Principalld
end

go

create procedure [Chapter6].[DeletePrincipal]
(@Staffld int)

as
begin
delete Chapter6.Staff where Staffld = @StaffId
delete Chapter6.Principal where Staffld = @StaffId
end

Listing 6-11. QueryView for the Instructor and Principal entities

<EntitySetMapping Name="Staffs">
<QueryView>

select value
case
when (i.StaffId is not null) then
EFRecipesModel. Instructor(s.StaffId,s.Name,i.InstructorId,i.Salary)
when (p.StaffId is not null) then
EFRecipesModel.Principal(s.StaffId,s.Name,p.Principalld,p.Salary,p.Bonus)
END
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from EFRecipesModelStoreContainer.Staff as s
left join EFRecipesModelStoreContainer.Instructor as i
on s.Staffld = i.StaffId
left join EFRecipesModelStoreContainer.Principal as p
on s.StaffId = p.StaffId
</QueryView>
</EntitySetMapping>

How It Works

With Table per Type inheritance, Entity Framework requires that the foreign key for the base entity’s
table be the primary keys in the derived entity’s table. In our example, each of the tables for the derived
entities have separate primary keys.

To create a Table per Type inheritance model, we started at the conceptual level by deriving the
Principal and Instructor entities from the Staff entity. Next, we deleted the mappings created when we
imported the table. We then used a QueryView expression to create the new mappings. Using QueryView
pushed the responsibility for the Insert, Update, and Delete actions onto our code. To handle these
actions, we used traditional stored procedures in the database.

We used QueryView to supply the mappings from our underlying tables to the scalar properties
exposed by our derived entities. The key part of the QueryView is the case statement. There are two
cases: either we have a Principal or we have an Instructor. We have an Instructor if the Instructor’s
Staffld is not null. Or, we have a Principal if the Principal’s Staffld is not null. The remaining parts of the
expression bring in the rows from the derived tables.

The code in Listing 6-12 inserts a couple of Principals and one Instructor into our database.

Listing 6-12. Inserting into and retrieving from our model
using (var context = new EFRecipesEntities())

var principal = new Principal { Name = "Robbie Smith",

Bonus = 3500M, Salary = 48000M };
var instructor = new Instructor { Name = "Joan Carlson",

Salary = 39000M };
context.Staffs.AddObject(principal);
context.Staffs.AddObject(instructor);
context.SaveChanges();

}
using (var context = new EFRecipesEntities())
Console.WriteLine(" Prlnc1pals );
Console.WriteLine("==========");
foreach (var p in context.Staffs.0fType<Principal>())
Console.WriteLine("\t{0}, Salary: {1}, Bonus: {2}",
p.Name, p.Salary.ToString("C"),
p.Bonus.ToString("C"));

Console.WriteLine(" Instructors") ;
Console. Writeline("===========");
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foreach (var i in context.Staffs.0fType<Instructor>())

{
}

Console.WriteLine("\t{0}, Salary: {1}", i.Name, i.Salary.ToString("C"));
}

The following is the output of the code in Listing 6-12:

Principals

Robbie Smith, Salary: $48,000.00, Bonus: $3,500.00

Instructors

Joan Carlson, Salary: $39,000.00

6-8. Modeling Nested Table per Hierarchy Inheritance

Problem

You want to model a table using more than one level of Table per Hierarchy Inheritance.

Solution

Suppose we have an Employee table that contains various types of employees such as Hourly and
Salaried Employee, as shown in Figure 6-20.

Employee (Chapter6)
% Employeeld
Name
Rate
Hours
Salary
Commission

EmployeeType

Figure 6-20. The Employee table containing various types of employees
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The employee table contains hourly employees, salaried employees, and commissioned employees,
which is a subtype of salaried employees. To model this table with derived types for the hourly and
salaried employees and a commissioned employee type derived from the salaried employee, do the

following:

1.

10.

Add anew ADO.NET Entity Data Model to your project and import the
Employee table.

Right-click the design surface and choose Add » Entity. Name the entity
HourlyEmployee and select Employee as the base entity. Repeat this step for
the SalariedEmployee entity. Make sure you select Employee as the base
entity.

Right-click the design surface and choose Add » Entity. Name the entity
CommissionedEmployee and select SalariedEmployee as the base type.

Right-click the Employee entity and choose Properties. Set the Abstract
property to true.

Remove EmployeeType property from Employee. This property will serve as
the discriminator column.

Move the Rate and Hours properties from the Employee entity to the
HourlyEmployee entity. You can use Cut/Paste to move the properties. Repeat
this step moving the Salary property to the SalariedEmployee entity and the
Commission property to the CommissionedEmployee entity.

Right-click the Commission property in the CommissionedEmployee entity
and select Properties. Change the nullable property to false.

Select the HourlyEmployee entity and view the Mapping Details window.
Select the Employee table in Add a Table or View. Add a condition for
EmployeeType = hourly.

Select the SalariedEmployee entity and view the Mapping Details window.
Select the Employee table in Add a Table or View. Add a condition for
EmployeeType = salaried. Add another condition for Commission is null.

Select the CommissionedEmployee entity and view the Mapping Details
window. Select the Employee table in Add a Table or View. Add a condition for
Commission is not null.

The completed model should look like the one in Figure 6-21.
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Figure 6-21. The completed model with two levels of Table per Type inheritance

How It Works

Table per Type inheritance is a flexible modeling technique. The depth and breadth of the inheritance
tree can be reasonably large and is easily implemented. This approach is efficient because no additional
tables and their required joins are involved.

We implemented the first level of the tree using simple conditions on EmployeeType. This column
served as our discriminator. We ensured mutually exclusive conditions, is null and is not null, on the
Commission property for the SalariedEmployee and CommissionedEmployee entities.

Listing 6-13 demonstrates inserting into and retrieving from our model.

Listing 6-13. Inserting and retrieving derived entities from Employee
using (var context = new EFRecipesEntities())

var hourly = new HourlyEmployee { Name = "Will Smith", Hours = 39,
Rate = 7.75M };

var salaried = new SalariedEmployee { Name = "JoAnn Woodland",
Salary = 65400M };

var commissioned = new CommissionedEmployee { Name = "Joel Clark",
Salary = 32500M, Commission = 20M };
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context.Employees.AddObject (hourly);
context. Employees.AddObject(salaried);
context.Employees.AddObject (commissioned);
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

Console.WritelLine("All Employees"),
Console.Writeline("============='
foreach (var emp in context. Employees)

if (emp is HourlyEmployee)
Console.WriteLine("{0} Hours = {1}, Rate = {2}/hour",
emp . Name,
((HourlyEmployee)emp) .Hours.Value.ToString(),
((HourlyEmployee)emp).Rate.Value.ToString("C"));
else if (emp is CommissionedEmployee)
Console.WriteLine("{0} Salary = {1}, Commission = {2}%",
emp.Name,
((CommissionedEmployee)emp).Salary.Value.ToString("C"),
((CommissionedEmployee)emp).Commission.ToString());
else if (emp is SalariedEmployee)
Console.WriteLine("{0} Salary = {1}", emp.Name,
((SalariedEmployee)emp).Salary.Value.ToString("C"));

The output of the code in Listing 6-13 is the following:

All Employees

Will Smith Hours = 39, Rate = $7.75/hour
JoAnn Woodland Salary = $65,400.00

Joel Clark Salary = $32,500.00, Commission = 20.00%
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6-9. Limiting the Values Assigned to a Foreign Key

Problem
You have several foreign key columns in a table. All these foreign keys reference a primary key column in

a single lookup table. You want to limit the values inserted into the foreign key columns to subsets of
values that are contained in the lookup table.

Solution

Suppose you have an Order table that has foreign key columns whose values come from a single Lookup
table, as shown in Figure 6-22.

Lookup (Chapter6) Order (Chapter6)
% Lookupld [ I % Orderld
Name [ 3 Amount
Value k1 e OrderStatusId
TransactionTypeld

ShippingTypeld

Figure 6-22. Order table with foreign key columns referencing a Lookup table

The columns OrderStatusld, TransactionTypeld, and ShippingTypeld are foreign keys referencing
the Lookupld column in the Lookup table. The database will constrain values for these columns to
values that exist in the Lookup table. However, these database constraints do not limit the values to the
appropriate subsets in the Lookup table.

For example, let’s say the Lookup table contains the rows shown in Figure 6-23. Lookuplds 1, 2, and
3 pertain to order status. Lookuplds 4 and 5 are shipping types. And finally, Lookuplds 6 and 7 are for
transaction types. Constraints at the database layer would prevent us for inserting a row into the Order
table with an OrderStatusld of 8, but it would not prevent us for inserting a row with an OrderStatusld of
7. From Figure 6-23, we know that an OrderStatusId of 7 makes no sense. The appropriate values should
be either 1(Ordered), 2 (Cancelled), or 3 (Shipped).

[ Results _'_1 Messages

Name Walue
OrderStatus Ordered
| OrderStatus Cancelled
OrderStatus Shipped
Shipping Type Fedex
Shipping Type UPS
TransactionType  Cash
TransactionType  Credit

=N e R =
= N e P

Figure 6-23. A typical collection of rows for our Lookup table. Notice that there are three subsets of lookup
values: one meaningful for order status, another for shipping types, and a third for transaction types.
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In the database we cannot constrain the foreign key values by subset, but in Entity Framework we
can build a model that does impose the limits we want. Follow these steps to create a model for the
tables in Figure 6-22:

1.

9.

10.

Add anew ADO.NET Entity Data Model to your project and import the Order
and Lookup tables.

Delete the three associations between Order and Lookup table.

Right-click the design surface and choose Add » Entity. Name the new entity
OrderStatus and select Lookup as the base type.

Select the OrderStatus entity and view the Mapping Details window. In Add a
Table or View, select the Lookup table. This maps the entity to the Lookup
table. Add the condition Where Name = OrderStatus.

Repeat steps 3 and 4, creating the entities ShippingType and TransactionType.
Add the conditions Name = ShippingType, and Name = TransactionType,
respectively, in the Mapping Details window. In both cases, map the new
entities to the Lookup table.

Right-click the Lookup entity and view its properties. Set the Lookup entity’s
Abstract property to True.

Right-click the Order entity and choose Add » Association to create a one-to-
many association between OrderStatus and Order. Set the multiplicity on the
Order side to Many and the multiplicity on the OrderStatus side to One.

Right-click the association between Order and OrderStatus entities and view
the association’s properties. Click the Referential Constraint box. In the
Referential Constraint dialog box, choose OrderStatus as the Principal. Set the
Dependent Property to OrderStatusId.

Repeat steps 7 and 8 for the ShippingType and TransactionType entities.

Delete the Name property from the Lookup entity.

The resulting model is shown in Figure 6-24.
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Figure 6-24. The completed model for the Order and Lookup tables

How It Works

It is common for a lookup table to be overloaded with semantically different subsets of values. In our
example, we used just one lookup table with three different kinds of values: order status, transaction
type, and shipping type. Of course, we could have created three separate lookup tables, but this
approach does not scale well and often ends up cluttering an otherwise clean database design with lots
of small lookup tables.

Overloading of a lookup table does introduce one problem. Most databases can constrain foreign
key column values to values that are contained in the related lookup tables. However, they typically
cannot constrain these values to subsets of a lookup table. In our example, the database would allow us
to set the OrderStatus column of an Order to “Cash,” which is a transaction type, not a valid order status.

We can address this problem at the conceptual level by introducing three entities derived from our
Lookup entity. These derived entities—OrderStatus, TransactionType, and ShippingType—surface the
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semantics of the Lookup table as strongly typed entities. This allows us to leverage the type system to
enforce the finer grain constraint.

The code in Listing 6-14 demonstrates inserting and retrieving orders. Notice that before we create
the orders, we grab instances of our derived Lookup entities. We use them in creating the orders.

On the query side, we use the Include() method to load Lookup instances together with the
instance of the Order entity. This is admittedly ugly. A better approach would to be load all the possible
lookup values with something as simple as context. Lookup.ToList(); then use the much cleaner syntax
foreach(var order in context.Order) to iterate through the orders. This works because the ToList()
method forces the materialization of the entire Lookup table. The entity references in each Order
instance are fixed up by Entity Framework. This is commonly known as relationship span.

Listing 6-14. Inserting into and retrieving orders
using (var context = new EFRecipesEntities())
var ordered = context.Lookups.0fType<OrderStatus>()
.First(s => s.Value == "Ordered");
context. Lookups.0fType<OrderStatus>()

First(s => s.Value == "Shipped");
var cash = context.Lookups.0fType<TransactionType>()

var shipped

.First(s => s.Value == "Cash");
var fedex = context.Lookups.0fType<ShippingType>()
.First(s => s.Value == "FedEx");

var order = new Order { Amount = 99.97M, OrderStatus = shipped,
ShippingType = fedex, TransactionType = cash };
context.Orders.AddObject(order);
order = new Order { Amount = 29.99M, OrderStatus = ordered,
ShippingType = fedex, TransactionType = cash };
context.Orders.AddObject(order);
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

context.ContextOptlons LazyloadingEnabled = true;
Console.WriteLine("Active Orders"),

Console.WriteLine("=============");
foreach (var order in context.Orders)
{

Console.WriteLine("\nOrder: {0}", order.OrderId.ToString());
Console.WriteLine("Amount: {0}", order.Amount.ToString("C"));
Console.WriteLine("Status: {0}", order.OrderStatus.Value);
Console.WritelLine("Shipping via: {0}", order.ShippingType.Value);
Console.WriteLine("Paid by: {0}", order.TransactionType.Value);

The output of Listing 6-14 is the following:
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Active Orders

Order: 15

Amount: $99.97
Status: Shipped
Shipping via: Fedex

Paid by: Cash

Order: 16

Amount: $29.99
Status: Ordered
Shipping via: Fedex

Paid by: Cash

6-10. Applying Conditions in Table per Type Inheritance

Problem

You want to apply conditions while using Table per Type inheritance.

Solution

Let’s say you have the two tables depicted in Figure 6-25. The Toy table describes toys a company
produces. Most toys manufactured by the company are for sale. Some toys are made just to donate to
worthy charities. During the manufacturing process, a toy may be damaged. Damaged toys are
refurbished, and an inspector determines the resulting quality of the refurbished toy.



Toy (Chapter6)
% Toyld
Name
Price

ForDonationOnly
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RefurbishedToy (Chapter6)
% Toyld
Quality
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Figure 6-25. Toy and RefurbishedToy tables with a one-to-one relationship

The application that generates reports for the company has no need to access toys manufactured for
donations. To create a model that filters out toys for donation while representing the Toy and
RefurbishedToy tables using Table per Type inheritance, do the following:

1. Add anew ADO.NET Entity Data Model to your project and import the Order

and Lookup tables.

2. Delete the association between Toy and RefurbishedToy.

3. Right-click the Toy entity and select Add » Inheritance. Select Toy as the base
entity and RefurbishedToy as the derived entity.

4. Delete the Toyld property in the RefurbishedToy entity.

5. Select the RefurbishedToy entity. In the Mapping Details window, map the
Toyld column to the Toyld property. This value will come from the Toy base

entity.

6. Delete the ForDonationOnly scalar property from the Toy entity.

7. Select the Toy entity and view the Mapping Details window. Use Add a Table
or View to map this entity to the Toy table. Add a condition When

ForDonationOnly = 0.

The resulting model is shown in Figure 6-26.

“#: Toy ES

=l Properties
f?ﬁ:To}«Id
7 Name
ﬁ“ Price

=l Mavigation Properties

2 RefurbishedToy (2

= Toy
= Properties
5 Quality

= Navigation Properties

Figure 6-26. The completed model with the Toy entity and derived RefurbishedToy entity
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How It Works

We limited the RefurbishedToy instances to non-donation toys by applying a condition on the base
entity. This approach is useful in cases such as this in which we need to apply a permanent filter to an

inheritance structure while using separate tables to implement some of the derived types.
The code in Listing 6-15 demonstrates inserting into and retrieving from our model.

Listing 6-15. Inserting into and retrieving from our model
using (var context = new EFRecipesEntities())

context.ExecuteStoreCommand(@"insert into chapter6.toy
(Name, ForDonationOnly) values ('RagDoll’,1)");
var toy = new Toy { Name = "Fuzzy Bear", Price = 9.97M };
var refurb = new RefurbishedToy { Name = "Derby Car", Price = 19.99M,
Quality = "Ok to sell" };
context.Toys.AddObject(toy);
context.Toys.AddObject(refurb);
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

Console. WIlteLlne("All Toys"),

Console.WriteLine("========");
foreach (var toy in context.Toys)
{

Console.WriteLine("{0}", toy.Name);

}
Console.WriteLine("\nRefurbished Toys");
foreach (var toy in context.Toys.0fType<RefurbishedToy>())

Console.WriteLine("{0}, Price = {1}, Quality = {2}", toy.Name,
toy.Price, ((RefurbishedToy)toy).Quality);

The following is the output from Listing 6-15:

All Toys

Fuzzy Bear

Derby Car
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Refurbished Toys

Derby Car, Price = 19.99, Quality = Ok to sell

6-11. Creating a Filter on Multiple Criteria

Problem

You want to filter rows for an entity based on multiple criteria.

Solution

Let’s assume we have a table that holds web orders, as shown in Figure 6-27.

WebOrder (Chapter6)
% Orderld
CustomerMame
OrderDate
IsDeleted

Amount

Figure 6-27. The WebOrder table containing information about a web order

Suppose we have a business requirement that defines instances of WebOrder as orders placed after
the first day of 2007 or orders placed between 2005 and 2007 that are not deleted or orders placed before
2005 that have an order amount greater than $200. This kind of filter cannot be created using the rather
limited conditions available in the Mapping Details window in the designer. One way to implement this
complex filter is to use QueryView. To model this entity and implement a filter that satisfies the business
requirement using QueryView, do the following:

1. Add anew ADO.NET Entity Data Model to your project and import the
WebOrder table.

2. Create the stored procedures in Listing 6-16. In the next two steps, we’ll map
these to the insert, update, and delete actions for the WebOrder entity.

3. Right-click the design surface and select Update Model from Database. In the
Update Wizard, select the InsertOrder, UpdateOrder, and DeleteOrder stored
procedures.
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4. Select the WebOrder entity and select the Map Entities to Functions button in
the Mapping Details window. This button is the second of two buttons on the
left side of the window. Map the InsertOrder procedure to the Insert action,
the UpdateOrder procedure to the Update action, and the DeleteOrder
procedure to the Delete action. The property/parameter mappings should
automatically line up. However, the return value from the InsertOrder
procedure must be mapped to the Orderld property. This is used by Entity
Framework to get the value of the identity column Orderld after an insert.
Figure 6-28 shows the correct mappings.

5. Select the table mapping (top button) in the Mapping Details window. Delete
the mapping to the WebOrder table. We’ll map this using QueryView.

6. Right-click the .edmx file in the Solution Explorer window and select Open
With » XML Editor. In the C-S mapping layer, inside the <EntitySetMapping>
tag, enter the code shown in Listing 6-17. This is the QueryView that will map
our WebOrder entity. Be careful! Changes made to the C-S mapping layer will
be lost if you do another Update Model from Database.

Listing 6-16. Procedures defined in the database for the Insert, Update, and Delete actions on the
WebOrder entity

create procedure [Chapter6].[InsertOrder]
(@CustomerName varchar(50),@0rderDate date,@IsDeleted bit,@Amount decimal)

as

begin
insert into chapter6.WebOrder (CustomerName, OrderDate, IsDeleted, Amount)
values (@CustomerName, @0rderDate, @IsDeleted, @Amount)
select SCOPE_IDENTITY() as OrderId

end

go

create procedure [Chapter6].[UpdateOrder]
(@CustomerName varchar(50),@0rderDate date,@IsDeleted bit,
@Amount decimal, @0rderId int)

as
begin
update chapter6.WebOrder set CustomerName = @CustomerName,
OrderDate = @OrderDate,IsDeleted = @IsDeleted,Amount = @Amount
where OrderId = @0rderId
end
go

create procedure [Chapter6].[DeleteOrder]
(@0rderId int)
as
begin
delete from Chapter6.WebOrder where OrderId = @0rderId
end
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Mapping Details - WebOrder *Ax
E Parameter / Column Operator Property Use Origi... Rows Affected ...
4 Functions

4 [7] Insert Using InsertOrder
4 [ Parameters

@l CustomerName: varchar + 5 CustomerMame : String
@] OrderDate : date +— % OrderDate : DateTime
@] lsDeleted : bit +— ' IsDeleted : Boolean
@l Amount: decimal +— % Amount : Decimal

4 [ Result Column Bindings
E8 Orderld —+ 5 Orderdd : Int32

E <Add Result Binding>
4 7] Update Using UpdateOrder
4 [ Parameters
@l CustomerName: varchar + 5 CustomerMame : String I}
@] OrderDate : date +— % OrderDate : DateTime I}
@] lsDeleted : bit +— ' IsDeleted : Boolean I}
@l Amount: decimal +— % Amount : Decimal I}
@] Orderd : int — # Orderd : Int32 o
4 [ Result Column Bindings
E <Add Result Binding>
4 [7] Delete Using DeleteOrder
4 [ Parameters
@] Orderd : int — # Orderd : Int32

Figure 6-28. Details for the stored procedurel/action mappings

Listing 6-17. Entity set mapping using QueryView for the WebOrder table

<EntitySetMapping Name="WebOrders">
<QueryView>
select value
EFRecipesModel.WebOrder(o.OrderId,
0.CustomerName,0.0rderDate,0.IsDeleted,o0.Amount)
from EFRecipesModelStoreContainer.WebOrder as o
where (o0.0rderDate > datetime'2007-01-01 00:00') ||
(o.0rderDate between cast('2005-01-01' as Edm.DateTime) and
cast('2007-01-01"' as Edm.DateTime) and !o.IsDeleted) ||
(o.Amount > 800 and o.OrderDate &lt;
cast('2005-01-01' as Edm.DateTime))
</QueryView>
</EntitySetMapping>

How It Works

QueryView is a read-only mapping that can be used instead of the default mapping offered by Entity
Framework. When QueryView is inside of the <EntitySetMapping> tag of the mapping layer, it maps
entities defined on the store model to entities defined on the conceptual model. When QueryView is
inside of the <AssociationSetMapping> tag, it maps associations defined on the store model to
associations defined on the conceptual model. One common use of QueryView inside of an
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<AssociationSetMapping> tag is to implement inheritance based on conditions that are not supported by
the default condition mapping.

QueryView is expressed in Entity SQL. QueryView can query only entities defined on the store
model. Additionally, eSQL in QueryView does not support group by and group aggregates.

When entities are mapped using QueryView, Entity Framework is unaware of the precise
implementation of the mapping. Because Entity Framework does not know the underlying columns and
tables used to create instances of the entities, it cannot generate the appropriate store-level actions to
insert, update, or delete the entities. Entity Framework does track changes to these entities once they are
materialized, but it does not know how to modify them in the underlying data store.

The burden of implementing the insert, update, and delete actions falls onto the developer. These
actions can be implemented directly in the .edmx file or they can be implemented as stored procedures
in the underlying database. To tie the procedures to the actions, you need to create a
<ModificationFunctionMapping> section. We did this in step 4 using the designer rather than directly
editing the .edmx file.

If an entity mapped using QueryView has associations with other entities, those associations along
with related entities also need to be mapped using QueryView. This, of course, can become rather
tedious. QueryView is a powerful tool, but can rapidly become burdensome.

Some of the common use cases for using QueryView are listed as follows.

1. To define filters that are not directly supported such as greater than, less than,
and so on

2. Tomap inheritance that is based on conditions other than is null, not null or
equal to

3.  To map computed columns or return subset of columns from a table or
change arestriction or data type of a column like making it nullable or to
surface a string column as integer

4. To map Table per Type Inheritance based on different primary and foreign key

5. To map the same column in the storage model to multiple types in the
conceptual model

6. To map multiple types to the same table

Inside the QueryView in Listing 6-17, we have an Entity SQL statement that contains three parts. The
first part is the select clause, which instantiates an instance of the WebOrder entity with a constructor.
The constructor takes the property values in precisely the same order as they are defined on the
conceptual model in Listing 6-18.

Listing 6-18. The definition of the WebOrder entity in the conceptual model

<EntityType Name="WebOrder">
<Key>
<PropertyRef Name="OrderId" />

</Key>

<Property Name="OrderId" Type="Int32" Nullable="false"
annotation:StoreGeneratedPattern="Identity" /»

<Property Name="CustomerName" Type="String" Nullable="false"
MaxLength="50" Unicode="false" FixedLength="false" />

<Property Name="OrderDate" Type="DateTime" Nullable="false" />

<Property Name="IsDeleted" Type="Boolean" Nullable="false" />
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<Property Name="Amount" Type="Decimal" Nullable="false"
Precision="18" Scale="2" />
</EntityType>

Notice that, in the Entity SQL in Listing 6-17, we fully qualified the conceptual namespace
EFRecipesModel when creating an instance of the WebOrder entity. However, in the from clause, we
also fully qualified the store container, EFRecipesModelStoreContainer.

The final section of the Entity SQL expression includes the where clause that, of course, is the whole
reason for using a QueryView in this example. Although the where clause can be arbitrarily complex, it is
subject to the restrictions for Entity SQL in QueryView as noted above.

The code in Listing 6-19 demonstrates inserting and retrieving WebOrders in our model.

Listing 6-19. Inserting and retrieving WebOrder entities
using (var context = new EFRecipesEntities())

var order = new WebOrder {CustomerName = "Jim Allen",
OrderDate = DateTime.Parse("5/3/2009"),
IsDeleted = false, Amount = 200};
context.WebOrders.AddObject (order);
order = new WebOrder { CustomerName = "John Stevens",
OrderDate = DateTime.Parse("1/1/2006"),
IsDeleted = false, Amount = 400 };
context.WebOrders.AddObject (order);
order = new WebOrder { CustomerName = "Russel Smith",
OrderDate = DateTime.Parse("1/3/2006"),
IsDeleted = true, Amount = 500 };
context.WebOrders.AddObject (order);
order = new WebOrder { CustomerName = "Mike Hammer",
OrderDate = DateTime.Parse("3/6/2006"),
IsDeleted = true, Amount = 1800 };
context.WebOrders.AddObject (order);
order = new WebOrder { CustomerName = "Steve Jones",
OrderDate = DateTime.Parse("1/1/2003"),
IsDeleted = true, Amount = 600 };
context.WebOrders.AddObject (order);
context.SaveChanges();

}
using (var context = new EFRecipesEntities())

Console.WriteLine("Orders");

Console.WriteLine(" ======“)
foreach (var order in context.WebOrders)
{

Console.WriteLine("\nCustomer: {0}", order.CustomerName);
Console.WriteLine("OrderDate: {0}", order.OrderDate.ToShortDateString());
Console.WriteLine("Is Deleted: {0}", order.IsDeleted.ToString());
Console.WriteLine("Amount: {0}", order.Amount.ToString("C"));
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The output of the code in Listing 6-19 follows. Notice that only customers that meet the criteria we
defined in the Entity SQL expression inside the QueryView are displayed.

Orders...

Customer: John Stevens
Order Date: 1/1/2006
Is Deleted: False

Amount: $400.00

Customer: Jim Allen
Oxder Date: 5/3/2009
Is Deleted: False

Amount: $200.00

Customer: Mike Hammer
Oxder Date: 6/3/2004
Is Deleted: True

Amount: $1,800.00

6-12. Using Complex Conditions with Table
per Hierarchy Inheritance

Problem

You want to model a table using Table per Hierarchy inheritance by applying conditions more complex
than those supported directly by Entity Framework.
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Solution

Suppose we have a Member table, as depicted in Figure 6-29. The Member table describes members in
our club. In our model, we want to represent adult members, senior members, and teen members as
derived types using Table per Type inheritance.

Name

Age

Member (Chapter6)
% Memberld

Phone

Figure 6-29. The Member table describing members in our club

Entity Framework supports Table per Hierarchy Inheritance based on the conditions =, is null, and
is not null. Simple expressions such as <, between, and > are not supported. In our case, a member
whose age is less than 20 is a teen (the minimum age in our club is 13). A member between the age of 20
and 55 is an adult. And, as you might expect, a member over the age of 55 is a senior. To create a model
for the member table and the three derived types, do the following:

1.

Add a new ADO.NET Entity Data Model to your project and import the
Member table.

Right-click the Member entity and select Properties. Set the Abstract attribute
to true. This marks the Member entity as abstract.

Create the stored procedures in Listing 6-20. We will use them to handle the
Insert, Update, and Delete actions on the entities we’ll derive from the
Member entity.

Right-click the design surface and select Update Model from Database. Select
the stored procedures you created in step 3.

Right-click the design surface and select Add » Entity. Name the new entity
Teen and set the base type to Member. Repeat this step, creating the derived
entities Adult and Senior.

Select the Member entity and view the Mapping Details window. Click Maps to
Member, and select <Delete>. This deletes the mappings to the Member table.

Select the Teen entity and view the Mapping Details window. Click the Map
Entity to Functions button. This is the bottom button on the left of the
Mapping Details window. Map the stored procedures to the corresponding
Insert, Update, and Delete actions. The parameter/property mappings should
automatically populate. Make sure you set the Result Column Bindings to map
the return value to the Memberld property for the Insert action. This identity
column is generated on the database side. See Figure 6-30.

Repeat step 7 for the Adult and Senior entities.

Right-click the .edmx file in the Solution Explorer window and select Open
With » XML Editor. This will open the .edmx file in the XML editor.
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10. Inthe C-S mapping section, inside the <EntityContainerMapping> tag, enter
the QueryView code shown in Listing 6-21.

Listing 6-20. Stored procedures for the Insert, Update, and Delete actions

create procedure [chapter6].[InsertMember]
(@Name varchar(50), @Phone varchar(50), @Age int)

as

begin
insert into Chapter6.Member (Name, Phone, Age)
values (@Name,@Phone,@Age)
select SCOPE_IDENTITY() as MemberId

end

go

create procedure [chapter6].[UpdateMember]
(@Name varchar(50), @Phone varchar(50), @Age int, @MemberId int)

as

begin
update Chapter6.Member set Name=@Name, Phone=@Phone, Age=@Age
where MemberId = @MemberId

end

go

create procedure [chapter6].[DeleteMember]
(@MemberId int)

as
begin
delete from Chapter6.Member where MemberId = @MemberId
end
Mapping Details - Teen *Ox
= Parameter / Column Operator  Property Use Origin... Rows Affected Pa...
4 Functions

4[] Insert Using InsertMember
4 [ ] Parameters

@@l Name:varchar  + % Name: String
@@l Phone:varchar 4 % Phone: String
@l Age:int + i Age:Int32

4 [ Result Column Binding:
2 Memberld -+ ¥ Memberld : Int32
E# <Add Result Binding>

4[] Update Using UpdateMemt
4[] Parameters

@l Name:varchar +— 5 Name: String &}
@] Phone:varchar  + 6 Phone: String 0
@ Age:int + & Age:Int32 0
@ Memberd:int  + ¥4 Memberd : Int32 [}

4 [ Result Column Binding:

E# <Add Result Binding>
4[] Delete Using DeleteMembe
4 [ Parameters
@] Memberd:int  + # Memberld : Int32

Figure 6-30. Mapping the Insert, Update, and Delete actions for the Teen entity
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Listing 6-21. QueryView for mapping the Member table to the derived types Teen, Adult, and Senior

<EntitySetMapping Name="Members">
<QueryView>
select value
case
when m.Age &1t; 20 then
EFRecipesModel.Teen(m.MemberId,m.Name,m.Phone,m.Age)
when m.Age between 20 and 55 then
EFRecipesModel.Adult(m.MemberId,m.Name,m.Phone,m.Age)
when m.Age > 55 then
EFRecipesModel.Senior(m.MemberId,m.Name,m.Phone,m.Age)
end
from EFRecipesModelStoreContainer.Member as m
</QueryView>
</EntitySetMapping>

The resulting model should look like the one in Figure 6-31.

2 Member ES

= Properties
#4 Memberld
ﬁ]Name
ﬁ]Phone
= Age

=l Navigation Properties

“¢ Teen 2 ¢ Adult 2 ¢ Senior ES
= Member = Member = Member

= Properties = Properties = Properties

= Navigation Properties = Navigation Properties = Navigation Properties

Figure 6-31. The resulting model with Member and the three derived types: Senior, Adult, and Teen

How It Works

Entity Framework supports only a limited set of conditions when modeling Table per Hierarchy
inheritance. In this recipe, we extended the conditions using QueryView to define our own mappings
between the underlying Member table and the derived types Senior, Adult, and Teen. This is shown in
Listing 6-21.

Unfortunately, QueryView comes at a price. Because we have defined the mappings ourselves, we
also take on the responsibility for implementing the Insert, Update, and Delete actions for the derived
types. This is not too difficult in our case.

In Listing 6-20, we defined the procedures to handle the Insert, Delete, and Update actions. We
need to create only one set because these actions target the underlying Member table. In this recipe, we
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implemented them as stored procedures in the underlying database. We could have implemented in the
.edmx file.

Using the designer, we mapped the procedures to the Insert, Update, and Delete actions for each of
the derived types. This completes the extra work we need to do when we use QueryView.

The code in Listing 6-22 demonstrates inserting into and retrieving from our model. Here we insert
one instance of each of our derived types. On the retrieval side, we print the members together with their
phone number, unless the member is a Teen.

Listing 6-22. Inserting into and retrieving from our model
using (var context = new EFRecipesEntities())

var teen = new Teen { Name = "Steven Keller", Age = 17,
Phone = "817 867-5309" };

var adult = new Adult { Name = "Margret Jones”, Age = 53,
Phone = "913 294-6059" };
var senior = new Senior { Name = "Roland Park", Age = 71,

Phone = "816 353-4458" };
context.Members.AddObject(teen);
context.Members.AddObject(adult);
context.Members.AddObject(senior);
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

Console. WIlteLlne("Club Members"),

Console.Writeline("============");
foreach(var member in context.Members)
{

bool printPhone = true;
string str = string.Empty;
if (member is Teen)

{

str = " a Teen";
printPhone = false;

else if (member is Adult)
str = "an Adult";
else if (member is Senior)
str = "a Senior";
Console.WriteLine("{0} is {1} member, phone: {2}",member.Name,
str, printPhone ? member.Phone : "unavailable");

The following is the output from the code in Listing 6-22:
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Members of our club

Steven Keller is a Teen member, phone: unavailable
Margret Jones is an Adult member, phone: 913 294-6059

Roland Park is a Senior member, phone: 816 353-4458

It is important to note here that no design time or even runtime checking is done to verify the ages
for the derived types. It is entirely possible to create an instance of the Teen type and set the age
property to 74—clearly not a teen. On the retrieval side, however, this row will be materialized as a
Senior member; a situation likely offensive to our Teen member.

We can introduce validation before changes are committed to the data store. To do this, register for
the SavingChanges event when the context is created. We wire this event to our code that performs the
validation. This code is shown in Listing 6-23.

Listing 6-23. Handling validation in the SavingChanges event
public partial class EFRecipesEntities
partial void OnContextCreated()

this.SavingChanges += new EventHandler(Validate);

}

public void Validate(object sender, EventArgs e)
{
var entities = this.ObjectStateManager
.GetObjectStateEntries(EntityState.Added |
EntityState.Modified)
.Select(et => et.Entity as Member);
foreach (var member in entities) {
if (member is Teen && member.Age > 19) {
throw new ApplicationException("Entity validation failed");

}
else if (member is Adult &% (member.Age < 20 || member.Age >= 55)) {
throw new ApplicationException("Entity validation failed");

else if (member is Senior &3 member.Age < 55) {
throw new ApplicationException("Entity validation failed");
}
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In Listing 6-23, when SaveChanges () is called, our Validate() method checks each entity that has
either been added or modified. For each of these, we verify that the age property is appropriate for the
type of the entity. When we find a validation error, we simply throw an exception.

We have several recipes in Chapter 12 that focus on handling events and validating objects before
they are committed to the database.

6-13. Modeling Table per Concrete Type Inheritance

Problem

You have two or more tables with similar schema and data and you want to model these tables as types
derived from a common entity using Table per Concrete Type inheritance.

Solution

Let’s assume we have the tables shown in Figure 6-32.
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Toyota (Chapter6)
¢ Carld
Model
Year

Color

BMW (Chapter6)
7 Carld
Model
Year
Color

CollisionAvoidance

CarDealer (Chapter6)
7 Carld
Dealerld

Dealer (Chapteré)
F Dealerld
Name

Figure 6-32. Tables Toyota and BMW with similar structure that will become derived types of the Car
entity

In Figure 6-32, the tables Toyota and BMW that have similar schema and represent similar data. The
BMW table has an additional column with a bit value indicating whether the instance has the collision
avoidance feature. We want to create a model with a base entity holding the common properties of the
Toyota and BMW tables. Additionally, we want to represent the one-to-many relationship between the
car dealer and cars he holds in inventory. Figure 6-33 shows the final model.

To create the model, do the following:

1. Add anew ADO.NET Entity Data Model to your project and import the Toyota,
BMW, CarDealer, and Dealer tables.

2. Right-click the design surface and select Add » Entity. Name the new entity
Car and unselect the Create key property check box.

3. Right-click the Car entity and view its properties. Set the Abstract property to
true.



Rl AL LI i TVINE THLE PNvivae i iviviiiva raves ieninini rueve

4. Move the common properties of the Toyota and BMW entities to the Car
entity. You can use Cut/Paste to move these properties. Make sure that only
the CollisionAvoidance property remains with the BMW entity and the Toyota
entity has no properties. Both of these entities will inherit these common
properties from the Car entity.

5. Right-click the Car entity and select Add » Inheritance. Set the base entity as
Car and the derived entity as BMW.

6. Repeat step 5, but this time set the Toyota as the derived entity.

7. Right-click the CarDealer entity and select Delete. When prompted to delete
the CarDealer table from the store model, select No.

8. Right-click the design surface and select Add » Association. Name the
association CarDealer. Select Dealer on the left with a multiplicity of one.
Select Car on the right with a multiplicity of many. Name the navigation
property on the Car side Dealer. Name the navigation property on the Dealer
side Cars. Be sure to uncheck the Add foreign key properties.

9. Select the association and view the Mapping Details window. Select CarDealer
in the Add a Table or View drop-down menu. Make sure the DealerId property
maps to the DealerId column and the Carld property maps to the Carld
column.

10. Right-click the .edmx file and select Open With » XML Editor. Edit the
mapping section with the changes shown in Listing 6-24 for the BMW and
Toyota entities.

Listing 6-24. Mapping the BMW and Toyota tables

<EntitySetMapping Name="Cars">
<EntityTypeMapping TypeName="IsTypeOf (EFRecipesModel.BMW)">
<MappingFragment StoreEntitySet="BMW">
<ScalarProperty Name="CollisionAvoidance"
ColumnName="CollisionAvoidance" />
<ScalarProperty Name="CarId" ColumnName="CarId"/>
<ScalarProperty Name="Model" ColumnName="Model"/>
<ScalarProperty Name="Year" ColumnName="Year"/>
<ScalarProperty Name="Color" ColumnName="Color"/>
</MappingFragment>
</EntityTypeMapping>
<EntityTypeMapping TypeName="IsTypeOf(EFRecipesModel.Toyota)">
<MappingFragment StoreEntitySet="Toyota">
<ScalarProperty Name="CarId" ColumnName="CarId"/>
<ScalarProperty Name="Model" ColumnName="Model"/>
<ScalarProperty Name="Year" ColumnName="Year"/>
<ScalarProperty Name="Color" ColumnName="Color"/>
</MappingFragment>
</EntityTypeMapping>
</EntitySetMapping>
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The resulting model is shown in Figure 6-33.

He Car 2 s Dealer ES
= Properties = Properties
¥4 Carld # Dealerd
ﬁ] Model * 1 ﬁ] Mame
B3 Year =l Navigation Properties
5 Color = Cars
=l Navigation Properties
3_—1 Dealer
“: BMW £ s Toyota %
= Car = Car
= Properties = Properties
# CollisionAvoidance = Navigation Properties

= Navigation Properties

Figure 6-33. The completed model with the derived entities BMW and Toyota represented in the database
as separate tables

How It Works

Table per Concrete Type is an interesting inheritance model in that it allows each derived entity to map
to separate physical tables. From a practical perspective, the tables need to share at least some part of a
common schema. This common schema is mapped in the base entity while the additional schema parts
are mapped in the derived entities. For Table per Concrete Type inheritance to work properly, the entity
key must be unique across the tables.

The base entity is marked abstract and is not mapped to any table. In Table per Concrete Type, only
the derived entities are mapped to tables.

In our example, we marked the Car entity as abstract and did not map it to any table. In the
mapping in Listing 6-24, notice that we mapped only the derived entities BMW and Toyota. We moved
all the common properties (Carld, Model, Year, and Color) to the base entity. The derived entities
contained only the properties unique to the entity. For instance, the BMW entity has the additional
CollisionAvoidance property.

Because the entities Toyota and BMW derived from the Car entity, they became part of the same
Cars entity set. This means that the Carld entity key must be unique within the entity set that now
contains all the derived entities. Because the entities are mapped to different tables, it is possible that we
can have collisions in the keys. To avoid this, we set the CarId column in each table as an identity
column. For the BMW table, we set the initial seed to 1 with an increment of 2. This will create odd
values for the Carld key. For the Toyota table, we set the initial seed to 2 with an increment of 2. This will
create event values for the Carld key.

When modeling relationships in Table per Concrete Type inheritance, it is better to define them at
the derived type rather than at the base type. This is because the Entity Framework runtime would not
know which physical table represents the other end of the association. In our example, of course, we
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provided a separate table (CarDealer) that contains the relationship. This allowed us to model the
relationship at the base entity by mapping the association to the CarDealer table.

There are many practical applications of Table per Concrete Type inheritance. Perhaps the most
common is in working with archival data. Imagine you have a several years worth of orders for your
eCommerce site. At the end of each year, you archive the orders for the previous 12 months in an archive
table and start the New Year with an empty table. With Table per Concrete Type inheritance, you can
model the current and archived orders using the approach demonstrated here.

Table per Concrete Type inheritance has a particularly important performance advantage over
other inheritance models. When querying a derived type, the generated query targets the specific
underlying table without the additional joins of Table per Type inheritance or the filtering of Table per
Hierarchy. For large datasets or models with several derived types, this performance advantage can be
significant.

The disadvantages of Table per Concrete Type inheritance include the overhead of potentially
duplicate data across tables and the complexity of insuring unique keys across the tables. In an archival
scenario, data is not duplicated but simply spread across multiple tables. In other scenarios, data
(properties) may be duplicated across the tables.

The code in Listing 6-25 demonstrates inserting into and retrieving from our model.

Listing 6-25. Inserting into and querying our model

using (var context = new EFRecipesEntities())

var di1 = new Dealer { Name = "All Cities Toyota" };
var d2 = new Dealer { Name = "Southtown Toyota" };
var d3 = new Dealer { Name = "Luxury Auto World" };
var cl = new Toyota { Model = "Camry", Color = "Green",

Year = "2010", Dealer = d1 };

var c2 = new BMW { Model = "310i", Color = "Blue",

CollisionAvoidance = true,

Year = "2010", Dealer = d3 };
var c3 = new Toyota { Model = "Tundra", Color = "Blue",

Year = "2010", Dealer = d2 };
context.Dealers.AddObject(d1);
context.Dealers.AddObject(d2);
context.Dealers.AddObject(d3);
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

context.ContextOptions.LazyloadingEnabled = true;
Console.WriteLine("Dealers and Their Cars");
Console.WriteLine(" ");
foreach (var dealer in context.Dealers)

{

Console.WriteLine("\nDealer: {0}", dealer.Name);
foreach(var car in dealer.Cars)
{
string make = string.Empty;
if (car is Toyota)
make = "Toyota";
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else if (car is BMW)
make = "BMW";
Console.WriteLine("\t{o} {1} {2} {3}", car.Year,
car.Color, make, car.Model);

The output of the code in Listing 6-25 is the following:

Dealers and Their Cars

Dealer: Luxury Auto World

2010 Blue BMW 310i

Dealer: Southtown Toyota

2010 Blue Toyota Tundra

Dealer: All Cities Toyota

2010 Green Toyota Camry

6-14. Applying Conditions on a Base Entity

Problem

You want to derive a new entity from a base entity that currently exists in a model and continue to allow
the base entity to be instantiated.

Solution

Let’s assume you have a model like the one shown in Figure 6-34.
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)

¢ Invoice

= Properties
# Invoiceld
f Amount
2 Description

f Date
5 [sDeleted

= Mavigation Properties

Figure 6-34. Our model with the Invoice entity

This model contains a single Invoice entity. We want to derive a new entity that represents deleted
invoices. This will allow us to more cleanly separate business logic that operates on active invoices
differently than deleted invoices. To add the derived entity, do the following:

1. View the Mapping Details window for the Invoice entity. Add a condition on
the IsDeleted column to map the entity when the column is 0 as shown in
Figure 6-35.

2. Now that the IsDeleted column is used in a condition, we need to remove it
from the scalar properties for the entity. Right-click the IsDeleted property in
the entity and select Delete.

3. Right-click the design surface and select Add » Entity. Name the new entity
DeletedInvoice and select Invoice as the base type.

4. View the Mapping Details window for the DeletedInvoice entity. Map the
entity to the Invoice table. Add a condition on the IsDeleted column to map
the entity when the column is 1 as shown in Figure 6-36.

The final model with the Invoice entity and the derived DeletedInvoice entity is shown in Figure 6-37.

Mapping Details - Invoice *Ox
Column Oper... Value/ Property
EF | 4 Tables
4 [ Maps to Invoice
E3 When IsDeleted = 0

% <Add a Condition>
4 [ Celumn Mappings
95 Invoiceld : int
=] Amount: decimal
=] Description : varchar
=] Date: datetime
=] IsDeleted : bit

[ <Add a Table or View>

% Invoiceld : Int32
#f Amount : Decimal
% Description : String
% Date: DateTime
% IsDeleted : Boolean

111t

ﬂ; ErrorList B Output B Find Results1 @Mapping Details

Figure 6-35. Mapping the Invoice entity when the IsDeleted column is 0

243



AL L Hi-TViInE T JNnvive Fiiniih vyl rans i rivv-

244

Mapping Details - DeletedInvoice

Column Oper... Value/ Property

E | 4 Tables
4 [ Maps to Invoice
£ When IsDeleted = 1
EY <Add a Condition>
4 [ Column Mappings
=] IsDeleted : bit “ o
B <Add a Table or View>

ﬂ; Error List B Output B} Find Results 1 [Ezal VRl e

Figure 6-36. Mapping the DeletedInvoice entity to the Invoice table when the IsDeleted column is 1

¢ Invoice

= Properties
# Invoiceld
ﬁ Amount
2 Description
ﬁ Date

= Mavigation Properties

(4 DeletedInvoice A
= Invoice

= Properties

= Mavigation Properties

Figure 6-37. Our completed model with the Invoice entity and the DeletedInvoice entity

How It Works

There are two different ways to model our invoices and deleted invoices. The approach we’ve shown
here is only recommended if you have an existing model and code base and would like to add the
DeletedInvoice derived type with as little impact as possible to the existing code. For a new model, it
would be better to derive an Activelnvoice type and a DeletedInvoice type from the Invoice base type. In
this approach, you would mark the base type as abstract.

Using the approach we’ve shown here, you could can determine, as we do in the code in Listing 6-
26, if the entity is a DeletedInvoice either by casting or by using the 0fType<> () method. However, you
can’t select for the Invoice entity alone. This is the critical drawback to the approach we’ve shown here.
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The approach you should use for new code is to derive two new entities: Activelnvoice and
Deletelnvoice. With these two sibling types, you can use either casting or the 0fType<>() method to

operate on either type uniformly.

Listing 6-26. Using theas operator to determine if we have an Invoice or DeletedInvoice

using (var context = new EFRecipesEntities())

}

context.Invoices.AddObject(new Invoice { Amount = 19.95M,
Description = "0il Change",
Date = DateTime.Parse("4/11/10") });
context.Invoices.AddObject(new Invoice { Amount = 129.95M,
Description = "Wheel Alignment",
Date = DateTime.Parse("4/01/10") });
context.Invoices.AddObject(new DeletedInvoice { Amount = 39.95M,
Description = "Engine Diagnosis",
Date = DateTime.Parse("4/01/10") });
context.SaveChanges();

using (var context = new EFRecipesEntities())

foreach (var invoice in context.Invoices)

{
var isDeleted = invoice as DeletedInvoice;
Console.WriteLine("{0} Invoice",

isDeleted == null ? "Active" : "Deleted");

Console.WriteLine("Description: {0}", invoice.Description);
Console.WriteLine("Amount: {0}", invoice.Amount.ToString("C"));
Console.WriteLine("Date: {0}", invoice.Date.ToShortDateString());
Console.WriteLine();

}

The following is the output of the code in Listing 6-26:

Active Invoice

Description: 0il Change

Amount: $19.95

Date: 4/11/2010

Active Invoice

Description: Wheel Alignment
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Amount: $129.95

Date: 4/1/2010

Deleted Invoice
Description: Engine Diagnosis
Amount: $39.95

Date: 4/1/2010

6-15. Creating Independent and Foreign Key Associations

Problem

You want to use Model First to create both independent and foreign key associations.

Solution

1.  Add anew ADO.NET Entity Data Model to your project. Select Empty Model
when prompted to choose the model contents. Click Finish. This will create an
empty design surface.

2. Right-click the design surface and select Add » Entity. Name the new entity
User and click OK.

3. Right-click the new entity and add a scalar property for the UserName.

4. Right-click the design surface and select Add » Entity. Name the new entity
PasswordHistory and click OK.

5. Right-click the new entity and add a scalar property for the LastLogin. Right-
click the LastLogin property and change its type to DateTime.

6. Right-click the User entity and select Add » Association. To create a foreign
key association, check the Add foreign key properties to the ‘PasswordHistory’
entity check box. TO create an independent association, uncheck this box.

7. Right-click the design surface and select Generate Model from Database.
Select a database connection and complete the remainder of the wizard. This
will generate the storage and mapping layers of the model and produce a script
to generate the database for the model.
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If you choose to create a foreign key association, the model should look like the one shown in Figure
6-38. If you choose to create an independent association, the model should look like the one shown in
Figure 6-39.

“o User E “¢  PasswordHistory (%
= Properties = Properties
F1d F1d
ﬁ]UserName 1 * ﬁ]LastLogin
=l Navigation Properties 7 Userd
= passwordHistories = Navigation Properties
B User

Figure 6-38. A foreign key association between User and PasswordHistory

“¢  PasswordHistory (%

“o User S ES
= Properties = Properties
F1d F1d
ﬁ]UserName 1 * ﬁ]LastLogin
=l Navigation Properties =l Navigation Properties
3_—1 PasswordHistories 3_—1 User

Figure 6-39. An independent association between User and PasswordHistory

How It Works

With a foreign key association, the foreign key is exposed as a property in the dependent entity. Exposing
the foreign key allows many aspects of the association to be managed with the same code that manages
the other property values. This is particularly helpful in disconnected scenarios as we will see in Chapter
9. Foreign key associations are the default in Entity Framework.

For independent associations, the foreign keys are not exposed as properties. This makes the
modeling at the conceptual layer somewhat cleaner because there is no noise introduced concerning the
details of the association implementation. In the early versions of Entity Framework, only independent
associations where supported.

6-16. Changing an Independent Association into
a Foreign Key Association

Problem

You have a model that uses an independent association and you want to change it to a foreign key
association.
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Solution

Let’s say you have a model like the one shown in Figure 6-40.

———— s Ticket S
@z Vehicle %
= = Properties

p rti

e 5 Ticketld
4 LicenseNumber 9 [ssueDate
1 *

ﬁz Model ﬁ:\«"iolation
& Navigation Properties = Mavigation Properties

I =

% Tickets B Vehicle

Figure 6-40. A model for vehicles and tickets using an independent association

To change the association from an independent association to a foreign key association, do the
following:

1. Right-click the Ticket entity and select Add » Scalar Property. Rename the
property LicenseNumber.

2. View the Mapping Details window for the association. Remove the mapping to
the Ticket table by selecting <Delete> from the Maps to Ticket control.

3. Right-click the association and view the properties. Click in the button in the
Referential Constraint control. In the dialog box select the Vehicle entity in the
Principal dropdown control. The Principal Key and the Dependent Property
should both be set to LicenseNumber as shown in Figure 6-41.

4. View the Mapping Details window for the Ticket entity. Map the
LicenseNumber column to the LicenseNumber property as shown in Figure
6-42.

The final model is shown in Figure 6-43.

Referential Constraint | ? RS |
Principal:
Vehicle -
Dependent:
Ticket
Principal Key Dependent Property
LicenseMumber LicenseMumber -

Figure 6-41. Creating the referential constraint for the foreign key association
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Mapping Details - Ticket

Column Oper... Value/ Property

Eh | 4 Tables
4 [ Maps to Ticket
EY <Add a Condition>
4 [ Column Mappings
@] Ticketld : int
=] IssueDate : datetime
=] Violation : varchar
=] LicenseMumber: varch
B <Add a Table or View>

# Ticketld : Int32
5 IssueDate : DateTime
5 Violation : String

+“
+“
+“
“ % LicenseMumber : String

ﬂ; Error List B Output B} Find Results 1 [Ezal VRl e

Figure 6-42. Mapping the LicenseNumber column to the LicenseNumber property for the Ticket entity

— (s Ticket =)

#2 Vehidle
= = Properties

Properties ]

4 Ticketld
¥ LicenseNumber 5 [ssueDate
1 *

' Model 5 Violation
1= Mavigation Properties 1 LicenseMumber

5] Tickets = Mavigation Properties
: 8 & vehicle

Figure 6-43. The model with the independent association changed to a foreign key association

How It Works

When you change an independent association into a foreign key association, most of your existing code
will continue to work. You will find it easier now to associate two entities by simply setting the exposed
foreign key to the appropriate value. To change a relationship with an independent association, you
need to create a new instance of EntityKey and set the entity’s xxxReference.EntityKey to this new
instance. With a foreign key association, you simply set the exposed foreign key property to the key
value.

Foreign key associations are not currently supported for many-to-many associations because these
associations must be mapped to the underlying link table. A future version of Entity Framework may
support foreign key associations along with payloads for many-to-many associations.
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CHAPTER 7

Working with Object Services

This chapter contains a rather eclectic collection of recipes that provide practical solutions to common
problems in real-world applications. We build our applications to tolerate changes in deployment
environments and make our applications flexible enough so that few if any configuration details need to
be hard-coded. The first three recipes provide you with tools to meet these challenges.

The remaining recipes cover topics such as Entity Framework’s Pluralization Service, using the

edmgen.exe utility, working with identifying relationships, and retrieving objects from an object context.

7-1. Dynamically Building a Connection String

Problem

You want to dynamically build the connection string for your application.

Solution

Many real-world applications start out on a developer’s desktop; move through one or more testing,

integration, and staging environments; and finally end up in a production deployment. You want to

dynamically configure the application’s connection string depending on the current environment.
To dynamically build the connection string for your application, follow the pattern in Listing 7-1.

Listing 7-1. Dynamically building a connection string
public static class ConnectionStringManager
public static string EFConnection = GetConnection();
private static string GetConnection()
var sqlBuilder = new SqlConnectionStringBuilder();
// figure out the environment
// strings here should come from a config file
string myHost = Dns.GetHostName();
if (myHost.ToLower().Contains("test"))

sqlBuilder.DataSource = @"TestSqlo1";
else if (myHost.ToLower().Contains("staging"))
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sqlBuilder.DataSource = @"StagingSqlo1";
else if (myHost.ToLower().Contains("prod"))

sqlBuilder.DataSource = @"ProdSqloi";
else

sqlBuilder.DataSource = @"localhost";

// fill in the rest
sqlBuilder.InitialCatalog = "EFRecipes”;
sqlBuilder.IntegratedSecurity = true;
sqlBuilder.MultipleActiveResultSets = true;

var eBuilder = new EntityConnectionStringBuilder();

eBuilder.Provider = "System.Data.SqlClient";

eBuilder.Metadata =
"res://*/Recipel.csdl|res://*/Recipel.ssdl|res://*/Recipel.msl";

eBuilder.ProviderConnectionString = sqlBuilder.ToString();

return eBuilder.ToString();

}

public partial class EFRecipesEntities
partial void OnContextCreated()

this.Connection.ConnectionString = ConnectionStringManager.EFConnection;

}

How It Works

When you add an ADO.NET Entity Data Model to your project, Entity Framework adds an entry to the
<connectionStrings> section in your project’s .config file. At runtime, the constructor for the object
context is passed the key for this configuration entry (EFRecipesEntities for the recipes in this book).
Given this key, the object context uses the connection string found in the .config file.

To dynamically create the connection string based on the environment in which our application is
deployed, we created the ConnectionStringManager class (refer to Listing 7-1). In the GetConnection()
method, we check the name of the machine the application is on and use it to determine the target
database server. To keep things simple, we hard-coded the names of machines here (you would
probably want to put them in a .config file). To use our ConnectionStringManager, we implemented the
OnContextCreated() partial method inside EFRecipesEntities partial class.

In our implementation of the OnContextCreated() partial method, we get the statically built
connection string from the ConnectionStringManager. The object context will use this connection string
to connect to our database server. You don’t need to change anything else in your application. Each time
you get a new instance of your object context, the OnContextCreated() method will get the connection
string created when the static ConnectionStringManager class was created.
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7-2. Reading a Model from a Database

Problem
You want to read the CSDL, MSL, and SSDL definitions for your model from a database table.

Solution
Suppose that you have a model like the one in Figure 7-1.
“¢  Customer ES

= Properties
# Customerld
ﬁ] Mame

=l Navigation Properties

Figure 7-1. A model with a Customer entity

Our model has just one entity: Customer. The conceptual layer (CSDL), mapping layer (MSL), and
storage layer (SSDL) definitions are typically found in the .edmx file in your project. We want to read
these definitions from a database. To read these definitions from a database, do the following:

1. Right-click the design surface and view the Properties. Change the Code
Generation Strategy to None. We’ll use POCO for our Customer class. See
Chapter 8 for more recipes on using POCO.

2. Create the table shown in Figure 7-2. This table will hold the definitions for our
project.

3. Right-click the design surface and view the Properties. Change the Metadata
Artifact Processing to Copy to Output Directory. Rebuild your project. The
build process will create three files in the output directory: Recipe2.ssd],
Recipe2.csdl, and Recipe2.msl.

4. Insert the contents of these files into the Definitions table in the corresponding
columns. Use 1 for the Id column.

5. Follow the pattern in Listing 7-2 to read the metadata from the Definitions
table and create a MetadataWorkspace that our application will use.
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Definitions (Chapter?7)

Column Name Data Type Allow Mulls
7 int
Ss0L xml
CSOL xml
MsL xml

Figure 7-2. The Definitions table holds the definitions for our SSDL, CSDL, and MSL. Note that the column
data types for the definitions are XML.

Listing 7-2. Reading the metadata from the Definitions table

using System;

using System.Collections.Generic;
using System.Ling;

using System.Text;

using System.Data.Metadata.Edm;
using System.Data.SqlClient;
using System.Data.EntityClient;
using System.Xml;

using System.Data.Mapping;

using System.Data.Objects;

namespace Recipe2
class Program
static void Main(string[] args)

RunExample();

static void RunExample()

{

using (var context = ContextFactory.CreateContext())

context.Customers.AddObject(

new Customer { Name = "Jill Nickels" });
context.Customers.AddObject(

new Customer { Name = "Robert Cole" });
context.SaveChanges();

}

using (var context = ContextFactory.CreateContext())
Console.WriteLine("Customers");

Console.WriteLine("--------- );
foreach (var customer in context.Customers)
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Console.WriteLine("{0}", customer.Name);

}

}
public class Customer

public virtual int CustomerId { get; set; }
public virtual string Name { get; set; }

}
public class EFRecipesEntities : ObjectContext
{
private ObjectSet<Customer> customers;
public EFRecipesEntities(EntityConnection cn)
: base(cn)
{
}
public ObjectSet<Customer> Customers
get
{
return customers ?? (customers = CreateObjectSet<Customer>());
}
}
}
public static class ContextFactory
{

static string connString = @"Data Source=localhost;
Initial Catalog=EFRecipes;Integrated Security=True;";
private static MetadataWorkspace workspace = CreateWorkSpace();

public static EFRecipesEntities CreateContext()

{
var conn = new EntityConnection(workspace,
new SqlConnection(connString));
return new EFRecipesEntities(conn);
}
private static MetadataWorkspace CreateWorkSpace()
{

string sql = @"select csdl,msl,ssdl from Chapter7.Definitions";
XmlReader csdlReader = null;
XmlReader mslReader = null;
XmlReader ssdlReader = null;

using (var cn = new SqlConnection(connString))
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using (var cmd = new SqlCommand(sql, cn))

cn.Open();
var reader = cmd.ExecuteReader();
if (reader.Read())

csdlReader = reader.GetSqlXml(0).CreateReader();
mslReader = reader.GetSqlXml(1).CreateReader();
ssd1Reader = reader.GetSqlXml(2).CreateReader();

}

var workspace = new MetadataWorkspace();
var edmCollection = new EdmItemCollection(new XmlReader| ]
{ csdlReader });
var ssdlCollection = new StoreItemCollection(new XmlReader[]
{ ssdlReader });
var mappingCollection = new StorageMappingItemCollection(
edmCollection, ssdlCollection, new XmlReader[] { mslReader });

workspace.RegisterItemCollection(edmCollection);
workspace.RegisterItemCollection(ssdlCollection);
workspace.RegisterItemCollection(mappingCollection);
return workspace;

}
}
}
The following is the output of the code in Listing 7-2:
Customers

Jill Nickels

Robert Cole

How It Works

The first part of the code in Listing 7-2 should be very familiar to you by now. We use Entity Framework
to create a new context, create a few entities, and call SaveChanges() to persist the entities to the
database. To retrieve the entities, we iterate through the collection and display each on the console. The
only difference in this part is the call to ContextFactory.CreateContext(). Normally, we would just use
the new operator to get a new instance of our EFRecipesEntities context.

We've created the ContextFactory to create our context from the model metadata stored not in the
.edmx file, but in a table in a database. We do this in the CreateContext() method. The CreateContext()
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method creates a new EntityConnection based on two things: a workspace that we create with the
CreateWorkSpace() method and a SQL connection string. The real work happens in how we create the
workspace in the CreateWorkSpace() method.

The CreateWorkSpace() method opens a connection to the database where our metadata is stored.
We construct a SQL statement that reads the one row from the Definitions table (refer to Figure 7-2) that
holds our definitions for the conceptual layer, storage layer, and mapping layer. We read these
definitions with XmlReaders. With these definitions, we create an instance of a MetadataWorkspace. A
MetadataWorkspace is an in-memory representation of a model. Typically, this workspace is created by
the default plumbing in Entity Framework from your .edmx file. In this recipe, we create this workspace
from the definitions in a database. There are other ways to create this workspace including using
embedded resources and an emerging perspective called Code First.

The code in Listing 7-2 uses Plain Old CLR Objects, also known as POCO, for our Customer entity.
We cover POCO extensively in Chapter 8, but here we use POCO to simplify the code. With POCO, we
don’t use the classes generated by Entity Framework. Instead, we use our own classes that have no
particular dependence on Entity Framework. In Listing 7-2, we created our own definition of the
Customer entity in the Customer class. We also created our own object context: EFRecipesEntities. Our
context, of course, does have a dependence on Entity Framework because it derives from ObjectContext.

7-3. Deploying a Model

Problem

You want to know the various options for deploying a model.

Solution

When you add a new ADO.NET Entity Data Model to your project, Entity Framework sets the Build
Action property for the .edmx file to Entity Deploy. Additionally, the Metadata Artifact Processing
property of the model is set to Embed in Output Assembly. When you build your project, the Entity
Deploy action extracts three sections from the .edmx file into three separate files. The CSDL section is
extracted into the Model.csdl file. The MSL section is extracted into the Model.msl file. The SSDL section
is extracted into the Model.ssdl file. With the Embed in Output Assembly, these three files get embedded
into the assembly as resources.

Changing the Metadata Artifact Processing property to Copy to Output Directory causes the three
Model.* files to be copied to the same directory as the resulting assembly. The files are not embedded as
aresource.

How It Works

The .edmx file contains all three model layers: conceptual, mapping, and storage. The file also contains
additional data used by the designer to manage the design surface. At runtime, Entity Framework uses
each of the layers separately. The .edmx file is just a convenient container for the design time user
experience. The deployment of a model depends on model layers either embedded in the assembly,
stored in files, or, as we saw in Recipe 7-2, retrieved from another source and used to complete a
MetadataWorkspace.
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If your Metadata Artifact Processing property is set to Embed in Output Assembly, you will notice
that the connection string in your App.config or web.config file, includes a metadata tag, which looks
something like the following:

metadata=res://*/Recipe3.csdl|res://*/Recipe3.ssdl|res://*/Recipe3.msl;

This notation indicates a search path for each of the model layers embedded in the assembly. If you
change the Metadata Artifact Processing property to Copy to Output Directory, you will see the
connection string change to something like this:
metadata=.\Recipe3.csdl|.\Recipe3.ssdl|.\Recipe3.msl;

This notation indicates a file path to each of the model layers.

When embedding the model layers as resources in an assembly, you are not restricted by the
connection string syntax to referencing only the executing assembly. Table 7-1 illustrates some of the

possible constructions you can use to reference the embedded model layers in other assemblies.

Table 7-1. Connection String Syntax for Loading Model Layers

Syntax Meaning

res://myassembly/file.ssdl Loads the SSDL from myassembly

res://myassembly/ Loads the SSDL, CSDL, and MSL from myassembly
res://*/file.ssdl Loads the SSDL from all assemblies in the AppDomain
res://*/ Loads the SSDL, CSDL, and MSL from all assemblies
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7-4. Using the Pluralization Service

Problem

You want to use Entity Framework’s Pluralization Service when you import table from a database.

Solution
Suppose that you have a database with the tables shown in Figure 7-3.
Employees (Chapter7) Tasks (Chapter7)
% Employeeld 7 Taskld
Mame Description
B Employeeld

Figure 7-3. Employees and Tasks tables in our database
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Notice that the tables in Figure 7-3 take the plural form. This is common in many databases. Some
DBAs believe that all table names should be plural; other DBAs believe just the opposite. And, of course,
there are a few who don’t seem to follow any particular view and mix things up. Depending on your
perspective, you may want to use the singular form of the table names for your model’s entities. Entity
Framework provides a Pluralization Service that can automatically generate the singular form of a table
name to use as the corresponding entity name.

To use the Pluralization Service when importing your tables, check the Pluralize or singularize

generated object names box in the last step of the Entity Data Model Wizard (see Figure 7-4). By default,
this box is checked.

Entity Data Model Wizard (2] = |

J— 1 Choose Your Database Objects
e

‘Which database objects do you want to include in your model?
Djﬁ Tables
[k Views
[[)% Stored Procedures

Click here to enable the
Pluralization Service

Include foreign key columns in the model

uralize or singularize generated ohject names

Model Namespace:

EFRecipesModel

Finish l ’ Cancel

Figure 7-4. Enabling the Pluralization Service

Figure 7-5 shows a model created when we import the table in Figure 7-3 without the Pluralization
Service enabled. Notice that entity names are taken directly from the table names and retain the plural

form. Figure 7-6 shows the same tables imported with the Pluralization Service enabled. These entities
use the singular forms of the table names.
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260

b

R @2 Tasks
“7 Employees ES

- . = Properties
Properties ¥ Tackld
@ﬁ:‘ Employeeld 1 [ Description
%1 Name 1 5 Employeeld

= Merzalen Tepsri= = Navigation Properties

& =
SEED 34 Employees

Figure 7-5. The model created from the tables in Figure 7-3 without the Pluralization Service

— @7 Task ES
42 Employee E
= Properties
=p rti
@rope les ’E’ﬁTaskId
ﬁr Employeeld 3 - 5 Description
5 Mame 5 Employeeld
= N:ﬂ-‘lgatlon Properties = Navigation Properties
55 Tasks E3 Employee

Figure 7-6. The model created from the tables in Figure 7-3 with the Pluralization Service

How It Works

Most developers prefer the entity names in the model in Figure 7-6. (Look at the names in boldface at
the top of each entity). Not only are the entity names singular but the Employee navigation property in
the Task entity also makes more sense than the Employees navigation property in the Tasks entity in
Figure 7-5. In both cases, this navigation property is an EntityReference, not a collection. The plural
form in Figure 7-5 seems somewhat confusing.

If our table names were singular to start with, the Pluralization Service would correctly pluralize the
collection-based navigation properties and pluralize the underlying entity set names. This takes cares of
the other half of the DBA community that use singular names for tables.

You can set the default on/off state of the Pluralization Service for new entities in your model by
changing the Pluralize New Objects property. When you add new entities to your model, this setting will
change the default on/off state for the Pluralization Service.

You can use the Pluralization Service outside of the context of Entity Framework. This service is
available in the System.Data.Entity.Design namespace. To add a reference to the
System.Data.Entity.Design.dll, you will need to change your project’s Target framework from the default
.NET Framework 4 Client Profile to the more expansive, .NET Framework 4. This setting is changed in
the properties of the project. The code in Listing 7-3 demonstrates using the Pluralization Service to
pluralize and singularize the words person and people.
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Listing 7-3. Using the Pluralization Service

var service = PluralizationService.CreateService(new CultureInfo("en-US"));

string person = "Person";

string people = "People";

Console.WriteLine("The plural of {0} is {1}", person,
service.Pluralize(person));

Console.WriteLine("The singular of {0} is {1}", people,
service.Singularize(people));

The following is the output of the code in Listing 7-3:

The plural of Person is People
The singular of People is Person

7-5. Retrieving Entities from the Object State Manager

Problem

You want to create an extension method that retrieves entities from the object state manager.

Solution
Suppose you have a model like the one in Figure 7-7.

“*2  ServiceCall 3

“*2 Technician ES
= Properties
= Properties ¥ Callld
#4 Techld 5 ContactMame
ﬁ] Mame 1 * 25 Issue
= Navigation Properties E' Techld
= ServiceCall = Navigation Properties
55 ServiceCalls
=] Technician

Figure 7-7. Our model with technicians and their service calls

In this model, each technician has service calls that include the contact name and issue for the call.
You want to create an extension method that retrieves all entities in the model that are in the Added,
Modified, or Unchanged state. To do this, follow the pattern in Listing 7-4.
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Listing 7-4. Creating an extension method that retrieves all the entities in the Added, Modified, or
Unchanged state

class Program
static void Main(string[] args)

RunExample();

static void RunExample()

{
using (var context = new EFRecipesEntities())
var tech1l = new Technician { Name = "Julie Kerns" };
var tech2 = new Technician { Name = "Robert Allison" };
context.ServiceCalls.AddObject (new ServiceCall {
ContactName = "Robin Rosen",
Issue = "Can't get satellite signal.”,
Technician = tech1 });
context.ServiceCalls.AddObject (new ServiceCall {
ContactName = "Phillip Marlowe",
Issue = "Channel not available",
Technician = tech2 });
// now get the entities we've added
foreach (var tech in
context.ObjectStateManager.GetEntities<Technician>())
Console.WriteLine("Technician: {0}", tech.Name);
foreach (var call in tech.ServiceCalls)
Console.WriteLine("\tService Call: Contact {0} about {1}",
call.ContactName, call.Issue);
}
}
}
}

}

public static class StateManagerExtensions

public static IEnumerable<T> GetEntities<T>(this ObjectStateManager manager)

{
var entities = manager
.GetObjectStateEntries(~EntityState.Detached)
.Where(entry => lentry.IsRelationship &3 entry.Entity != null)
.Select(entry => entry.Entity).0fType<T>();
return entities;
}
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The following is the output of the code in Listing 7-4:

Technician: Julie Kerns
Service Call: Contact Robin Rosen about Can't get satellite signal.
Technician: Robert Allison

Service Call: Contact Phillip Marlowe about Channel not available

How It Works

In Listing 7-4, we implemented the GetEntities<T>() extension method to retrieve all the entities in the
object context that are in the Added, Modified, or Unchanged state. Because this may be a common
activity in your application, it makes sense to implement this just once in an extension method. In the
implementation of the GetEntities<T>() method, we call the GetObjectStateEntries() method passing
in the “EntityState.Detached expression. The method returns all entries that are not in the Detached
state. From these, we filter out relationships and null entries. From the remaining entries, we select only
those of the given type.

There are some important scenarios in which you might want to implement a method like
GetEntities<T>(). For example, in the SavingChanges event, you may want to validate entities that are
about to be inserted, modified, or deleted.

It is important to note that when you add or delete entities from the object context, these changes
are not reflected in results of queries against the object context. These queries represent entities as they
exist in the database, not what currently exist in the object context.

In our implementation of GetEntities<T>(), we filtered out relationship entries in the object state
manager. Relationships are first-class objects in Entity Framework, and entries are created in the object
state manager for relationships.

7-6. Generating a Model from the Command Line

Problem

You want to generate a model from the command line.

Solution

To generate a model for a given database from the command line, use the edmgen.exe program. To
access the Visual Studio Command Prompt, click Visual Studio 2010 Command Prompt under Microsoft
Visual Studio 2010 from the Start menu.

The Microsoft documentation for the edmgen command provides a complete list of the command
line options. The edmgen command supports a lot of useful command line options. The following
command, for example, will generate a model from all of the tables in the given Test database:
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edmgen /mode:FullGeneration /project:Test /provider:"System.Data.SqlClient"
/c:"server=localhost;integrated security=true;database=Test;"

Other /mode options are available. One that can be particularly useful in a continuous integration
build process is /mode:ValidateArtifacts. With this option, one or more of the generated layers are
validated. You need to use one or both of the /inssdl or /incsdl options. If you are validating the
mapping layer, all three layers must be specified.

You can use one of the /out options to specify the name of the generated file for specific model
layers. For example, using /outcsdl:MyProject.csdl will create the conceptual layer definitions in a file
named MyProject.csdl. There are similar options for the other layers.

How It Works

The edmgen command provides a convenient way to automate some of the build processes and is a
useful tool for pregenerating views and generating separate files for the model layers. One restriction of
edmgen is that it does not provide a way to generate a model based on a subset of the tables in a
database.

7-7. Working with Dependent Entities in an Identifying
Relationship

Problem

You want to insert, update, and delete a dependent entity in an identifying relationship.

Solution

Suppose you have a model like the one in Figure 7-8. The Lineltem’s entity key is a composite key
comprised of InvoiceNumber and ItemNumber. InvoiceNumber is also a foreign key to the Invoice
entity.

>
>

¢ Invoice ¢ Lineltem

= Properties = Properties
# InvoiceNumber # InvoiceNumber
2 BilledTo P 5 remNumber
ﬁ] InvoiceDate ﬁ] Cost

= Navigation Properties = Navigation Properties
3_—1 Lineltems 3_—1 Invoice

Figure 7-8. Invoice and Lineltem in an identifying relationship because of the composite entity key in the
Lineltem entity
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When one of the properties of an entity key is both the primary key and the foreign key, the entity is
said to be participating in an identifying relationship. In our model, Lineltem’s entity key, its identity, is
also a foreign key to the Invoice entity. The Lineltem entity is referred to as the dependent entity while
Invoice is the principal entity.

There is a subtle difference in how Entity Framework handles the deletion of dependent entities in
an identifying relationship. Because the dependent entity cannot exist without participating in the
relationship, simply removing the dependent entity from the principal’s collection will result in Entity
Framework marking the dependent entity for deletion. Additionally, deleting the principal entity will
also mark the dependent for deletion. This is reminiscent of the cascading deletes common in database
systems. Of course, Entity Framework allows you to explicitly delete the dependent entity. The code in
Listing 7-5 demonstrates all three of these scenarios.

Listing 7-5. Deleting the dependent entity
static void Main(string[] args)

RunExample();

static void RunExample()

using (var context = new EFRecipesEntities())

var invoicel = new Invoice { BilledTo = "Julie Kerns",
InvoiceDate = DateTime.Parse("3/19/2010") };
var invoice2 = new Invoice { BilledTo = "Jim Stevens",
InvoiceDate = DateTime.Parse("3/21/2010") };
context.LineItems.AddObject(new LineItem { Cost = 99.29M,
Invoice = invoice1 });
context. LineItems.AddObject(new LineItem { Cost = 29.95M,
Invoice = invoice1 });
context.LineItems.AddObject(new LineItem { Cost = 109.95M,
Invoice = invoice2 });
context.SaveChanges();

// display the line items
Console.WriteLine("0Original set of line items...");
DisplayLineItems();

// remove a line item from invoice 1's collection

var item = invoicel.LineItems.TolList().First();
invoicel.LineItems.Remove(item);

context.SaveChanges();

Console.WriteLine("\nAfter removing a line item from an invoice...");
DisplayLineItems();

// remove invoice2

context.DeleteObject(invoice2);
context.SaveChanges();

Console.WriteLine("\nAfter removing an invoice...");
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DisplayLineItems();

// remove a single line item
context.DeleteObject(invoicel.LineItems.First());
context.SaveChanges();

Console.WriteLine("\nAfter removing a line item...");
DisplayLineItems();

}
static void DisplayLineItems()

bool found = false;
using (var context = new EFRecipesEntities())

foreach (var lineitem in context.LineItems)

{
Console.WriteLine("Line item: Cost {0}",
lineitem.Cost.ToString("C"));
found = true;
}
if (1found)

Console.WriteLine("No line items found!");

The following is the output of the code in Listing 7-5:

Original set of line items...
Line item: Cost $99.29
Line item: Cost $29.95

Line item: Cost $109.95

After removing a line item from an invoice...
Line item: Cost $29.95

Line item: Cost $109.95

After removing an invoice...

Line item: Cost $29.95
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After removing a line item...

No line items found!

How It Works

The code in Listing 7-5 deletes line items in three ways. First, it deletes a line item from an invoice’s
collection. Because a line item is dependent on the invoice for its identity, Entity Framework marks the
referenced line item for deletion. Next, it deletes an invoice. Entity Framework marks all the dependent
line items for deletion. Finally, the code deletes the last remaining line item directly by calling
DeleteObject().

You can modify all the properties of a dependent entity except for properties that participate in the
identifying relationship. In our model, we can modify the Cost property in a line item, but we can’t
change the Invoice navigation property.

When a principal object in an identifying relationship is saved to the database, the key that is
generated at the database (for store-generated values) is written to the principal entity and to all its
dependent entities. This ensures that all are synchronized in the object context.

The subtle difference in Entity Framework’s treatment of a deleted relationship between two
entities in an identifying relationship and two entities in any other relationship is worth noting. For
other types of relationships, Entity Framework does not mark an entity for deletion if the entity is
removed from the collection of another entity. For an identifying relationship, Entity Framework does
mark the dependent entity for deletion.

7-8. Inserting Entities Using an Object Context

Problem

You want to insert entities in your model to the database using an object context.

Solution

Suppose you have a model like the one in Figure 7-9.

“: Employee & . Task x
= Properties = Properties
# EmployeeMumber 4 Taskld
ﬁ:‘Name 1 """""" . ﬁ:‘;—\ssignedld
57 Salary 57 Description
= Navigation Properties = Navigation Properties
B Tacks B Employee

Figure 7-9. A model with employees and their tasks
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The model in Figure 7-9 represents employees and their tasks. You want to insert new employees
and their tasks into the underlying database. To insert an Employee, create a new instance of Employee
and call the AddObject () method available on the Employees entity set in the context. To add a Task for
an employee, create a new instance of Task and add it to the Tasks collection of the employee. You must
also call AddObject() to add either the employee or the task to the object context. To persist the changes
to the database, call the SaveChanges () method.

The code in Listing 7-6 demonstrates using AddObject() to add new objects to the object context
and persist them to the database with SaveChanges ().

Listing 7-6. Inserting new entities into the database
using (var context = new EFRecipesEntities())
var employeel = new Employee {EmployeeNumber = 629,

Name = "Robin Rosen", Salary = 106000M };

var employee2 = new Employee {EmployeeNumber = 147,

Name = "Bill Moore", Salary = 62500M };
var taskl = new Task { Description = "Report 3rd Qtr Accounting" };
var task2 = new Task { Description = "Forecast 4th Qtr Sales" };
var task3 = new Task { Description = "Prepare Sales Tax Report" };

// use AddObject() on the Employees entity set
context.Employees.AddObject (employee1);

// add two new tasks to the employeel's tasks
employee1.Tasks.Add(task1);
employee1l.Tasks.Add(task2);

// add a task to the employee and use

// AddObject() to add the task to the object context
employee2.Tasks.Add(task3);

context.Tasks.AddObject (task3);

// persist all of these to the database
context.SaveChanges();

}

using (var context = new EFRecipesEntities())

foreach (var employee in context.Employees)

{
Console.WriteLine("Employee: {0}'s Tasks", employee.Name);
foreach (var task in employee.Tasks)
Console.WriteLine("\t{0}", task.Description);
}
}

The following is the output of the code in Listing 7-6:
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Employee: Bill Moore's Tasks
Prepare Sales Tax Report

Employee: Robin Rosen's Tasks
Report 3rd Qtr Accounting

Forecast 4th Qtr Sales

How It Works

In Listing 7-6, we used the AddObject() method available on the Employees and Tasks entity sets to add
entities to the object context. An AddObject() method is also available on the object context. This second
version of AddObject() exists for largely historic reasons. Most new applications use the AddObject()
method on the entity set.

When you add an entity to the object context, Entity Framework creates a temporary entity key for
the newly added entity. Entity Framework uses this temporary key to uniquely identify the entity. This
temporary key is replaced by a real key after the object is persisted to the database. If saving two entities
to the database results in both entities being assigned the same entity key, Entity Framework will throw
an exception. This can happen if the keys are assigned the same value by t